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COMPUTERFUNDAMENTALS

Computer is an electronic device that is designed to work with Information. The
termcomputerisderivedfromtheLatinterm‘compute’,thismeanstocalculate.Computer



cannotdoanythingwithoutaProgram.Itrepresentsthedecimalnumbersthroughastring of
binary digits. The Word 'Computer' usually refers to the Center Processor Unit plus
Internal memory.

CHARLESBABBAGE

Charles Babbage was an English polymath. He was a mathematician, philosopher,
inventor and mechanical engineer, who is best remembered now for originating the
concept of a programmable computer.

Considered a "father of the computer", Babbage is credited with inventing the first
mechanical computer that eventually led to more complex designs. His varied work in
otherfieldshasledhimtobedescribedas"pre-eminent"amongthemanypolymathsof his
century.

FUNCTIONALITESOF COMPUTER:

Anydigitalcomputercarriesoutfivefunctionsingrossterms:

• Takesdataasinput.

• Storesthedata/instructionsinitsmemoryandcanusethemwhenrequired.

• Processthedataandconvertitintousefulinformation.

• Outputtheinformation.

• Controlalltheabovefoursteps.

Definition

ComputerSystemisanelectronicdataprocessingdevicewhichdoesthefollowing:

• Acceptandstoreaninputdata.

• Processthedatainput.

• Andoutputtheprocesseddatainrequiredformat.

ADVANTAGESOFCOMPUTER:



FollowinglistdemonstratestheadvantagesofComputers:High Speed

• Computerisaveryfastdevice.

• Itiscapableofperformingadditionofverybigdata.

• Thecomputerhasunitsofspeedinmicrosecond,nanosecondandeventhe picoseconds.

• It canperformmillionsof calculationsin afewsecondsascomparedtomanwho can
spend many months for doing the same task.

Accuracy

• In addition to being very fast, computer is very accurate. The computer

can perform calculations 100% error free.

• Computersperformalljobswith100%accuracy.

StorageCapability

• Memoryisaveryimportantcharacteristicofacomputer.

• Thecomputerhasmuchmorestoragecapacitythanhumanbeings.

• Itcanstorelargeamountofdata.

• It can store any type of data such as images, videos, text, audio and any other
type.

Diligence

• Unlike human beings, a computer is free from monotony, tiredness and lack
ofconcentration.

• Itcanworkcontinuouslywithoutcreatinganyerrorandboredom.

• Itcandorepeatedworkwithsamespeedandaccuracy.

Versatility

• Acomputerisaveryversatilemachine.

• Acomputerisveryflexibleinperformingthejobstobedone.



Thismachinecanbeusedtosolvetheproblemsrelatingtovariousdifferent
fields.

• At one instant, it may be solving a complex scientific problem and the very next
moment it may be playing a card game. Reliability

• Acomputerisareliablemachine.

• Modernelectroniccomponentshavefailurefreelonglives.

• Computersare designedto makemaintenance easy.

Automation

• Computerisanautomaticmachine.

• Automationmeansabilitytoperformthetaskautomatically.

• Onceaprogramisgiventocomputeri.estoredincomputermemory,theprogram and
instruction can control the program execution withouthuman interaction.

ReductionInPaperWork

• Theuseofcomputersfordataprocessinginanorganizationleadstoreductionin paper
work and speeds up the process.

• As data in electronic files can be retrieved as and when required, the problem of
maintenance of large number of files gets reduced.

Reduction In Cost

• Though the initial investment for installing a computer is high but it substantially
reduces the cost of each of its transaction.

DISADVANTAGESOFCOMPUTER:

FollowinglistdemonstratesthedisadvantagesofComputersintoday'sarena.

• Acomputerisamachineandhasnointelligenceofitsowntoperformanytask.

• Eachandeveryinstructionhastobegiventothecomputer.

• Acomputercannottakeanydecisiononitsown.
Dependency



• Itcanperformfunctionasinstructedbytheuser,soitisfullydependentonhuman being.
Environment

• Theoperatingenvironmentofcomputershouldbedustfreeandsuitabletoit. No
Feeling

• Computerhasnofeelingoremotions.

• It cannot make Judgment based on feelings, tastes, experiences and knowledge
unlike a human being.

APPLICATIONSOFCOMPUTER

Banking

TodayBankingisalmosttotallydependentoncomputer. Banks

provide following facilities:

• Bankson-lineaccountingfacility,whichincludecurrentbalances,deposits, overdrafts,
interest charges, shares and trustee records.

• ATMmachinesaremakingiteveneasierforcustomerstodealwithbanks.

Insurance

Insurance companies are keeping all records up to date with the help of computer. The
Insurance Companies, Finance houses and Stock broking firms are widely using
computers for their concerns.

InsuranceCompaniesaremaintainingadatabaseofallclientswithinformationshowing

• howtocontinuewithpolicies

• startingdateofthepolicies

• nextdueinstallmentofapolicy

• maturitydate

• interestsdue

• survivalbenefits

• bonus

Education



ThecomputerhasprovidedalotoffacilitiesintheEducationSystem.

• The uses of computer provide a tool in the Education system is known as CBE
(Computer Based Education).
CBEinvolvesControl,DeliveryandEvaluationoflearning.

• The computer education is very familiar and rapidly increasing the graph of
computer students.

• Therearenumberofmethodsinwhicheducationalinstitutionscanusecomputer to
educate the students.

• It is used for prepare a database about student performance and analysis are
carried out.

Marketing

InMarketingusesofcomputerarefollowing:
• Advertising: With computers, advertising professionals create art and graphics,

writeandrevisecopyandprintanddisseminateadswiththegoalofsellingmore products.
• At Home Shopping: At home shopping has been made possible through use of

computerized catalogues that provide access to product information and permit
direct entry of orders to be filled by the customers.

HealthCare

ComputershavebecomeimportantpartinallMedicalSystems.

Thecomputersarebeingusedinhospitalstokeeptherecordofpatientsandmedicines. It is also
used in scanning and diagnosing different diseases. ECG, EEG, Ultrasounds and CT
Scans etc. are also done by computerized machines.

Someofmajorfieldsofhealthcareinwhichcomputerareused:
• DiagnosticSystem:Computers are used to collect data and identify cause

ofillness.
• Lab-diagnosticSystem:Alltestscanbedoneandreportsarepreparedby computer.
• PatientMonitoringSystem:Theseareusedtocheckpatient'ssignsfor abnormality

such as in Cardiac Arrest, ECG etc.
• PharmaInformationSystem:ComputerchecksDrug-Labels,Expirydates, harmful

drug side effects etc.

• Nowadays,computersarealsousedinperformingsurgery.

Engineering Design



Computersarewidelyusedinengineeringpurposes.

OneofmajorareasisCAD(ComputerAidedDesign).CADprovidescreation,editionand modification of
image. Some fields are:

• Structural Engineering: Requires stress and strain analysis required for design
of Ships, Buildings, Budgets, and Airplanes etc.



Industrial Engineering: Computers deals with design, implementation and
improvement of integrated systems of people, materials and equipments.

• Architectural Engineering: Computers help in planning towns, designing
buildings, determining a range of buildings on a site using both 2D and 3D
drawings.

Military
Computers are largely used in defense. Modern tanks, missiles, weapons etc. employ
computerized control systems. Some militaryareas where a computer has been used
are:

• MissileControl

• MilitaryCommunication

• Militaryoperationandplanning

• SmartWeapons

Communication

Communicationmeanstoconveyamessage,anidea,apictureorspeechthatisreceived and
understood clearly and correctly by the person for whom it is meant. Some main areas
in this category are:

• E-mail

• Chatting

• Usenet

• FTP

• Telnet

• Video-conferencing

Governmentapplications

Computers play an important role in government applications. Some major fields in this
category are:

• Budgets

• Salestaxdepartment

• Incometaxdepartment

• Male/Femaleratio



• Computerizationofvoterslists

• Computerization of Driving Licensing system
Computerization of PAN card

WeatherForecasting.

TYPESOFCOMPUTER:

Computercanbebroadlyclassifiedbytheirspeedandcomputingpower.

Sr.
No. Type Specifications

1 PC(PersonalComputer)
Singleusercomputersystem.Moderately
powerful microprocessor.

2
Singleusercomputersystem.SimilartoWorkStati

on PersonalComputerbuthavemorepowerful
microprocessor.

3 MiniComputer
Multi-user computer system. Capable of
supportinghundredsofuserssimultaneously.

4 MainFrame

Multi-user computer system. Capable of
supportinghundreds of users simultaneously.
Software technology is different from
minicomputer.

5 Supercomputer
Anextremelyfastcomputerwhichcanperform
hundreds of millions of instructions per
second.

INPUTDEVICES

FollowingarefewoftheimportantinputdeviceswhichareusedinComputerSystems

• Keyboard

• Mouse

• JoyStick

• Lightpen



• TrackBall

• Scanner

• GraphicTablet

• Microphone
MagneticInkCardReader(MICR)

• OpticalCharacterReader(OCR)

• BarCodeReader

• OpticalMarkReader

OUTPUT DEVICES

FollowingarefewoftheimportantoutputdeviceswhichareusedinComputerSystems

• Monitors

• GraphicPlotter

• Printer

CPU(CENTRALPROCESSING UNIT)

• CPUisconsideredasthebrainofthecomputer.

• CPUperformsalltypesofdataprocessingoperations.

• Itstoresdata,intermediateresultsandinstructions(program).

• Itcontrolstheoperationofallpartsofcomputer.

CPU itself hasfollowing threecomponents.

• Memory OrStorageUnit:

• ControlUnit

• ALU(ArithmeticLogicUnit)



Memoryor Storage Unit:
This unit can store instruction, data and intermediate results. This unit supplies
informationtotheotherunitsofthecomputerwhenneeded.Itisalsoknownasinternal storage
unit or main memory or primary storage or Random access memory (RAM).

Its size affects speed, power and capability. There are primary memory and secondary
memory two types of memories in the computer.



FunctionofMemoryUnitis:

Itstoresallthedatatobeprocessedandtheinstructionsrequiredforprocessing. It stores

intermediate results of processing.

Itstoresfinalresultsofprocessingbeforetheseresultsarereleasedtoanoutputdevice. All inputs

and outputs are transmitted through main memory.

Control Unit:
Thisunitcontrolstheoperationsofallpartsofcomputer.Itdoesnotcarryoutanyactualdata processing
operations.

Functionsofthisunitare

Itisresponsibleforcontrollingthetransferofdataandinstructionsamongotherunitsofa computer.

Itmanagesandcoordinatesalltheunitsofthecomputer.

Itobtainstheinstructionsfromthememory,interpretsthemanddirectstheoperationofthe computer.

ItcommunicateswithInput/outputdevicesfortransferofdataorresultsfromstorage. It does

not process or store data.

ALU(ArithmeticLogicUnit):

Thisunitconsistsoftwosub-sectionsnamely

• Arithmeticsection

• LogicSection

ARITHMETICSECTION
FunctionofArithmeticsectionistoperformarithmeticoperations likeaddition,subtraction,
multiplication and division. All complex operations are done by making repetitive use of
above operations.

LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting,matching
and merging of data.



Unitsof Computer MemoryMeasurements

1Bit=BinaryDigit(BitsofComputerare0and1) 8 Bits
= 1 Byte
1024Bytes=1KB(KiloByte)
1024 KB = 1 MB (Mega Byte)
1024 MB = 1 GB(Giga Byte)

Computer Memory
In computing,memoryrefers tothephysical devices usedtostoreprograms (sequences
ofinstructions)ordata(e.g.programstateinformation)onatemporaryorpermanentbasis
foruseinacomputerorotherdigitalelectronicdevice.Thetermprimarymemoryisused for the
information in physical systems which function at highspeed (i.e. RAM), as a distinction
from secondary memory, which are physical devices for program and data storage
which are slow to access but offer higher memory capacity. Primary memory
storedonsecondarymemoryiscalled"virtualmemory".Anarchaicsynonymformemory is store.

The term "memory", meaning primary memory is often (but not always) associated with
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors, used for example as primary memory but also other purposes in computers
andotherdigitalelectronicdevices.Therearetwomaintypesofsemiconductormemory:
volatileandnon-volatile.Examplesofnon-volatilememoryareflashmemory(sometimes used
as secondary, sometimes primary computer memory) and ROM/PROM/EPROM/EEPROM
memory (used for firmware such as boot programs). Examples of volatile memory are
primary memory (typically dynamic RAM, DRAM), and fast CPU cache memory (typically
static RAM, SRAM, which is fast but energyconsuming and offer lower memory capacity
per area unit than DRAM) .

Volatile memory

Volatile memory is computer memory that requires power to maintain the stored
information.MostmodernsemiconductorvolatilememoryiseitherStaticRAMordynamic
RAM.SRAMretainsitscontentsaslongasthepowerisconnectedandiseasytointerface to but
uses six transistors per bit. Dynamic RAM is more complicated to interface to and control
and needs regular refresh cycles to prevent its contents being lost. However, DRAM uses
only one transistor and a capacitor per bit, allowing it to reach much higher densities
and, with more bits on a memory chip, be much cheaper per bit. SRAM is not
worthwhile for desktop system memory, where DRAM dominates, but is used for their
cache memories. SRAM is commonplace in small embedded systems, which might only
need tens of kilobytes or less. Forthcoming volatile memory technologies that hope to
replaceorcompetewithSRAMandDRAMincludeZ-RAM, TTRAM,A-RAMandETA RAM.

Non-volatilememory



Non-volatilememoryiscomputermemorythatcanretainthestoredinformationevenwhennot
powered. Examples of non-volatile memory include read-only memory(ROM), flash memory,
most types of magnetic computer storage devices (e.g. hard disks, floppy discs and magnetic
tape), optical discs, and early computer storage methods such as paper tape and punched
cards.

OPERATINGSYSTEM
An operating system is a program that acts as an interface between the softwareand the
computer hardware.

• Itisanintegrationsetofspecializedprogramsthatareusedtomanageoverallresources and
operations of the computer.

• It isspecialized softwarethat controlsandmonitorsthe execution ofallotherprograms that
reside in the computer, including application programs and other system software.

ObjectivesofOperating System

• Makingacomputersystemconvenienttouseinanefficientmanner

• Tohidethedetailsofthehardwareresourcesfromtheusers

• Toprovideusersaconvenientinterfacetousethecomputersystem.

• To act as an intermediary between the hardware and its users and making it easier for
the users to access and use other resources.

• Managetheresourcesof acomputersystem.

• Keep track of who is using whichresource, granting resource requests, according
forresource using and mediating conflicting requests from different programs and users.

• Theefficientandfairsharingofresourcesamongusersandprograms

CharacteristicsofOperatingSystem

• Memory Management -- It keeps tracks of primary memory i.e. what part of it are in use by
whom,whatpartarenotinuseetc.Allocatesthememorywhentheprocessorprogramrequests it.

• Processor Management -- Allocate the processor (CPU) to a process. De-allocate
processor when processor is no longer required.

• Device Management -- Keep tracks of all devices. This is also called I/O controller. Decides
which process gets the device when and for how much time.



• File Management --Allocatestheresources.De-allocatestheresources.Decideswhogetsthe
resources.

• Security--Bymeansofpasswords&similarothertechniques,preventingunauthorizedaccess to
programs & data.

• Job accounting--Keepingtrackoftime&resourcesusedbyvariousjobsand/orusers.

• Control over system performance --Recordingdelaysbetweenrequestforaservice&from the
system.

• Interaction with the operators -- The interaction may take place via the console of the
computer in the form of instructions. Operating System acknowledges the same, do the
corresponding action and inform the operation by a display screen.

• Error-detectingaids --Productionofdumps,traces,errormessagesandotherdebuggingand error-
detecting methods.

• Coordination between other software and users -- Coordination and assignment of
compilers, interpreters, assemblers and other software to the various users of the computer
systems.

WINDOWS7

Windows 7 isanoperatingsystemproducedbyMicrosoftforuseonpersonalcomputers,
including home and business desktops, laptops, net books, tablet PCs, and media center
PCs. It was released to manufacturing on July 22, 2009, and became generally available
retail worldwide on October 22, 2009, less than three years after the release of its
predecessor, Windows Vista. Windows 7's server counterpart, Windows Server 2008 R2,
was released at the same time. Windows 7 is succeeded by Windows
8.

Unlike Windows Vista's many new features, Windows 7 was an incremental upgrade
designedtoworkwithVista-compatibleapplicationsandhardware.Presentationsgiven by
Microsoft in 2008 focused on multi-touch support, an updatedWindows shell with a new
taskbar, referred to internally as the Superbar, a home networking system called Home
Group, and performance improvements. Some standard applications that have been
included with prior releases of Microsoft Windows, including Windows Calendar,
Windows Mail, Windows Movie Maker, and Windows Photo Gallery, are not included in
Windows 7; most are instead offered separately at no charge as part of theWindows
Essentials suite.

InstallWindows7

ManypeoplehavecomputersthatcomewithWindows7sotheymayneverhavetoinstall it.
However, you may need to install Windows 7 if:

• You replaced your hard disk drive with a new hard disk drive that does not
haveWindows 7 installed.



• You are reinstallingWindows 7 on a computer because you want to clean off your
hard drive and remove any unwanted programs, such as spyware.

• Youpurchasedacomputerwithoutanoperatingsystem.

Pre-installation checklist

Beforeyoubegintheinstallationprocess,usethischecklisttomakesurethatyouareprepared:

• YouhavetheWindows7CD.
• You have theproductkeyavailable.Theproduct keyislocatedonyourWindows 7 CD

case and is required to install and activate Windows 7.
• Your computer hardware is set up. At a minimum, you should connect your

keyboard, mouse, monitor, and CD drive. If available, you should connect your
computer to a wired network.

• YouhaveWindows7driversavailable.DriversaresoftwarethatWindows7usesto
communicate with your computer’s hardware. If you do not have drivers available,
Windows7mayalreadyincludedriversforyourhardware.Ifnot,youshouldbeable to
download them from your hardware manufacturer’s website after you set up
Windows 7.

• IfyouarereinstallingWindows7onanexistingcomputer,youneedabackupcopy of your
files and settings. The installation process will delete all of your files. You can use
the File and Settings Transfer Wizard to store your files and settings on removable
media and then restore them after installation is complete.

Installation process

InstallingWindows7cantakeuptotwohours.Tomaketheprocessmoremanageable,it has been
broken up into several sections.

ToBeginInstallation:

1. InserttheWindows7CDintoyourcomputerandrestartyourcomputer.
2. IfpromptedtostartfromtheCD,pressSpacebar.Ifyoumisstheprompt(itonlyappears for a

few seconds), restart your computer to try again.
3. Windows7Setupbegins.Duringthisportionof setup,yourmousewillnot work,soyou

mustusethekeyboard.OntheWelcometoSetuppage,pressEnter.4.OntheWindows 7
Licensing Agreement page, read the licensing agreement. Press the Page Down keyto
scroll to the bottom of the agreement. Then press F8.

5. This page enables you to select the hard disk drive on which Windows 7 will be
installed. Once you complete this step, all data on your hard disk drive will be
removed and cannot be recovered. It is extremelyimportant that you have a
recent backup copy of your files before continuing. When you have a backup
copy,pressD,andthenpressLwhenprompted.Thisdeletesyourexistingdata.

6. PressEntertoselectunpartitionedspace, which appearsbydefault.
7. Press Enteragain to select Formatthepartition usingthe NTFSfilesystem, which

appears by default.



8. Windows 7 erases your hard disk drive using a process called formatting and
thencopiesthesetupfiles.Youcanleaveyourcomputerandreturnin20to30 minutes.

ToContinuethe Installation

1. Windows7restartsandthencontinueswiththeinstallationprocess.Fromthispoint
forward, you can use your mouse. Eventually, the Regional and Language Options
page appears. Click Next to accept the default settings. If you are multilingual or
preferalanguageotherthanEnglish,youcanchangelanguagesettingsaftersetup is
complete.

2. On the Personalize Your Software page, type your name and your organization
name.Someprogramsusethisinformationtoautomaticallyfillinyournamewhen
required. Then, click next.

3. On the Your Product Key page, type your product key as it appears on your
Windows7 CDcase.The productkeyisuniqueforeveryWindows7 installation. Then,
click Next.

4. On the Computer Name and Administrator Password page, in the Computer name
box, type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect
your computer to anetwork, you will use thiscomputernametofindsharedfiles
andprinters.Typea strongpasswordthatyou canrememberintheAdministrator
password box, and then retype it in the Confirm password box.
Writethepassworddownandstoreitinasecureplace.ClickNext.

5. OntheDateandTimeSettingspage,setyourcomputer’sclock.Then,clickthe Time
Zone down arrow, and select your time zone. Click Next.

6. Windows7willspendaboutaminuteconfiguringyourcomputer.Onthe
Networking Settings page, click next.

7. OntheWorkgrouporComputerDomainpage,clickNext.

To complete the installation

1. Windows 7 will spend 20 or 30 minutes configuring your computer and will
automatically restart when finished. When the Display Settings dialog appears, click
OK.

2. WhentheMonitorSettingsdialogboxappears,clickOK.
3. The final stage of setup begins. On the Welcome to Microsoft Windows page, click

Next.
4. On the Helpprotect yourPCpage,clickHelpprotectmyPCbyturningon Automatic

Updates now. Then, click Next.
5. Windows7willthencheckifyouareconnectedtotheInternet:

o IfyouareconnectedtotheInternet,selectthechoicethatdescribesyour
networkconnectionontheWillthiscomputerconnect to the Internet
directly,orthroughanetworkpage.Ifyou’renotsure,acceptthedefault
selection, and click Next.



o Ifyouusedial-upInternetaccess,orifWindows7cannotconnecttothe
Internet,youcanconnecttotheInternetaftersetupiscomplete.Onthe How
will this computer connect to the Internet? Page, click Skip.

6. Windows7SetupdisplaystheReadytoactivateWindowspage.Ifyouareconnected to the
Internet, click Yes, and then click Next. If you are not yet connected to the Internet,
click No, click Next, and then skip to step 24. After setup is complete, Windows 7
will automatically remind you to activate and register your copy of Windows 7.

7. OntheReadytoregisterwithMicrosoftpage,clickYes,andthenclickNext.
8. OntheCollectingRegistrationInformationpage,completetheform.Then,clickNext.
9. OntheWhowillusethiscomputerpage,typethenameofeachpersonwhowilluse the

computer? You can use first names only, nicknames, or full names. Then click Next.
10.OntheThankyou!Page,clickFinish.

Windows7setupiscomplete.Youcanlogonbyclickingyournameonthelogon
screen.Ifyou’veinstalledWindows7onanewcomputerornewharddiskdrive, you can
now use the File and Settings Transfer Wizard to copy your important data to
your computer or hard disk drive.

MS-DOS

Short for Microsoft Disk operating system, MS-DOS is a non-graphical command line
operating system derived from 86-DOS that was created for IBM compatible computers.
MS-DOS originally written by Tim Peterson and introduced by Microsoft in August 1981
and was last updated in 1994 when MS-DOS 6.22 was released. Today, MS-DOS is no
longer used; however, the command shell, more commonly known as the Windows
command line is still used by many users.

Today, most computer users are only familiar with how to navigate Microsoft Windows
using the mouse Unlike Windows, MS-DOS is a command-line and is navigated by using
MS-DOScommands.Forexample,ifyouwantedtoseeallthefilesinafolderinWindows you
would double-clickthefoldertoopenthefolderinWindowsExplorer.In MS-DOS,to viewthat
samefolderyou would navigate tothefolder using the CD command and then list the files
in that folder using the dir command.

DOS Commands

MS-DOS has a relatively small number of commands, and an even smaller number of
commonly used ones. Moreover, these commands are generally inflexible because, in
contrast to Linux and other Unix-like operating systems, they are designed to
accommodate few options or arguments (i.e., values that can be passed to the
commands).

Some of the most common commands are as follows (corresponding commands on Unix-like
operating systems are shown in parenthesis):



CD-changesthecurrentdirectory(cd)
COPY - copies a file (cp)DEL
-deletesafile(rm)
DIR-listsdirectorycontents(ls)
EDIT-startsaneditortocreateoreditplaintextfiles(vi,vim,ed,Joe) FORMAT
- formats a disk to accept DOS files (mformat)
HELP-displaysinformationaboutacommand(man,info) MKDIR -
creates a new directory (mkdir)
RD-removesadirectory(rmdir)
REN - renames a file (mv)
TYPE-displayscontentsofafileonthescreen(more,cat)

OtherDOSCommand commonlyused are:

Append
Theappendcommandcanbeusedbyprogramstoopenfilesinanotherdirectoryasifthey were
located in the current directory.
Attrib
Theattribcommandisusedtochangetheattributesofasinglefileoradirectory.
Break
ThebreakcommandsetsorclearsextendedCTRL+Cchecking.Call
Thecallcommandisusedtorunascriptorbatchprogramfromwithinanotherscriptorbatch program.
Thecallcommandhasnoeffectoutsideofascriptorbatchfile.Inotherwords,runningthe call
command at the DOS prompt will do nothing.
Chcp
Thechcpcommanddisplaysorconfigurestheactivecodepagenumber.Chdir
Thechdircommandisusedtodisplaythedriveletterandfolderthatyouarecurrentlyin.
Chdircanalso be usedto change thedrive and/ordirectorythat youwant to workin.
Chkdsk
Thechkdskcommand,oftenreferredtoascheck disk,isusedtoidentifyandcorrectcertain hard
drive errors.
Choice
Thechoicecommandisusedwithinascriptorbatchprogramtoprovidealistofchoices and return
the value of that choice to the program.
Cls
Theclscommandclearsthescreenofallpreviouslyenteredcommandsandothertext.
Dir
Thedircommandisusedtodisplayalistoffilesandfolderscontainedinsidethefolderthat you are
currently working in.
Thedircommandalsodisplaysotherimportantinformationliketheharddrive's serial
number,thetotalnumberoffileslisted,theircombinedsize,thetotalamountoffree space left on
the drive, and more.



DIR[drive:][path][filename][/P][/W][/A[[:]attributes]][/O[[:]sortorder]][/S][/B][/L][/V]
Specifiesdrive,directory,orfilestolist.(Couldbeenhancedfile

[drive:][path][filename]specificationormultiplefilespecs)

/P Pauses aftereachscreenful ofinformation.
/W Useswidelistformat.

attributes:D
Directories
RRead-onlyfiles

/A HHiddenfiles
AFilesreadyforarchiving S
System files
-Prefixmeaningnot
Listbyfilesinsortedorder,sortorder: N
By name (alphabetic)
SBysize(smallestfirst)

/O EByextension(alphabetic)
DBydateandtime(earliestfirst)
GGroupdirectoriesfirst
-Prefixtoreverseorder
AByLastAccessDate(earliestfirst)

/S Displaysfilesinspecifieddirectoryandallsubdirectories.
/B Usesbareformat(noheadinginformationorsummary).
/L Useslowercase.
/V Verbosemode.

WINDOWSOPERATIONS:

MS- PAINT
Paintisadrawingtoolyoucanusetocreatesimpleorelaboratedrawings.Thesedrawings can be
either black-and-white or color, and can be saved as bitmap files. You can print
yourdrawing,useitforyourdesktopbackground,orpasteitintoanotherdocument.You can
even use Paint to view and edit scanned photos.

YoucanalsousePainttoworkwithpictures,suchas.jpg,.gif,or.bmpfiles.Youcanpastea Paint picture
into another document you've created, or use it as your desktop background.

Todrawastraightline
1. Inthetoolbox,clickLine .
2. Belowthetoolbox,clickalinewidth.
3. Dragthepointertodrawtheline.

Todraw a freeformline
1. Inthetoolbox,clickLine .
2. Dragthepointertodrawtheline.



Todrawacurvedline
1. Inthetoolbox,clickCurve .
2. Belowthetoolbox,clickalinewidth.
3. Drawastraightlinebydraggingthepointer.
4. Click where you want one arc of the curve to be, and then drag the pointer to adjust the

curve. Repeat this step for a second arc. You can only create two curves for each line.

Tosend animageusing e-mail
Afteryouaredoneworkingonanimage,youcansendittoanyonewhohasane-mailaccount (as long as
you also have access to an e-mail account).
1. OntheFilemenu,clickSend.
2. Youre-mailprogramwilldisplay,withyourimageincludedeitherasanattachmentoras part of

the message section of your e-mail.
3. Specifyyourrecipient'se-mailaddress,asubject,andamessage;thensendtheemailas you

normally would.

Todraw arectangleorsquare
1. Inthetoolbox,clickRectangle tocreateasquare-corneredshape,orclickRounded Rectangle

to create a round-cornered shape.
2. Belowthetoolbox,clickafillstyle.
3. Todrawarectangle,dragthepointerdiagonallyinthedirectionyouwant.
4. Todrawasquare,holddownSHIFTwhiledraggingthepointer.

Toacquireanimagefromascanneroradigitalcamera 1. On the
File menu, click From Scanner or Camera.
2. IntheGetPicturesdialogbox,clicktheimageyouwant, andthenclickGetPicture.

NOTEPAD

Notepadoverview
Notepad is a basic text editor you can use for simple documents or for creating Web
pages.ThemostcommonuseforNotepadistovieworedittext(.txt)files,butmanyusers find
Notepad a simple tool for creating Web pages.
Because Notepad supports only very basic formatting, you cannot accidentally save
special formatting in documents that need to remain pure text. This is especially useful
when creating HTML documents for a Web page because special characters or other
formatting may not appear in your published Web page or may even cause errors. You
can save your Notepad files as Unicode, ANSI, UTF-8, or big-endian Unicode. These
formats provide you greater flexibility when working with documents that use different
character sets.
WORDPAD

WordPad is a basic word processor that is included with almost allversions of Microsoft
WindowsfromWindows95onwards.ItismoreadvancedthanNotepadbutsimplerthan
Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft Write.



UsingWordPad

WordPad is a basic word processor that is included in Windows. A word processor is a
computerprogramthatyoucanusetocreate,edit,view,andprinttextdocuments.With
WordPad, you can type letters, book reports, and other simple documents. You can also
change how the text looks, quickly move sentences and paragraphs around, and copy
and paste text within and between documents.

TheWordPadwindow
ToopenWordPad,clickthe Start button ,click All Programs,clickAccessories,andthen click
WordPad.

TherearefourmainpartsoftheWordPadwindow:

The toolbar: The toolbar contains buttons for basic commands, including saving and
printing. To find out what a button does, rest your mouse pointer on it. A box pops up
showing the function of the button.

The format bar: Theformat bar contains buttons that you can use to format the text in
yourdocument.Forexample,youcanchoosethefont,color,andalignmentofyourtext. The
ruler: Usetheruler to check the layoutandplacementof text in your document.

The document area:Thisiswhereyoutypeyourdocument,makechangestothetext,and apply your
formatting.

Typing text:Whenyou'rereadytogetstarted,typeinthedocumentareaofWordPad.A flashing
vertical line called the cursor indicates where the next text that you type will
appear.Tomove the cursor within text, click where you want the cursor to appear.

Unlike using a typewriter, when you type in WordPad you don't have to press ENTER to
startanewline.WordPadwilltakecareofthatforyoubyautomaticallystartinganewline when
you reach the end of the one you're working on. When you want to start a new
paragraph, press ENTER.

Selectingtext

Wheneveryouwanttodosomethingtotextinyourdocument,suchascopyitorformat
it,youneedtoselectitfirst.Toselecttext,positionthemousepointertotheleftofwhere
youwanttobeginyourselection.Withthepointerpositioned,clickandholdtheleftmouse
buttonwhileyoudragthepointeroverthetextthatyouwanttoselect.Theselectedtext will be
highlighted. Once you've completed your selection, release the mouse button.

Copyingandmovingtext

Ifyouhavetextinonepartofyourdocumentthatyouwanttoappearinanotherpart,there
aretwowaystomovethetextaroundwithouthavingtoretypeit:Youcancopyandpaste it to
another location, or you canmove it toanother location.



When you copy text, it is placed in the Clipboard. You can then paste it in a different location.
The original text is preserved.

Whenyoumovetexttoanotherlocation,theoriginaltextisnotpreserved.Youmightfind this
method useful when you want to rearrange the sentences and paragraphs in your
document.

To copytext and paste it in anotherlocation

1. Selectthetextthatyouwanttocopy.

2. OntheEditmenu,clickCopy.

3. Movethecursortothelocationwhereyouwanttoinsertthecopiedtext.

4. OntheEditmenu,clickPaste.

Tip

Toquicklycopytextthatyou'veselected,pressCTRL+C.Topasteit,pressCTRL+V.

Insertinganddeletingtext

WordPad makes it easy to insertand delete text wherever you want. To inserttext, click
whereyouwanttoinsertthetextandthenjuststarttyping.Todeletetext,selectthetext that you
want to delete, and then press DELETE.

Formattingyour document

Formattingreferstothehowthetextinyourdocumentlooksaswellashowitisarranged. WordPad
lets you easily change the formatting in your document. For example, you can
choosefrommanydifferentfontsandfontsizes,andyoucanmakeyourtextalmostany color you
want. You can also easily change how your document is aligned.

Tochangethefont,fontstyle,orfontsize:

1. Selectthetextwhoseformattingyouwanttochange.

2. OntheFormatmenu,clickFont.

3. IntheFontbox,typeorselectthefontyouwanttouse.

4. IntheFontStylebox,typeorselectthefontstyleyouwant.

5. IntheSizebox,typeorselectthesizeyouwanttouse.

Tochange the color

1. Selectthetextwhosecoloryouwanttochange.

2. OntheFormatmenu,clickFont.



3. UnderColor,clickthecolorthatyouwant.

Tochange the alignment

Youcanalignthetextinyourdocumenttoeithertheleftmargin,thecenter,ortherightmargin.

1. Selecttheparagraphwhosealignmentyouwanttochange.

2. OntheFormatmenu,clickParagraph.

3. IntheAlignmentbox,clickthealignmentyouwant.

Savingyourdocument

It'sagoodideatosaveyourdocumentperiodicallywhileyouareworkingonitsothatin case your
computer stops working for some reason, you won't lose any of your work.
Savingthedocumentwillalsoallowyoutocomebacktoitlaterifyouwanttoworkonit again.

Tosavethedocument

OntheFilemenu,clickSave.

Ifyouhaven'tsavedthedocumentyet,you'llbeaskedtoprovideanameforthedocument and
location on your computer to save it to:

1. IntheSaveinbox,clickthelocationwhereyouwanttosavethedocument.

2. IntheFilenamebox,typeanameforyourdocument.

3. ClickSave.

Printingyourdocument

On the File menu, click Print. In the Print dialog box, use the Page Range box and the
Number of copies box to specify which pages you want to print as well as how many
copies. When you're done, click Print.

MS-OFFICE:
MicrosoftOfficeisanofficesuiteofdesktopapplications,serversandservicesforthe
Microsoft Windows and OS X operating systems, introduced by Microsoft on August 1,
1989.Initiallyamarketingtermforabundledsetofapplications,thefirstversionofOffice
contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years,
Office applications have grown substantially closer with shared features such as a
common spell checker, OLE data integration and Microsoft Visual Basic for
Applications scripting language. Microsoft also positions Office as a development platform for
line-of-business software under the Office Business Applications brand. Office is reported to
now be used by over a billion people worldwide.



The current versions are Office 2013 for Windows, released on October 11, 2012 and
Office 2011 for OS X, released October 26, 2010. On 24 October 2012, the RTM final
code of Office 2013 Professional Plus has been released to TechNet and MSDN
subscribersfordownload.On15November2012,the60-daytrialversionofOffice2013
Professional Plus was released for download.

MS-WORD
Microsoft→ordisanexampleofaprogramcalleda“wordprocessor.”Thekeybenefitto
usingawordprocessoristhatyoucanmakechangeseasily,includingcorrectingspelling;
adding,deleting,formatting,andrelocatingtext;andinsertingimages.Onceyoucreatea
document, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a friend via e-mail. Microsoft Word is a very powerful word
processor—this handout was created using just a small number of its features!

MicrosoftWordisavailableonbothPCsandMacs,sowhatyoulearninclasstodayshould
beapplicabletoanycomputeryouuse.Theprogrammaylookslightlydifferentdepending on the
version and computer that you’re using, but Microsoft →ord will function in the same
basic ways. There are other word processors out there, including OpenOffice.org Writer,
WordPerfect, Apple Pages, and WordPad. They have many features in common with
MicrosoftWord, and you should feel free to choose any program you prefer.

OpeningMicrosoft Word
TogetstartedwithMicrosoftWord(sometimescalled“MS→ord”),youwillneedtolocate and
openthe program on yourcomputer.Toopen the program, point to →ord’s iconon
thedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon’t see the
MS→ordiconon yourdesktop,you’llhave toaccesstheprogramfrom the Start
Menu.ClickonthebuttoninthebottomleftcornertopulluptheStartMenu.Youshould see the
MSWord iconhere, so click on it once with yourleft button. If you stilldon’t see
it,clickon“AllPrograms”andscrollthroughthelistofprogramsuntilyoufindit.Clickonce
withyourleftbuttontoopentheprogram.Occasionally,MicrosoftWordwillbeinafolder
called“MicrosoftOffice”orsomethingsimilar—thiswillmakeonemorestepbetween“All
Programs” and “Microsoft →ord.”

MS→ordwillthenopenablankpagecalled“Document 1.”
Thisisanimageoftheupper-leftcornerofMSWord.Thisboxfeaturestwoimportantpiecesof
information:thenameofthefilethatyouarecurrentlyworkingon(inthiscase,
“Document 1” since we have not yet renamed it) and which program you are using
(“Microsoft→ord”).Thereshouldnowbeablinkinglineinthetopleftcornerofthepartof the
screen that looks like a sheet of paper. This means you will be able to type in this space!



MicrosoftWordFeatures

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“MicrosoftWord”)andthenameoftheprogram(“Microsoft→ord”).Notice the
threebuttonsonthe right side, controllingthe size and closingoftheprogram.
Minimize:Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearin the task
bar
Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.
Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure you
save your work first!
RestoreDown:
Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.ThetabbedRibbon menu
system is howyounavigate throughWord andaccessvariousWordcommands.If you have
used previous versions of Word, the Ribbon system replaces the traditional menus.

The File Menu
InMicrosoftOffice2007,therewassomethingcalledtheMicrosoftOfficeButton()inthe top left-
hand corner. In Microsoft Office 2010, this has been replaced with a tab in the Ribbon
called “File.”
When you left-click on this tab, a drop-down menu appears. From this menu, you can
performthesamefunctionsaswerefoundundertheMicrosoftOfficeButtonmenu,such as:
Create a new document, open files, save files in a variety of ways, and print.



QuickAccessToolbar
On the top left-hand side of the Title Bar, you will see several little icons above the File
menu.Theseletyouperformcommontasks,suchassavingandundoing,withouthaving
tofindtheminamenu.→e’llgooverthemeaningsof theiconsalittlelater.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change the font, size, color, alignment, organization and style of the text in the
document. For example, the “Times New Roman” Indicates the FONT of your text, the
“12”indicatestheSI↕Eofyourtext;etc.→ewillgooverhowtousealloftheseoptionsto
formatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-click
onthetinydown-arrowinthebottomrightcornerofthewindow.Therulerisfoundbelow the
Ribbon.The ruler tells you where you are on the page, alongwith the dimensionsof
theoveralldocument.Justlikearealpieceofpaper,thedefaultsettingis8.5x11inches,
andthemarginshavebeenincorporatedforyou.SimilartomostoptionsinMSWord,this is
entirely customizable and the user can create a document of any dimensions.

Keyboard Review

InordertouseMSWordeffectively,youmustinputcommandsusingboththemouseand
thekeyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfront of you;
learning just a few certain keys will help to improve your efficiency in typing, as well as
present you with more options within the program. The following is a list of commonly
used keys that have special functions in MS Word (key functions can change depending
on which program you are using) :

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey, willperformasecondary

Function.

4. Spacebar:This keyentersa spacebetween wordsorletters.

5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault Indent

distance is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.



8. Enter:Thiskeyeithergivesyou a newline, orexecutesa command(pressed inMSWord, it

begins a new line).

9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe

Keyboard; some people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocument.

MICROSOFT WORDBASICS

TypingText

Toentertext,typejustasyouwouldifyouwereusingatypewriter.Tocapitalizealetter, hold
down the SHIFT key while typing the letter. Or, press the CAPS LOCK key on the left-
hand side of your keyboard. You will have to press the CAPS LOCK key again—once you
are done capitalizing—to remove the lock. You do not need to press ENTER to start a
new line—Microsoft Word will automatically wrap your sentence at the end of the line.
Tomovethecursorfromitspositionattheendofyoursentencetoanywhereelseon the
page,usethemouseorthearrowkeystomovethecursorwhereyouwantthelettersor spaces to
be (left-click the mouse to place the cursor) and then type what you want to add—
thetextwillautomaticallyadjusttoincludeit.PressENTERtostartanewparagraph (this is
sometimes called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Wordcandeletetextonthescreenandleavenotrace—itisasif younevertypedonthe
pageinthefirstplace.Therearetwodifferentbuttonsonthekeyboardthatwillallowyou to erase
text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the keyboard
map on page. The “Backspace” key deletes words to the LEFT of the cursor, and the
“Delete” key deletes words to the RIGHT of the cursor.

BACKSPACE↔ DELETE

Let’sassume that the vertical line dissectingthe word “creative” in the example above is
our cursor. Pressing the “Backspace” key will erase “a,” “e,” “r,” “c,” and so on, moving
LEFT.The “Delete”keywillerase “t,”“i,”“v,”“e,”and soon,moving RIGHT.

Todeleteawholechunkoftextatonce,left-clickwithyourmouseanddragtohighlighta
sectionoftext.Thensimplypress“Backspace”or“Delete”andallofthehighlightedText will
disappear.



Undoingand Redoing

The UNDO and REDO features of Microsoft Windows applications are great tools to rely
on.Theprogramwillkeepalistofthelast25commandsthatyouhaveperformed,andit allows for
taking “one step” backwards in order to erase what you have just done. Click
ontheUNDObuttonintheQuickAccessToolbartogobackonestep.ClickontheREDO button in
the Quick Access Toolbar to go forward one step.

FormattingText

Changingthelookofwhatyou’vewritteniscalled“formatting.”Thiscanincludechanging
thetextstyle,size,color,andmore.Thisisasentencethatfeaturesmanydifferentfonts. This is a
sentence that features many different sizes. From the Home Tab, the “B” will
makeyourtextBOLD,the“I”willputitinitalics,andthe“←”willaddanunderlinetoyour
text.Thesefeaturesdonothavetobeusedindependentlyofeachother—inotherwords,
youcanbold,underline,anditalicizeasinglepieceoftext.Thealignmentofthetextcan be altered
usingthe buttons with the horizontal lines on them. You can align text To the LEFT, To
the CENTER and to the RIGHT.

Inordertoapplycertainstylisticorformattingchangestotext,youmustfirst
HIGHLIGHTthetext.ThisisacommonprocedureinMicrosoftWindowsapplications,and
becauseitissouseful,itisaskillworthpracticing.Youcanalsochangethefontcolorby clicking on
the appropriate buttons in the

FormattingToolbar.Experimentandremember—youcanalwaysstartoverwithafresh,
newdocument,sodon’tworryaboutmakingmistakes!Ifyoudo,however,thereisalways
theincredible“←NDO”tool.Cutting,Copying,andPastingTextinMSWord,youcanCUT
orCOPYtextfromoneareaofthedocumentandsavethattexttobePASTEDelsewhere (these
commands are found on the Home Tab).When you CUT text, you actually delete it from
where you took it, as opposed to COPYING it, which makes a copy of your selection.

When you CUT or COPY text, it is stored on the CLIPBOARD. The Clipboard is a tool in
MS Word that stores cuts and copies of your work, to be pasted in other places in the
document. Once your selection is on the CLIPBOARD, you can PASTE it as many times
as you want! CUTTING a selection will place it on the clipboard, just in case you wantto
PASTE it elsewhere. To CUT a selection, first highlight it. Then, click on the CUT icon
fromtheHomeTab.Thehighlightedtextwilldisappear,asyouhavejustcutitout,buta
copyisnowonyourclipboard,andMSWordiswaitingforyoutopasteitsomewhereelse.

To PASTE this cut selection, place your cursor where you want the selection to go. Click
on the PASTE icon from the Home Tab toolbar, and it will pop the text into place, right
where you have your cursor. To COPY, simply follow those same steps, replacing the
CUT command with COPY. The COPY command will not alter your original selection at
all,asitsimplymakesacopyoftheselectionwithoutchangingordeletingitinanyway.



DOING MORE WITHMICROSOFT WORD

InsertingImagesandClipArt

WithMicrosoftWord,youcaninsertpicturesinyourdocumentusingtheInsertTabtoolbar.
↔oucaninsertpicturesfromthe“ClipArt”albumthatcomeswiththeprogram,oryoucan insert
pictures from a file that you have previously saved on a disk or elsewhere on the
computer (e.g., the My Pictures folder).Clip Art is a collection of cartoon and computer-
generatedimagesthatcoverabroadarrayofcommonlyneedediconsandpictures.These
includebusiness,holiday,nature,entertainment,academicandotherthemes,alongwith
standard bullets and symbols.

To insert a clip art picture into a Microsoft Word document, you will first need to place
yourcursor(left-click)whereyouwishtoinsertyoupictureinyourdocument.Then,from
theInserttabontheRibbon,clickon “Clip Art.” AClipArtsearchboxwillappearonthe
rightsideofyourscreen.Fromhere,youcanenterasearchwordforthepictureyouwould
liketofind.Thenclick“Go.”Thiswillshowalltheoptionsofpicturesyoucaninsert.When
youseeapieceofclipartthatyoulike,clickonit,anditwillautomaticallyinsertintoyour
document,intheexactplacewhereyouleftthecursor.Toresizeyourimage,graboneof
thecornersoftheimagebyleft-clickingandholding—dragittoyourdesiredsizeandfine-
tunetheplacement.Thecursorwillchangefromatypingicontoadoublearrowwhenit can be
used to resize an image.

Dragthecornertowardtheupper-leftcornerofthescreen,andtheimagewillgrow.Drag
towardthebottom-right,anditwillshrink.Youcanmovetheimagetoanotherplaceinthe
document by left-clicking and holding on the center of it; drag it to its desired location.
More options, such as aligning the image with text (or special effects like wrapping text
around orthrough an image)can befound byclickingon the picture, and then choosing the
Picture Tools Tab. You can also insert a photograph or other images from your files
using this same process. On the Insert Tab,click on Picture and locate the files that you
want to include.

ModifyingLine Spacing

Line spacing inWord refers to the amount of space between lines of text. The default in
Word 2010 is 1.15 spacing, which leaves a little bit more space than single-spacing, or
whatyouwouldfindinanormalbook.Singlespacingisgenerallyeasyfortheeyetoread.
Theremaybetimes,however,whenyouwanttochangethisspacing.Onecommonoption is to
double-space text: This text is double-spaced. Double-spacing is especially useful if
someoneelseisproofreadingyourdocument.Itallowsformoreroomtowritecomments on the
page.

Tochange theline spacing:

1. Selecttextyouwanttoformatbyhighlightingit.



2. OntheHomeTab,clickontheLineSpacingbuttonintheParagraphgroup.
3. Choose the spacing you want from the menu that appears. For more options, select Line
Spacing Options. In the dialog box that appears, you can choose other spacing options,
including spacing between paragraphs. This can be done by changing the values in the
Before and After boxes.

CreatingBulletedand Numbered Lists

Wordallowsyoutocreatelistswithinyourdocumentthatcanbeorganizedwithbulletsor
numbers. Lists are useful for presenting text that wouldn’t make the most sense in
paragraph form (for example, step-by-step instructions) or for emphasizing key points
Bullets are usually small circles at the beginning of item in a list, and numbers are used
for lists that are arranged in sequential order.Here’s an example of a bulleted list:

• Bananas
• Milk
• Eggs
• IceCream

Tocreatealist:

1. On the Home tab, select either the Bullets or Numbering buttons from the Paragraph
group. If you want to choose a particular style for your bullets or numbers, click on the
triangle next to thebutton and choose astyle from themenuthat appears.

2. You will see the first bullet or number appear on your document. Type your first line of
text and then hit Enter.

3. Another bullet or number will appear automatically. Type your next line of text and hit
Enter.

4. Whenyouhavefinishedyourlist,hitEntertwicetoendthebulletsornumbering.

ChangingViewsandOverall Look

There will be times when you need to create documents that don’t fit on a standard piece of
paper (8.5” by 11”).

ClickonthePageLayoutTab.

From this menu, you can alter the margins, width, height, and orientation (portrait =
11”14long; landscape = 11” wide) of the document, as well as choose from a variety of
templates,differenttypesofpaper,anddocumentstylesthatcomewiththeprogram.To change
the orientation of your page, clickon the Orientation button.



ClickonLandscapefromthedrop-downboxthatappears.Yourdocumentshouldnowbe in
landscape position. If you wish to return to portrait orientation, go through the same
steps,clickingontheLandscapeoptioninsteadofPortrait.Ifyouwouldliketochangethe
displayofyourdocumentorzoominandoutwithoutaffectingthewayyourdocumentwill
print,youcandothatfromtheViewTab.AnythingyouchangefromtheViewTabwillnot
changethewayyourdocumentprintsout.Soifyouwantyourtexttobebiggerwhenyou
printoutthedocument,makesuretochangethesizeof thefontinsteadof thezoom.

SpellingandGrammar Check

One benefit of using a computerized word processor is its ability to recognize, change,
andgiveadviceaboutyourwriting.MSWordhasutilitiesthatcancheckyourspellingand
grammar against a master database, and can offer advice on a variety of different
grammatical styles. MS Word automatically underlines any words that it does not
recognize in red, assuming that theyare not spelled correctly, and underlines in green if
itdoesnotrecognizethegrammaticalpattern,assumingthatthesentencedoesnotmake sense.

Forexample:Inthiscase,“jumping”shouldread“jump”and“laziy”shouldbe“lazy.”Ifyou
rightclickontheword,amenuwithpopupwithoptions,including“Ignore”ifyoudonot want help
on this specific phrase or agree with the suggestion. You can also choose to
addwordstotheMSWordspellingdatabase,ifyouaregoingtousethemoftenanddon’t
wantthem tobeflaggedasmisspelledeverytime—thisisespeciallyusefulfornames,as MS
Word often interprets these as misspellings. The spelling and grammar tools can be
found in the Review Tab

USINGMICROSOFTWORD

Microsoft →ord is an example of a program called a “word processor.” →ord processors
areusedtocreateandprinttextdocumentsinmuchthesamewaythatyouwouldusea
typewriter.Thekeybenefittousingawordprocessoristhatyoucanmakechangeseasily,
includingcorrectingspelling;adding,deleting,formatting,andrelocatingtext;andinserting
images.Onceyoucreateadocument,youcaneffortlesslyprintit(asmanycopiesasyou
want!),saveitforlatermodifications,orsendittoafriendviae-mail.MicrosoftWordisa
verypowerfulwordprocessor—Thishandoutwascreatedusingjustasmallnumberofits
features! Microsoft Word is available on both PCs and Macs, so what you learn in class
today should be applicable to any computer you use. The program may look slightly
differentdependingontheversionandcomputerthatyou’reusing,butMicrosoftWordwill
function in the same basic ways. There are other word processors out there, including
OpenOffice.org Writer, WordPerfect, Apple Pages, and WordPad. They have many
featuresincommonwithMicrosoftWord,andyoushouldfeelfreetochooseanyprogram you
prefer.

OpeningMicrosoft Word

TogetstartedwithMicrosoft→ord(sometimescalled“MS→ord”),youwillneedtolocate and
openthe program on yourcomputer.Toopen the program, point to →ord’s iconon



thedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon’t see the
MS→ordiconon yourdesktop,you’llhave toaccesstheprogramfrom the Start
Menu.ClickonthebuttoninthebottomleftcornertopulluptheStartMenu.Youshould
seetheMSWordiconhere,soclickonitoncewith yourleftbutton. If youstilldon’tsee
it,clickon“AllPrograms”andscrollthroughthelistofprogramsuntilyoufindit.Clickonce with
yourleftbuttontoopentheprogram.

Occasionally, Microsoft Word will be in a folder called “Microsoft Office” or something
similar—thiswillmakeonemorestepbetween“AllPrograms”and“Microsoft→ord.”MS
→ordwillthenopenablankpagecalled“Document1.”Thisisanimageoftheupper-left corner of
MS Word. This box features two important pieces of information: the name of the file
that you are currently working on (in this case, “Document 1” since we have not yet
renamed it) and which program you are using (“Microsoft →ord”).There should now be
ablinkingline in the top left cornerofthepartofthescreenthatlookslike a sheetof paper. This
means you will be able to type in this space!

MICROSOFT WORDBASICS

TypingText

Toentertext,typejustasyouwouldifyouwereusingatypewriter.Tocapitalizealetter, hold
down the SHIFT key while typing the letter. Or, press the CAPS LOCK key on the left-
hand side of your keyboard. You will have to press the CAPS LOCK key again—once you
are done capitalizing—to remove the lock. You do not need to press ENTER to start a
newline—Microsoft Word will automatically wrap your sentence at the end of the line.
Tomovethecursorfromitspositionattheendofyoursentencetoanywhereelseonthe
page,usethemouseorthearrowkeystomovethecursorwhereyouwantthelettersor spaces to
be (left-click the mouse to place the cursor) and then type what you want to add—
thetextwillautomaticallyadjusttoincludeit.PressENTERtostartanewparagraph (this is
sometimes called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Wordcandeletetextonthescreenandleavenotrace—itisasif younevertypedonthe
pageinthefirstplace.Therearetwodifferentbuttonsonthekeyboardthatwillallowyou to erase
text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the keyboard
map on page.

The“Backspace”keydeleteswordstotheLEFTofthecursor,andthe“Delete”keydeletes words to the
RIGHT of the cursor.

MicrosoftWordFeatures

The Title Bar



This is a close-up view of the Title Bar, wherefile information is located. It shows the name of
the file (here, “Microsoft Word”) and the name of the program (“Microsoft →ord”). Notice the
threebuttonsontheright side, controllingthe size and closingof the program.

Minimize:Leftclickthisbuttontoshrinkthewindowdowntoasmallbuttonthatwillappearin the task
bar

Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.

Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning.Make sure you
save your work first!

RestoreDown:Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.

The FileMenu

InMicrosoftOffice2007,therewassomethingcalledtheMicrosoftOfficeButton()inthe top left-
hand corner. In Microsoft Office 2010, this has been replaced with a tab in the Ribbon
called “File.” When you left-click on this tab, a drop-down menu appears. From
thismenu,youcanperformthesamefunctionsaswerefoundunder theMicrosoftOffice
Buttonmenu,suchas:Createanewdocument,openexistingfiles,savefilesinavariety of ways,
and print.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change thefont, size, color, alignment, organization and style of the text in the
document. For example, the “Times New Roman” indicates the FONT of your text; the
“12”indicatestheSIZEofyourtext;etc.Wewillgooverhowtousealloftheseoptionsto
formatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-click
onthetinydown-arrowinthebottomrightcornerofthewindow.

The Ruler

TherulerisfoundbelowtheRibbon.Therulertellsyouwhereyouareonthepage,along with the
dimensions of the overall document. Just like a real piece of paper, the default
settingis8.5x11inches,andthemarginshavebeenincorporatedforyou.Similartomost options
in MSWord, this is entirely customizable and the user can create a document of any
dimensions.

Keyboard Review

InordertouseMSWordeffectively,youmustinputcommandsusingboththemouseand
thekeyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfront



of you; learning just a few certain keys will help to improve your efficiency in typing, as
well as present you with more options within the program. The following is a list of
commonly used keys that have special functions in MS Word (key functions can change
depending on which program you are using)

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.

4. Spacebar:This keyentersa spacebetween wordsorletters.

5. Tab: This key will indent what you type, or move the text to the right. The default indent
distance is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter you type
capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:Thiskeyeithergives you anewline,or executesacommand(pressed inMSWord,it begins a
new line).

9. Number Keypad: These are exactly the same as the numbers at the top of the keyboard;
some people just find them easier to use in this position.

10.ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentorpage.

MICROSOFTEXCEL
Microsoft Excel is an example of a program called a “spreadsheet.” Spreadsheets are
used to organize real world data, such as a check register or a rolodex. Data can be
numerical or alphanumeric (involving letters or numbers). The key benefit to using a
spreadsheet program is that you can make changes easily, including correcting spelling
or values, adding, deleting, formatting, and relocating data. You can also program the
spreadsheettoperformcertainfunctionsautomatically(suchasadditionandsubtraction), and
a spreadsheet can hold almost limitless amounts of data—a whole filing cabinet’s worth
of information can be included in a single spreadsheet. Once you create a spreadsheet,
you can effortlessly print it (as many copies as you want!), save it for later modifications,
or send it to a colleague via e-mail. Microsoft Excel is a very powerful.

OpeningMicrosoftExcel
TogetstartedwithMicrosoftExcel(oftencalled“Excel”),youwillneedtolocateandopen
theprogramonyourcomputer.Toopentheprogram,pointtoExcel’sicononthedesktop with
your mouse and double-click on it with the left mouse button. If you don’t see the



Excelicononyourdesktop,you’llhavetoaccesstheprogramfrom theStartMenu.Click
onthebutton in thebottom left cornertopulluptheStart Menu.YoumayseetheExcel icon
here, so click on it once with your left button. If you still don’t see it, click on “All
Programs”andscrollthroughthelistofprogramsuntilyoufindit.Itmayalsobelocated in a folder
called “Microsoft Office” or something similar—it will depend on your specific
machine.Clickoncewithyourleftbuttontoopentheprogram.Excelwillthenopenablank page
called “Book1.”

MicrosoftExcelFeatures

The Title Bar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“Book1,”thedefaulttitle)andthenameoftheprogram(“MicrosoftExcel”).
↔ou will be able to name your file something new the first time that you save it. Notice
thethreebuttonsontherightsideoftheTitleBar,controllingthesizeandclosingofthe program.

TheRibbon Menu System
The tabbed Ribbon menu system is how you navigate through Excel and access various
Excel commands. If you have used previous versions of Excel, the Ribbon system
replaces the traditional menus. At the bottom, left area of the spreadsheet, you will find
worksheet tabs. By default, three worksheet tabs appear each time you create a new
workbook.Onthebottom,rightareaofthespreadsheetyouwillfindpageviewcommands, the
zoom tool, and the horizontal scrolling bar.



The FileMenu
InMicrosoftOffice2007,therewassomethingcalledtheMicrosoftOfficeButton()inthe top left-
hand corner. In Microsoft Office 2010, this has been replaced with a tab in the Ribbon
called “File.”→hen you left-click on this tab, a drop-down menu appears.
From this menu, you can perform the samefunctions as were found under the Microsoft
Office Buttonmenu, such as: Createa newworksheet, open existingfiles, save files ina
variety of ways, and print.6
Quick AccessToolbarOn the top left-hand side of the TitleBar, you will see several little
icons above the File menu. These let you perform common tasks, such as saving and
undoing,withouthavingtofindtheminamenu.→e’llgooverthemeaningsoftheicons a little
later.

TheHomeTab
The most commonly used commands in Excel are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change the font, size, color, alignment, organization and style of the text in the
spreadsheet and individual cells. For example, the “Calibri” indicates the FONT of your
text;the“11”indicatestheSIZEofyourtext;etc.Wewillgooverhowtouseallofthese
optionstoformatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuif you left-
click on the tiny down-arrow in the bottom right corner of the window. This tab works
the exact same way as the MS Word Formatting Toolbar. The main difference is
thattheformatchangeswillonlyaffecttheselectedcellorcells,allunselectedcellsremain in
thedefaultsetting(“Calibri”font, size “11”).

Equation Editor
TheEquationEditorisgenerallyfoundbelowtheribbonmenu.Theleftsidedenoteswhich cell is
selected (“C5”) and the right side allows you to input equations or text into the selected
cell.
Therearetwowaystoinputinformationintoacell.Youmayeitherselectanindividualcell
andtypetheequationortextintotheequationeditorortypetheequationortextdirectly
intotheselectedcell.Equations(forexample,=SUM(D5+E5))willautomaticallybehidden
insidethecellandcanonlybeviewedusingtheequationeditor;theresultoftheequation
willdisplayinthecell.Ifanywrittentextislongerthanthecellwidth,thenthespreadsheet
willcoverupanyportionlongerthanthecellwidth.Theinformationwillstillbeinthecell, you just
won’t be able to see it at all times.

Keyboard Review
InordertouseExceleffectively,youmustinputcommandsusingboththemouseandthe
keyboard.Theaboveimageofakeyboardshouldlooksimilartothekeyboardinfrontof
you;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintypingaswell
aspresentyouwithmoreoptionswithintheprogram.Thefollowingisalistofcommonly used
keys that you may already be familiar with:
1. Backspace:Thiskeydeleteslettersbackwards.
2. Delete:Thiskeydeleteslettersforward.



3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.
4. Spacebar:This keyentersa spacebetween wordsorletters.
5. Tab: This key will indent what you type, or move the text to the right. The default
indentdistance is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutype capitalized.
7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.
8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand.
9. Number Keypad: Theseare exactly thesameas the numbersat thetop ofthekeyboard; some
people just find them easier to use in this position.

10.ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentorpage.

Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work in
Excel. Each pointer shape indicates a different mode of operation. This table shows the
various pointer shapes you may see while working in Excel.

MICROSOFTEXCEL BASICS

Formatting Cells
Cells are the small rectangular boxes that make up the spreadsheet. All the information
entered into an Excel spreadsheet is entered into cells. The cell width and height will
usuallyneed to be adjusted to viewall the information entered into a cell.

To adjust the cell width, move the mouse pointer in between two cell columns in the
columnheader.Holddowntheleftmousebuttonanddragthemouselefttoshortenthe
widthorrighttoexpandthewidth.Noticethatallcellswithinthecolumnareautomatically
adjusted.Adjustthecellheightusingthesamemethod.Movethemousecursorbetween
tworows,holddowntheleftmousebuttonandmovethemouseuptodecreasetheheight
anddowntoincreasetheheight.Beforeyoubeginenteringdataintoaspreadsheet,you
mayalreadyknowthewidthandheightyouwantyourcellstohave.Inthiscase,youcan adjust all
the widths and heights by doing the following: Select the “square” between Column A
and Row 1.

ThiswillselectALLthecellsinthespreadsheet.Fromthe“Home”taboftheRibbonMenu, within
the “Cells” box, click on “Format,” and select Row Height. ↔ou will nowbe asked
toenteranumericalvalueforheight.Thedefaultvalueis15,butyoucanenteryourown height
value (10, 20, 25, etc.).

RepeatthesamestepsforColumnwidth.Fromthe“Home”taboftheRibbonMenu,within the
“Cells” box, click on “Format,” and select Column →idth. Note that the default value
forthewidthis8.43.Enteryourownwidthvalue(5,10,15,20,etc.).

Foranygivencellorselectedcells,youcanalsoformatthewayyourdataisrepresentedwithin the cell(s).
Select a single cell or multiple cells.



Again,fromthe“Home”taboftheRibbonMenu,withinthe“Cells”box,clickonFormat.” Select
“Format Cells.”The format window will now appear, giving you a wide variety of options
on how to format your cell.

Number – This allows you to choose how to represent the numbers that are entered into a
cell (number, currency, time, etc.).
Alignment–Thisdetermineshowthedatawillbealignedwithinthecell(left-side,centered,or right-
side).
Font–Selectthetypeoffonttobeusedwithinthecells.
Border –Thisoptionletsyouchoosewhattypeofborder,ifany,youwouldlikearoundthe cells or
some of the cells.
Fill –Thisallowsyoutochangethebackgroundcolorofthecell.
Protection –Thisoption allows you to “lock” cell information so that otherusers cannot
make changes.Typing in Cells
Clickonacelltobegintypinginit.Itisthateasy!Whenyouarefinishedtypinginthecell,
presstheEnterkeyandyouwillbetakentothenextcelldown.Youcanthenbegintyping
inthatcell.Youcaneasilynavigatearoundthecellsusingyourarrowkeys.Keepinmind that the
Formatting toolbar in Microsoft Excel 2010 is exactly the same as the one used for
Microsoft Word 2010. The biggest difference between the two programs is that, in Excel,
the format is set for each individual cell.

SoifyouchangethefontandappliedtheboldoptionincellC5,thenthisformatwillonly
beappliedtocellC5.Allremainingcellswill remainindefaultmodeuntiltheyhavebeen
changed.Sometimesyoumayonlywishtoadjusttheformatofoneparticularcell.Inthis case,
simply select the cell by clicking the mouse on it and make any necessary
adjustmentstothefont,size,style,andalignment.Thosechangeswillnotcarryoverwhen you
begin typing in a new cell. Other times, you may wish to adjust the text format of a
group of cells, entire rows, or entire columns.

InExcel,youcanchoosegroupsofcellsinrectangularunits—allthe cells
you select must form a rectangle of some kind. To select a group of cells, begin by
clicking on the cell that would be in the upper-left hand corner of your rectangle. Hold
downtheShiftkeyonyourkeyboardandusethearrows(,,,)onthekeyboardtoexpand the
selection of cells, or click and drag your mouse. Once the group of cells has been
selected, you can make adjustments to the font, size, style, and alignment and they will
be applied to all selected cells.

Toselectanentire row, click ontheRowNumber with your mouse—note howtheentire
rowbecomeshighlighted.Allformattingchangeswillnowbeappliedtothewholerow.To
selectanentirecolumn,clickontheColumnNumberwithyourmouse—again,theentire column
will become highlighted. All formatting changes will be applied to the whole column.

InsertingRowsand Columns.
Whenyouareworkingonaspreadsheet,youmayrealizethatyouleftoutaroworcolumn
ofdataandneedtoadditin.Toinsertarow,clickontherowbelowwhereyouwantyour



newrowtobe(remembertoclickontherownumbertohighlighttheentirerow).Fromthe “Home”
tab, within the“Cells” box, click “Insert.” Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automaticallyadjusted.Toinsertacolumn,clickonthecolumntotherightofwhereyou
wantyournewcolumntobe(remembertoclickonthecolumnlettertohighlighttheentire
column).Fromthe“Home”tab,withinthe“Cells”box,click“Insert.”Select“Insertsheet
Columns.” A new column will automatically be inserted and the column letters
automatically adjusted.

SortingData
Once you have created your spreadsheet and entered in some data, you may want to
organize the data in a certain way. This could be alphabetically, numerically, or another
way.Let’slookatthefollowingspreadsheetasanexample.Thisinformationcanbesorted
bycheck number, date, alphabeticallybydescription, orusing anyof the other columns.

First, select all the cells that represent the data to be sorted, including the header
descriptions (Check No., Date, Description, etc.). Then, select the first cell in Row 1
(Check No.) Click anddragto selectallthe cells that you want to sort. Usingthemouse,
select Sort & Filter from the Editing panel. Select Custom Sort…
Selectthecolumnyouwishtosortby.Doyouwanttosortby alphabeticalorder,reverse
alphabetical order, date, or amount? →hen you press “OK,” your spreadsheet will be
sorted in the order that you specified.

AutoSumandExcelEquations
OneofthemostpowerfulfeaturesofExcelisitsabilitytoperformbasicmathfunctionson data.
Excel can add, subtract, multiply, divide, find the average, and perform general
countingfunctionsonthenumericaldatathatyouenter.Toenablethisfeature,highlight allof
the cells in a column,plusoneadditional empty cellin which todisplaythe result.

SelecttheAutoSumiconfromtheribbonmenu:
If you click directly on the ∑, Excel will automatically add up the numbers you have
selected.Ifyouclickonthelittledropdownarrownexttoit(▼),youwillgetthefullchoice
ofmathematicalfunctions.Ifyoudouble-clickonthecellinwhichtheanswerappears,you will
see an equation that looks something like this (you will also see this equation in the
Equation Editor):
Let’sbreakdownwhatexactlytheequationmeans:
=indicatesthatyouarestartinganequationinthiscell.
SUMtellsthefunctiontobeperformed.Inthiscase,allthecellswillbeaddedtogether.
( )Theparentheses containthecells that thefunction will be performedon.
D2thisisthefirstcelltobeincludedintheadditionformula.
D8thisisthelastcelltobeincludedintheadditionformulaindicatesthatallcellsbetweenthe first and the
last should be included in the formula.
Thespreadsheetwilloften“select”thecellsthatitthinksyouwishtoinclude.Butyoucan
manuallychangethecellrangebytypingintotheEquationEditor.Whenyouarereadyto



execute the formula, just press the “Enter” key. Other mathematical functions you can
perform from the AutoSum button include:
Average – This function will calculate the average of the selected cells.
CountNumbers–Thisfunctionsimplycountsthenumberof cellsselected. Max –
This function will return the highest value of the selected cells.
Min–Thisfunctionwillreturnthelowestvalueoftheselectedcells.
*Remember* Excel equations are similar to programming languages, so have some
patience and if at first you don’t succeed, try again. Even Excel professionals create
incorrect formulas on their first try.
Onceyougetanequationtowork,youwilltechnicallybeacomputerprogrammer!
Creating Charts andGraphs:
InExcel,therearealsowaystorepresentyourdatainchartorgraphicalforms.Tocreate
achartorgraph,selecttheInserttabfromtheRibbonMenubar.Inthemiddleofthisnew menu,
you will see a “Charts” box.
1. Select the range of data to be represented in the chart or graph. Click on your
spreadsheetandselectthedatatoberepresentedusingthesamemethodthatyouused
toselectdatainthesortingexercise.Forthisexample,wewanttoseeavisualcomparison
ofhowmuchmoneywespentoneachiteminthelist.Selectrows1through8inrowsB, C, and D.
2. Select the type of chart or graph you wish to create (for our example, we’ll choose a
bar graph).
3. Onceyouhavecreatedyourgraph,youcannow“customize”itbygivingitatitleand labeling
different parts. You can also make certain design decisions regarding the appearance of
your graph or chart by choosing the different elements under the Design tab that
appears on the Ribbon Menu bar.
4. Finally, you will need to decide if your chart should be pasted on to the existing
spreadsheet or if it should be pasted on to a brand new sheet. On the very right side of
the Ribbon Menu bar,select Move Chart. Once the chart or graph has been created and
yourealizeamistakehasbeenmadeoritdidnotturnoutthewayyouwanteditto,simply click on
the chart or graph and hit the Backspace keyon your keyboard to delete itfrom your
spreadsheet. Don’t be afraid to go back and try again!

Multiple Sheets

Sometimes you may find it useful to have multiple spreadsheets for related data. For
example, personal finances are usually tracked on a monthly calendar and it’s generally
goodideatokeeprecordsofthepasttransactions.Excelcancreatemultiplespreadsheets
attached to the same Excel file, one for each month. Tabs for the different sheets are
locatedinthelower-leftcornerofthespreadsheet.Thespreadsheetthatiscurrentlybeing worked
on is on the top tab. To access another spreadsheet, select the appropriate tab,
suchasSheet2.ThedefaultnamesforthesheetsareusuallySheet1,Sheet2,andSheet3.
Torenameasheetortocreateanewsheet,simplymovethemousepointeroverthesheet name
and right-click. Select “Rename” to rename the sheet or select “Insert” to create a new
sheet.



You can transfer cell information between two or more sheets by creating a simple
formula.Forexample,mostpeoplewhokeeptrackoftheirpersonalfinancesdon’tbegin
everymonthwith abalanceof $0.Instead, the balanceatthebeginningof themonthis
transferred over from the previous month. So if you have a March 2012 finance
spreadsheetandanApril2012financespreadsheet,youcanselectacellintheApril2012 sheet
and write in the formula

=‘March2012’! D11
Theequalssign(=)tellsExcelthatthevalueforthiscellistobederivedfromsomewhereinthe
spreadsheet (such as a formula or another cell location).
‘Sheet name’ tells Excel what sheet to refer to when it retrieves the value. The single
quotation marks (‘ ‘) are important. ! D11 tells Excel that it is to copy the value that is
located in cell D11 (or whatever cells you wish to copy the value from).
If you want to transfercellinformationfromone celltoanotheron the same sheet, you can use
the exact same formula; just exclude ‘Sheet name.’

DOINGMOREWITHMICROSOFTEXCEL

Cutting,Copying,andPastingData
Whenyouaretypinginyourspreadsheet,itcanbeveryhelpfultocutorcopyinformation from one
cell and paste it into another. This can help reduce the amount of typing you have to do,
as well as limit the number of typographical errors. Cutting, copying, and
pastingthecontentsofcellsinExcelisverysimilartothewayyoudoitinMicrosoftWord.
ThesecommandsareallaccessiblefromtheHometabontheRibbonMenubar. To CUT
thecontentsofacell,clickonthecelltoselectit,thenclickontheCutbuttonontheHome tab. ↔ou
will see the borderof the cell turninto little “marching ants.” The contents are now on the
Clipboard, ready for you to paste them somewhere else.

To PASTE the cut selection somewhere else, clicks on the cell where you want the
selection to go. Then click on the Paste button on the Home tab. The selection will now
appear in the new cell and be removed from the original cell.

To COPY the contents of a cell, simply follow the directions above but replace the CUT
command with COPY. This will leave the contents of the original cell in place and make
an exact copy of them in another cell.

FillingDataacrossColumnsand Rows
Another way to copy text from one cellto another is to drag it or “fill” it across a range of
cells (a row or a column). This is a great method if you want all the text (or numbers) in
column or row to be the same. For example, if you have a spreadsheet for your yearly
budget with a column for rent, you could use this method to fill in all the cells in the rent
column with the same number without re-typing.

Tofillthecontentsofcellsinacolumn:
1. Clickonthecellwiththeinformationyouwanttocopytotheothercells.



2. Hoveryourmouseoverthelittlesquare(calleda“fillhandle”)inthebottomrightcornerofthe
highlighted cell border. Your mouse will turn into a cross.

3. Click on the fill handle and drag your mouse (while still holding the button down) down the
columnuntilyou’vehighlightedallthecellswhereyouwantthetexttogo.

4. Letgoofthemousebutton.Thetextwillnowappearinallthecellsyouhighlighted.
5. You can follow these same steps to fill the contents of a row rather than a column— simply
drag your mouse across the row instead of down the column.

Youcanalsousethistechniquetocopyformulasacrosscolumnsandrowsinthespreadsheet.

CLOSINGMICROSOFTEXCEL

SavingSpreadsheets

Whenyoufinishyourspreadsheetandwanttoleavethecomputer,itisimportanttosave
yourwork,evenifyouareprintingahardcopy.TosaveyourworkinExcel,itisessential to know
WHAT you are trying to save and WHERE you are trying to save it.
Click on the File Tab, then click “Save As” to get started. You can change the filename
thatExcelhaschosenjustbytypinganewoneinthe“Filename”boxatthebottomofthe
windowthatappears.The MyDocumentsfolder on yourcomputer’s harddrive isa good
placetostoreyourdocuments.AblankCDoraUSBjumpdrivearegreatportablestorage
optionsand cancontain a LOT of data.Excelwillautomaticallysave yourdocumentwith
thesuffix“.xlsx”–thisissimplyatagthatletsExcelknowthatyourworkisspecifictothis program
andwhatversionitisin.Youdonothaveto typeit–justhighlight whatisthere
(defaultis“Book1”)andwriteanewfilename.↔oumayalsochosetosaveitinanolder
formatsothatitcanbeopenedwitholderversionsof Excel.Afterthefirstsave,youcan just click
“Save” to preserve your work.

However,itisimportanttonotethateveryfollowingcommandofSAVEwilloverwriteyour
originalfile,creatingthemostup-to-dateversion.Ifyouwouldliketokeepsavingdifferent versions
of your worksheet, be sure to use the “Save As” function each time you save, using a
slightly different name for each version.

Printing Spreadsheets
ToprintyourExceldocument,clickontheFileTab,thenclick“Print”fromtheleft-sidecolumn. A Print
Preview and printing options will appear in your Excel window.
Clickthelarge“Print”buttontosendyourworksheettotheprinter.↔oucanchangethe number
of copies you would like to print, change the paper orientation, choose which printer
you want to use, and more.

Finding More Help
You can get help with Excel by clicking on the Question Mark symbol in the upper-right
handcornerofthemainmenubarorbypressingthe“F1”button.Thiswilltakeyoutohelp from
Office.com, Microsoft’s help website. There are also many other resources and
tutorialsavailableonline.↔oumighttryaGooglesearchwiththewords“Excel2010”and



thefunctionyouaretryingtoperform.Askyourinstructorforhelpfindingtheseresources if you
have any trouble.

Closing the Program
ClickontheFileTab,thenclick“Exit.” OR
ClickontheXinthetoprightcorneroftheExcelscreen.

MICROSOFTPOWERPOINT
MicrosoftPowerPointisaprofessionalpresentationprogramthatallowstheusertocreate
"presentationslides"thatcanbedisplayedonthecomputerscreenorthroughaprojector that is
plugged in to the computer. A PowerPoint presentation is a good way to convey pieces
of information, usually in the form of an outline, to a large audience. Generally,
PowerPoint presentations are appealing to users because they are easy to create and
edit and generallysmall enough tofit onto aCD or a USB Jump Drive. Therefore, a user
does not have to carry around any slides or a slide project, and, if necessary, can make
last-minute changes to the presentation.

MicrosoftPowerPointComponents:

Beforeyou get startedwith Microsoft PowerPoint (commonlyreferred toasPowerPoint),
youwillneedtolocateandopenitonthecomputer.Itmaybeonyourdesktop.
Onthecomputerdesktop:
1. Double-clickontheMSPowerPointicon
IftheMSPowerPointiconisnotonthedesktop,gototheStartmenu:



1. Click ►Start►Programs►MicrosoftPowerPoint*
MSPowerPointwillopenablankpagecalled"Presentation1."

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Noticethedefault title
"Presentation1." You will get a chance to rename your presentation slides the first time
you choose to save it.

TheMenu Bar
The Menu Bar is a common sight in almost all Microsoft Windows programs. It features
text based menus, on which virtually every option available to the user in the entire
program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks.

Standard Toolbar
Toolbars provide "shortcuts" to commands also found in the Menu Bar. Toolbars are
usually located just below the Menu Bar and exist to offer another way to perform the
same task.
The most commonly used commands in MS PowerPoint are also the most accessible.
Some of these commands are:
New|Open|Save|Print |Preview| Spell-check|Copy|Paste|Undo| Insert

Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization, and style of the text in thepresentation slides. For example, (startingfrom
theleftsideoftheToolbar)the"Arial"indicatestheFONTofyourtext;the"32"indicates
theSIZEofyourtext;andsoon.ThistoolbarworkstheexactsamewayastheMSWord
FormattingToolbar.Themaindifferenceisthattheformatchangeswillonlyaffectthetext box in
which you are currently working.
Allothertextboxeswillremaininthedefaultsetting("Arial"font,size"32").Design/New Slide
Icons additional shortcut icons appear on the MS PowerPoint toolbar: the Design icon
and the New Slide icon. Both commands are frequently used, and it is good to be
familiar with their location on the toolbar.

TheDesign icon isashortcuttotheslidedesign page.Hereyou will be
abletocreateandedittheappearanceof yourslide(s).TheNewSlideiconautomatically adds a
new, blank slide for you to work on. You can keep track of the slides you have already
worked on in the Slide Outline box on the left-hand side of the screen. You can access a
slide at any time by clicking on it with your mouse through this screen.

SIMPLETASKSINMICROSOFTPOWERPOINT
Text Boxes:



Text Boxes are "designated" areas that allow you to type words, sentences, and bullet
points into the slide. You can adjust the size and placement of the text box within any
given slide. It is also possible to have multiple text boxes per slide.

WhenyoufirstopenMSPowerPoint,therewillautomaticallybetwotextboxesontheslide:
"Clicktoaddtitle"and"Clicktoaddsubtitle."Thesetextboxesalready haveapreset format applied
to them. The"title" boxhasafont size of "44" while the "subtitle" boxhas
afontsizeof"32."Youcanchangethetextformatofanyboxatanytimebyadjustingthe
formatsettingsontheFormattingToolbar.Toadjustthesizeofthetextbox,firstclickon
thetextbox.Noticethechangeinborder.Onceyouhaveclickedonatextbox,theborder
oftheboxbecomesthickerandlittlecirclesappearonthecornersandatthemidpointsof
thebox.Movethemousepointeroveranyoneofthecircles.Noticethatthemousepointer
willchangetoeitheror.Clickandholddowntheleftmousebutton.Toadjusttheheight,
movethemouseupordown;toadjustthewidth,movethemouseleftorright.Notethat the
corner circles can adjust both height and width, while the mid-point circles can only
adjust either height or width.

To move the text box to a different location on the slide, move your mouse pointer over
anypartofthethick,grayboxoutline.Noticethechangeinyourmousepointer(itwilllook
somethinglikea"plus"sign(+)witharrows).Clickandholddowntheleftbuttononyour
mouse.Youcannowdragthetextboxtoanypositionontheslidebysimplymoving your mouse.
To write in a text box, simplyclick inside the boxwith your mouse.
Whenacursorisflashing,youarereadytotype.

Slide Design:

OneofthemorepopularfeaturesofMSPowerPointisthatitgivestheuseawidevariety of design
choices. At some point, you may wish to change the design and color of the background
of your slides. To do so, simply click on the Design icon. On the righthand
sideofyourscreen,the"SlideDesign"panewillappear.Here,youaregiventhreedesign options
to apply to your slides.

Design Templates:Hereisalistofover20templatesthatyoucanchoosefromtoapply
tothebackgroundofyourslides.Foreachtemplate,youhavetheoptionofapplyingthe
designtoallslidesortoonlytheselectedslide.Youcanviewtheseoptionsbyclickingon
thearrowontherightsideofthetemplate.IfyouareconnectedtotheInternet,youcan also
choose to viewhundreds of additional templates bychoosing"Design Templates on
Microsoft Office Online" on the bottom of the template screen.

Color Schemes: This option gives you a variety of color schemes to choose from to apply to
your selected design template.

AnimationSchemes:Thisoptionwillallowyoutoselectdifferenttypesofanimationthat can be
applied to either all the slides or selected slides. The animation schemes are different
ways the slides are "introduced" to your audience, such as "faded wipe" or "pinwheel."



Designingyour ownbackground:

Sometimesyoumaywishtodesignyourownbackground.
To do this, select Format ► Background… from the Menu Bar. Select the Color Bar on
the bottom of the Background window and choose the appropriate color and or/effects
thatyoudesire.Thereisnorightorwrongwaytodesignyourownbackground,soifyou choose
this option, have some patience and don't be afraid to experiment.

Slide Layout:

ThedefaultinPowerPointforeachnewslideistohaveaTitletextboxandaTextbox.As discussed
earlier, you do have the option of rearranging the text boxes to fit any layout you have
in mind. However,sometimes it willbe easiersimplyto select a layout thatfits your needs
rather than reformatting the default layout for each slide. To choose a slide layout,
select Format► Slide Layoutfrom the Menu Bar. On the right-hand side of your
screen,the"SlideLayout"panewillappear.Fromhere,youhavetheoptionofapplyinga
slidelayouteithertoaselectedslideortoanewslidethathasyettobeinserted.Youcan viewthese
optionsbyclickingon thearrowon the right sideof the template.

Notethefourdifferenttypesoflayout categories.

TextLayout:Theseoptionsareforchoosingalayoutinwhichyouareonlyorganizingdifferent text
boxes. There is no room for pictures, charts, or graphs.

ContentLayout: Theseoptionsareforchoosingalayoutthatwillonlycontainpictures,charts, or
graphs. There is no room for text boxes.

TextandContentLayout:Theseoptionshaveroomforbothtextboxesand pictures,charts,or graphs.

Other Layouts: Theselayoutsaredesignedforothermediacontentsuchasvideoclipsor audio
tracks.

Inserting a Picture:

InsertingapictureintoMSPowerPointisverysimilartoinsertingapictureintoMSWord.

1. Selecttheslidethatyouwishtoaddapictureto.

2. FromtheMenuBar,selectInsert►Picture►FromFile(orClip Art).

3. Choosethepictureyouwishtoinsertandselect"Insert."

*Note*: Thepicturewillbeinsertedinitsoriginalsize,soyouwillprobablyhavetoresize it. You
can re-size a picture the same way you re-sized a text box. Click on the picture
andnotethecirclesatthecornersandatthemidpointsofthelengthandwidth.Moveyour



mouse pointeroverthe circles, left-click themouse and hold the button down. Move the
mouse vertically or horizontally to re-size.
Rotating a picture: ItispossibletorotatepicturesinMSPowerPoint.Onceapicturehas been
inserted onto a slide and you have clicked on the picture so it is "outlined," notice the
green circle above the center of the picture.

Move the mouse pointer over the green circle, and left-click and hold the button down.
Nowmove themouseeitherclockwise orcounter-clockwise and thepicture willrotatein the
same direction.

Inserting aGraph or Table:

TherearetwowaystoinsertagraphortableintoaPowerPointslide.

1. The graph or table may already exist in another document or file. If this is the case,
then you can simply insert the graph or table as you would a picture. Follow the
instructions under

Inserting a Picture.

OryoucouldCut and Pasteagraph orchartfromanother documentor file into yourslide presentation.

2. MS PowerPoint can create graphs or tables directly in the slide. From the Menu Bar,
select

Insert►Chart(orTable).

FortheChartoption,PowerPointwillpresentaverysimplebargraph.

You will need to go in and edit the information in the bar graph to conform to the
information you wish to represent in a chart. From the Datasheet, you can enter in the
appropriate values for the columns and re-name the entities.

TheTableoptionwillpresentyouwiththefollowingwindow:

Selecttheappropriatenumberof rowsandcolumnsyouwishtohaveinyourtable.Click "OK"to
insert the table. Once the table has been inserted you will be able to put information
into the table cells.

Slide Management:

Onceyouhavecompletedaslide,youcancreateanewslidebyclickingontheNewSlide icon.
Notice that your previous slides still appear on the left-side frame. You can still access
your previous slides by simply clicking on them from this location.



Once all your slideshave been completed, you can present your slides in a "slideshow." From
the Menu Bar select Slide Show► ↑iew Show. Notice that the slide takes over our
entirescreen.Tonavigatethroughtheslides,usethearrow
keysonyourkeyboard(,or,).↔oucanalsonavigatethroughyourslidesbyclickingon
theleftorrightarrowsinthelowerleftcornerofyourslide.Toendyourslideshow,click on the
squareboxon the lower left side of your slide show(this is difficult to see at first because
it is designed to blend into you slide show so it won't be noticeable to your audience).
Select End Show from the pop-up window.

CLOSINGMICROSOFT POWERPOINT

SavingSlideShows:

Whenyoucometoastoppingpointandwanttoleavethecomputer,itisimportanttosave
yourwork(evenifyouareprintingahardcopy—savingshouldbeareflex).Tosaveyour work in
MS PowerPoint, it is essential to know WHAT you are trying to save as well as WHERE
you are trying to save it.

Click►File►Save fromtheMenu Bartogetstarted.

YoucanchangethefilenamethatPowerPointhaschosenjustbytypinganewoneintheFile name box at
the bottom of the windowthat appears.

MSPowerPointwillautomaticallysaveyourdocumentwiththesuffix“.ppt”–thisissimply
atagthatletsPowerPointknowthatyourworkisspecifictothisprogram.Youdonothave to type
it – just highlight what is there (default is “Presentation1”) and write a new file name.

The My Documents folder on your computer’s hard drive is a good place to store your
documents. A blank CD (compact disc) or a USB Jump Drive are great portable storage
devices and can contain a LOT of data. It is important to note that every consequent
commandofSAVEwilloverwriteyouroriginalfile,creatingthemostup-to-dateversion.If you
want to save any changes to your PowerPoint slides without destroying the original one:

IntheMenuBar,click►File►SaveAsfromthemenubarandgiveyourdocumentanew filename
(unique from the original). To bring a saved document back up on the screen from MS
PowerPoint:

Click►File►OpenfromtheMenuBar.Locatewherethefileislocated(whichfolder,thatis) and click
on the filename of the document you want.

Click ►Open.

PrintingSlides:



Toprint your MS PowerPointslides:

Click►File►PrintfromtheMenuBarandaPrintwindowwillpopuponthescreen. Click ►OK
for your document to start printing.

AswithallcommandsinMSPowerPoint,youcanmakechangesalongtheway.Fromthe
Printmenu,youcanalterhowmanycopieswillbemade,inwhatorderthepageswillbe,
andmuchmore.OtherusefultoolsarethePrintPreviewfunctionfoundalongsidethePrint
command and the

Page Setup function. Print Preview will allow you to look over an exact copy of what will
come out of the printer before actuallyexecuting the print command.

Closing the Program:

Whenyouarefinished,

Click►File►Exitfromthemenubar OR

ClickontheXinthetoprightcornerofthecomputerscreen.

INTERNET:

Introduction:

Theinternetinsimpletermsisanetworkoftheinterlinkedcomputernetworkingworldwide, which
is accessible to the general public. These interconnected computers work by
transmittingdatathrough a special type of packet switching which is known as the IPor
the internet protocol.

Internet is such a huge network of several different interlinked networks relating to the
business,government,academic,andevensmallerdomesticnetworks,thereforeinternet
isknownasthenetworkofalltheothernetworks.Thesenetworksenabletheinternetto be used
for various important functions which include the several means of communications like
the file transfer, the online chat and even the sharing of the documents and web sites
on the WWW, or the World Wide Web.

It is always mistaken said that the internet and the World Wide Web are both the same
terms,oraresynonymous.Actuallythereisaverysignificantdifferencebetweenthetwo
whichhastobecleartounderstandboththeterms.TheinternetandWorldWideWebare
boththenetworksyet;theinternetisthenetworkoftheseveraldifferentcomputerswhich
areconnectedthroughthelinkageoftheaccessorieslikethecopperwires,thefiberoptics and
even the latest wireless connections. However, the World Wide Web consists of the



interlinked collection of the information and documents which are taken as the resource
by the general public. These are then linked by the website URLs and the hyperlinks.
Therefore World Wide Web is one of the services offered by the whole complicated and
hugenetworkoftheinternet.TheuseofIPintheInternetistheintegralpartofthenetwork,
astheyprovidetheservicesoftheinternet,throughdifferentlayersorganizationthrough
theIPdatapackets.Thereareotherprotocolsthatarethesub-classesoftheIPitself,like the TCP,
and the HTTP.

Bytheturnofthecentury,information, includingaccesstotheInternet,willbethebasis for
personal, economic, and political advancement. The popular name for the Internet is
theinformationsuperhighway.Whetheryouwanttofindthelatestfinancialnews,browse
throughlibrarycatalogs,exchangeinformationwithcolleagues,orjoininalivelypolitical
debate,theInternet isthe tool that will take you beyond telephones,faxes, and isolated
computerstoaburgeoningnetworkedinformationfrontier.TheInternetsupplementsthe
traditionaltoolsyouusetogatherinformation,DataGraphics,Newsandcorrespondwith other
people. Used skillfully, the Internet shrinks the world and brings information, expertise,
and knowledge on nearly every subject imaginable straight to your computer.

What isthe Internet?

The Internet links are computer networks all over the world so that users can share
resources and communicate with each other. Some computers have direct access to all
the facilities on the Internet such as the universities. And other computers, example
privately-owned ones, have indirect links through a commercial service provider, who
offerssomeoralloftheInternetfacilities.InordertobeconnectedtoInternet,youmust
gothroughservicesuppliers.Manyoptionsareofferedwithmonthlyrates.Dependingonthe option
chosen, access time may vary.
TheInternetiswhatwecallaMetanetwork,thatis,anetworkofnetworksthatspansthe globe.
It's impossible to give an exact count of the number of networks or users that comprise
the Internet, but it is easily in the thousands and millions respectively. The
Internetemploysasetofstandardizedprotocolswhichallowforthesharingofresources among
different kinds of computers that communicate with each other on the network.
Thesestandards,sometimesreferredtoastheInternetProtocolSuite,aretherulesthat
developers adhere to when creating newfunctionsfor the Internet.The Internet isalso
whatwecalladistributedsystem;therearenocentralarchives.Technically,nooneruns the
Internet. Rather, the Internet is made up of thousands of smaller networks. The
Internet thrives and develops as its many users find new ways to create, display and
retrievetheinformationthatconstitutestheInternet.

Who OwnstheInternet?
No one actually owns the Internet, and no single person or organization controls the
Internetinitsentirety.TheInternetismoreofaconceptthananactualtangibleentity,and it relies
on a physical infrastructure that connects networks to othernetworks.

Is WebandInternetthe Same?



TheInternetisnotsynonymouswithWorldWideWeb.TheInternetisamassivenetwork of
networks, a networking infrastructure. It connects millions of computers together
globally, forming a network in which any computer can communicate with any other
computer as long as they are both connected to the Internet. The World Wide Web, or
simplyWeb, is a way of accessing information over the medium of the Internet.
Itisaninformation-sharingmodelthatisbuiltontopoftheInternet.
WEBBROWSER:

A web browser (commonlyreferred to as a browser) is a software application for
retrieving, presenting, and traversing information resources on the World Wide Web. An
informationresourceisidentifiedbyaUniformResourceIdentifier(URI/URL)andmaybe a web
page, image, video or other piece of content. Hyperlinks present in resources enable
users easily to navigate their browsers to related resources.

AlthoughbrowsersareprimarilyintendedtousetheWorld WideWeb,theycanalsobe used to
access information provided by web servers in private networks or files in file systems.

Usesof Internet

Internetistodayoneofthemostimportantpartofourdailylife.Therearelargenumbers of things
thatcan be done using the internet and so it is veryimportant. You can say
thatwiththeprogressintheinternetweareprogressingineverysphereoflifeasitnot only makes
our tasks easier but also saves a lot of time. Today internet is used for different
purposes depending upon the requirement. Here in this very article we have mentioned
then ten best uses of the internet. Here goes the list.

1) Email:



By using internet now we can communicate in a fraction of seconds with a person who
issittingintheotherpartoftheworld.Todayforbettercommunication,wecanavailthe facilities
of Email. We can chat for hours with our loved ones. There are plenty messenger
services and email services offering this service for free. With help of such
services,ithasbecomeveryeasytoestablishakindofglobalfriendshipwhereyoucan share
your thoughts, can explore other cultures of different ethnicity.
2) Information:

Thebiggestadvantagethatinternetofferingisinformation.TheinternetandtheWorld
WideWebhasmadeiteasyforanyonetoaccessinformationanditcanbeof anytype, as the
internet isflooded with information. The internet and theWorldWideWeb has made it
easy for anyone to access information and it can be of any type. Any kind of information
on any topic is available on the Internet.

3) Business:

World tradehasseena bigboom with the help of the internet,as ithas becomeeasier for
buyers and sellers to communicate and also to advertise their sites. Now a day's most
of the people are using online classified sites to buy or sell or advertising their products
or services. Classified sites save a lot of money and time so this is chosen as
mediumbymostofpeopletoadvertisetheirproducts.Wehavemanyclassifiedsiteson the web
like craigslist, Adsglobe.com, Kijiji etc.

4) SocialNetworking:

Todaysocialnetworkingsiteshavebecomeanimportantpartoftheonlinecommunity. Almost
all users are members use it for personal and business purposes. It's an
awesomeplacetonetwork with manyentrepreneurs who comehere tobegin building
their own personal and business brand.

5) Shopping:

In today's busy life most of us are interested to shop online. Nowa day's almost
anythingcanbeboughtwiththeuseoftheinternet.Incountrieslike USmostof consumers
prefer to shop from home. We have many shopping sites on internet like amazon.com,
Dealsglobe.com etc. People also use the internet to auction goods. There are many
auction sites online, where anything can be sold.

6) Entertainment:

Oninternetwecanfindallformsofentertainmentfromwatchingfilmstoplayinggames online.
Almost anyone can find the right kindof entertainmentfor themselves.When people
surf theWeb, there are numerous things that can be found. Music, hobbies, news and
more can be found and shared on the Internet. There are numerous games
thatmaybedownloadedfrom theInternetforfree.

7) E-Commerce:



Ecommerce is the conceptusedfor anytype of commercial maneuvering, or business
dealsthatinvolvesthetransfer of informationacross the globe via internet.Ithas
becomeaphenomenonassociatedwithanykindofshopping,almostanything.Ithas got a
real amazing and range of products from household needs, technology to
entertainment.

8) Services:
Many services are now provided on the internet such as online banking, job seeking,
purchasing tickets for your favorite movies, and guidance services on array of topics in
theeveryaspectoflife,andhotelreservationsandbillspaying.Oftentheseservicesare not
available off-line and can cost you more.

9) Job Search:

Internetmakeslifeeasyforbothemployersandjobseekersasthereareplentyofjobsites which
connect employers and job seekers.

10) Dating/Personals:

People areconnecting with others though internet andfinding their life partners.
Internetnotonlyhelpstofindtherightpersonbutalsotocontinuetherelationship.

E-mailing

Short for electronic mail, e-mail or email is text messages that may contain files,
images, orother attachments sent through a network to a specified individual or
groupofindividuals.Thefirste-mailwassentbyRayTomlinsonin1971.By1996, more
electronic mail was being sent than postal mail.

“Email,e-mailorelectronicmailisthetransmissionofmessages(emailsoremail messages)
over electronic networks like the internet.”

Email, sometimes written as e-mail, is simply the shortened form of “electronic mail,” a
system for receiving, sending, and storing electronic messages. It has gained nearly
universalpopularityaroundtheworldwiththespreadoftheInternet.Inmanycases,email has
become the preferred method for both personal and business communication.

HowItIsUsed

Messages sent by electronic mail normally reach a recipient’s account within seconds.
They frequently include more than just text; images and numerous types of
formatteddocuments are noweasily included as attached files. Moreover, it is no longer
necessary tobesittinginfrontofaPCtosendorreceiveanemail.Avarietyofmobiledevices,such
as tablet computers and smart phones, make it possible manage correspondence on the
go.



Moste-mailsystemsincludearudimentarytexteditorforcomposingmessages,butmany allow
you to edit your messages using anyeditor you want. You then send the message to the
recipient by specifying the recipient's address. You can also send the same message to
several users at once. This is called broadcasting.

Sentmessagesarestoredinelectronicmailboxesuntiltherecipientfetchesthem.To see
ifyouhaveanymail,youmayhavetocheckyourelectronicmailboxperiodically,although
manysystemsalertyouwhenmailisreceived.Afterreadingyourmail,youcanstoreitin
atextfile,forwardittootherusers,ordeleteit.Copiesofmemoscanbeprintedoutona
printerifyouwantapapercopy.E-mailcanbedistributedtolistsof peopleaswellasto individuals.
A shared distribution list can bemanaged by usingan e-mail reflector. Some
mailinglistsallowyoutosubscribebysendinga requesttothemailinglistadministrator. A
mailing list that is administered automatically is called a list server.

Togetagraspofwhatemailisit'sbest—theterminologyindicatesit—tothinkinequivalents of
"traditional" postal mail.

• The email message - Instead of using a pen to write a letter on paper, you're using
your keyboard to type an email message in an email program on your computer.

• Sending the email - When the email is finished and has been addressed to the
recipient's email address, you don't put a stamp on it and post it but press the Send
button in the email program. This makes the email message go on its journey.

• Email transport - Like postal services transport letters and parcel, email servers
transmit email messages from sender to recipient. Usually, emails are not delivered to
therecipientdirectly,though,butwaitingatthe"nearest"mailservertobepickedupby them.

• Fetchingnew mail -Ifyou'vegotnewmailinyourmailbox,yougoandfetchit.Similarly, your
email program can check for new email messages at your mail server and download
them for you to read.



DESKTOP PUBLISHING
(PAGEMAKER,CORELDRAW,PHOTOSHOP)

DESKTOPPUBLISHING:

Desktop publishing (abbreviated DTP) is the creation of documents using page layout
skills on a personal computer. When used skillfully, desktop publishing software can
produce text and images with attractive layouts and typographic quality comparable to
traditional typography and printing, so DTP is also the main reference for digital
typography. This technology allows individuals, businesses, and other organizations to
self-publisha wide range of printed matter—from menus and localnewslettersto books,
magazines, and newspapers—without the sometimes-prohibitive expense of commercial
printing.

The same DTP skills and software used for common paper and book publishing are
sometimes used to create graphics for point of sale displays, promotional items, trade
show exhibits, retail package designs and outdoor signs. Although what is classified as
"DTPsoftware"isusuallylimitedtoprintandPDFpublications,DTPskillsaren'tlimitedto print.
The content produced by desktop publishers may also be exported and used for
electronicmedia.Thejobdescriptionsthatinclude"DTP"suchasDTPartistoftenrequire skills
using software for producing e-books, web content, and web pages.

Terminology
There are two types of pages in desktop publishing, electronic pages and virtual paper
pagestobeprintedonphysicalpaperpages.Allcomputerizeddocumentsaretechnically
electronic, which are limited in size only by computer memory or computer data storage
space.

Virtualpaperpageswillultimatelybeprinted,andthereforerequirepaperparametersthat
coincidewithinternationalstandardphysicalpapersizessuchas"A4,""letter,"etc.,ifnot
customsizesfortrimming.Somedesktoppublishingprogramsallowcustomsizes



designated for large format printing used in posters, billboards and trade show displays.
Avirtualpageforprintinghasapre-designatedsizeofvirtualprintingmaterialandcanbe viewed
on a monitorinWYSIWYGformat. Each page forprinting has trim sizes (edge of
paper)andaprintableareaifbleedprintingisnotpossibleasisthecasewithmostdesktop printers.

A web page is an example of an electronic page that is not constrained by virtual paper
parameters. Most electronic pages may be dynamically re-sized, causing either the
content to scale in size with the page or causing the content to re-flow.

Master pages are templates used to automatically copy or link elements and graphic
designstylestosomeorallthepagesofamultipagedocument.Linkedelementscanbe modified
without having to change each instance of an element on pages that use the
sameelement.Masterpagescanalsobeusedtoapplygraphicdesignstylestoautomatic page
numbering.

Page layout is the process by which the elements are laid on the page orderly,
aesthetically, and precisely. Main types of components to be laid out on a page include
text, linked images that can only be modified as an external source, and embedded
images that may be modified with the layout application software. Some embedded
images are rendered in the application software, while others can be placed from an
external source image file. Text may be keyed into the layout, placed, or (with database
publishingapplications)linkedtoan externalsourceof text which allows multipleeditors to
develop a document at the same time.

Graphic design styles such as color, transparency, and filters, may also be applied to
layoutelements.Typographystylesmaybeappliedtotextautomaticallywithstylesheets. Some
layout programs include style sheets for images in addition to text. Graphic styles for
images may be border shapes, colors, transparency, filters, and a parameter
designatingthewaytextflowsaroundtheobjectcalled"wraparound"or"runaround."

Comparisons

Withwordprocessing
While desktop publishing software still provides extensive features necessary for print
publishing, modern word processors now have publishing capabilities beyond those of
many older DTP applications, blurring the line between word processing and desktop
publishing.

Intheearlydaysofgraphicaluserinterfaces,DTPsoftwarewasinaclassofitsownwhen
compared to the fairly Spartan word processing applications of the time. Programs such
asWordPerfectandWordStarwerestillmainlytext-basedandofferedlittleinthewayof page
layout, other than perhaps margins and line spacing. On the other hand, word
processingsoftwarewasnecessaryforfeatureslikeindexingandspellchecking,features that
are common in many applications today.

Ascomputersandoperatingsystemshavebecomemorepowerful,vendorshavesoughtto provide
users with a single application platform that can meet all needs.



Withotherelectroniclayoutsoftware

In modern usage, DTP is not generally said to include tools such as TeX or troff, though
bothcaneasilybeusedonamoderndesktopsystemandarestandardwithmanyUnixlike
operating systems and readily available for other systems. The key difference between
electronic typesetting software and DTP software is that DTP software is generally
interactive andWYSIWYG in design, while otherelectronictypesetting software, such as
TeX,LaTeXandothervariants,tendstooperateinbatchmode,requiringtheusertoenter
theprocessingprogram'smarkuplanguagewithoutimmediatevisualizationofthefinished
product. This kind of workflow is less userfriendly than WYSIWYG, but more suitable for
conference proceedings and scholarly articles as well as corporate newsletters or other
applications where consistent, automated layout is important.

There is some overlap between desktop publishing and what is known as Hypermedia
publishing (i.e. Web design, Kiosk, CD-ROM). Many graphical HTML editors such as
Microsoft FrontPage and Adobe Dreamweaver use a layout engine similar to a DTP
program.However,someWebdesignersstillprefertowriteHTMLwithouttheassistance of
aWYSIWYG editor, for greater control and because these editors often result in code
bloat.

What isthe PrintMedia?

Theprintmediaiscomposedofnewspapers,communitynewsletters,wireservices,
magazines, and other publications. Within these publications, there are two main
divisions of labor: reporting and editing. Reporters are the newspaper writers who
investigate newsworthy events and interesting stories. Editors assign stories to
reporters, edit storycontent, and decide which stories to print.
Whyis the Print Media Important?

TheprintmediaisaneffectivewaytoalertthepublictotheWeatherizationAssistance Program
and its work. Readers often bypass paid advertising, but a story from an independent
journalist increases public awareness and builds local credibility. The media reaches a
broad audience of readers on a daily basis. Reporters and editors are always
lookingfor interesting, newsworthystories. Attractingmedia attention canhelp expand
your influence and name recognition in target communities.

ADVANTAGESANDDISADVANTAGESOFPRINTMEDIA

Oneof themostpopularandgrowingindustriesisthe printmediaand the reasonbeing

thefactthatitisoneoftheeasiestwaystoreachtargetedcustomersbyadvertisersand

marketers. These advertisers and businessmen make the most of all forms of print

media like magazines, newspaper, leafletsetc. If you want to knowmore aboutprint



media,thenreadthisarticleaswebringtoyoutheadvantagesanddisadvantagesof print

media here. Read on to find out what are they.

Advantagesofprintmedia
• Flashy magazines are always popular among consumers and are often read by them

foraparticularperiodoftimeinamonth.Themonthlymagazinesarethebestwayto bring
attention to any advertisements.

• Print media is an easy medium to spread awareness or advertise to any particular
geographicalarea. Like, a localnewspaperisthebestwayto spread newsaboutany local
event of the place.

• Someformsoftheprintmediahavehugeandtrustedfollowers.Thisisdefinitelya great
boost to attract readership.

• Printmediaallowsyoutochooseyourownspaceforadvertisement,thus,youcan manage
your budget and expenses while planning for the advertisement.

Disadvantagesofprint media
• Ifyouaretargetingtheglobalaudience,thenthisisnotthemediumyoushouldgofor.

Instead,theinternethasa much widerreach thanprintmedia in this.
• Placinganadvertisementinprintmediarequiresalotofplanningandtime.Inthis

case,youarefacedwithflexibilityproblem,particularlywhenyouworkintight deadlines.
• Infact, thereismuch limitationswhen it comesto targetingyouraudienceasthe

particularnewspapermaynotbeavailabletotheaudienceallthetime.Ontheother hand, a
person can get access to the internet from anywhere and everywhere.

• Besides, most of the time, your advertisement might get lost among all other ads and
editorials. Plus, the lifespan of newspaperand magazines is veryshort as people have a
tendencyto throwthem or keep them aside afterone dayof read.
Therearebothadvantagesanddisadvantagesforprintmedia.Wehavetokeepallthese
inmindandmaketherightplanningtomaketheoptimumuseofprintmedia.

CharacteristicsofPrintMedia

Thecharacteristicsoftheprintmediaareasfollows:

1. The print media like newspapers and magazines gives us an in-depth coverage and
analysis of news stories around the world. These stories are permanent and readily
availabletothecommonpeopleintimesofneed.Thenewsstoriescanberead,re-read and
retained.



2. Thetimelinessofnewsintheprintmediaislimited.Unliketheelectronicmedia,theydo
notgiveusimmediatenewsbutithastheluxuryof detailedrepresentation,interpretation and
analysis.

3. Alotofvariationsarefoundintheprintmediaintheformsofhardnews,softnews, features,
gossips, page 3 news, etc.

4.Magazinesservespecialinterestslike fashion, food,politics,economics,etc.

PAGEMAKER:
PageMakerwasoneofthefirstdesktoppublishingprograms,introducedin1985byAldus
Corporation, initially for the then-new Apple Macintosh and in 1987 for PCs running
Windows 1.0.

PageMakerwasawardedanSPAExcellenceinSoftwareAwardforBestNewUseofa Computer in
1986.

PageMakerrelies on Adobe Systems'PostScript page description language, and in 1994Adobe
Systems acquired Aldus and PageMaker.

As an application relying on a graphical user interface, PageMaker helped to popularize the
Macintosh platform and the Windows environment.

AdobePageMakerisadesktoppublishingsoftwareprogramthatallows youtoview entire

pages of a publication, such as a report, pamphlet or booklet.Therefore, it's



easytoformatadocument'slayoutandcontrolvariousdesigndetails,suchasfonts and

graphics, prior to printing or distribution.

Adobe PageMaker provides graphic designers, print professionals or production artists

withtheabilitytocreateprofessionalpagelayouts.Ifyou'repursuingsuchacareer,or if you're

interested in desktop publishing for educational or small business purposes, you may

want experience with this program.

SystemRequirements

Adobe PageMaker runs on both Windows and Macintosh computers. On Windows

machines, it'srecommended thatyour system has 48 MB ormoreof RAM, 200 MBof

available hard-disk space and a high-resolution display. If you have a Mac, 45 MB of

memory is recommended in addition to the same storage and monitor requirements.

Adobehasreleasedupdatestoensuretheproductcontinuestofunctionwithnewercomputer hardware.

Toolsusedinpagemaker

ThefunctionsoftheToolboxshouldbelearnedinordertomakegooduseofthePageMaker program.



WhenPageMakerisflashedup,thetoolboxshouldbeseenonthemonitor.TheToolbarconsists of 14
separate boxes.

TextTool

Thetexttool(theletterT)islocatednexttothepointertoolatthetopoftheToolbox..If
textistobewritten,theTshouldbeclicked.Thetextboxwilllightenup.Thecursorcan be placed
anywhere and text can be written.

The Pointer Tool
The pointer tool is the power tool. It is used for many applications such as moving
graphics, changing size of graphics, deleting graphics, altering drawing sizes and
shapesmadefromthedrawingtoolsintheToolboxandmovingtexttoanewpage.

RotateTool

Therotationtoolisusedtorotateagraphicortext.Torotateagraphic,Clickonagraphic, Click on the
rotation tool

Rotatethegraphic



Torotate text,
Click in the document until the lines with the handles show up. Move the handle over
thedesiredtext.Gotothetoolboxandclickontherotatetool.Withamouse,movethe text how
you want it presented

CroppingTool

TheCroppingToolisusedtocutoutsomeofagraphic.
Tocrop agraphic,
Clickingonagraphicwiththepointertoolorcroppingtool.Clickthecroppingtooltoactivate it.

Dragoneofthecornersorsideblackboxesuntilthesectionyouwanttocutoutgetscut out.



Thenexttwotoolsareusedtomakelines.

RectangularTools

ThenexttwocommandsaretherectangletoolandtherectangletoolwithanXinsideof the
rectangle. The box on the left is made for rectangles. Any line thickness and color can
be customized. The rectangle on the right-hand side, works well for placing graphics
and aligned text inside of the rectangle or square.



Tochangethepatterninsidetherectangle,

Rightclickontherectanglewiththepolygontoolorthepointertool.Clickfillandstroke.Make choices

Elliptical Tools

Thenexttwotools(9-10)dothesamethingastherectangulartoolswiththeonlydifference being the
circular.6.11.

Theboxontheleftismadeforellipticaldesign.Anylinethicknessandcolorcanbe
customized. The ellipse on the right-hand side is used is used to make ellipses for
which graphics and aligned text can be inserted inside of the circle.

Tochangethepatterninsidetheellipse,Rightclickontheellipsewiththepolygontoolor the
pointer tool.Click fill and stroke. Make choices



PolygonTools

Thenexttwotoolsmakepolygonshapes.
The box on the left is made for a polygon design. Any line thickness and color can be
customized. The polygon on the right-hand side is used is used to make polygons for
whichgraphicsandalignedtextcanbeinsertedinsideofthecircle.Todrawapolygon,

• Click apolygontool
• Leftclickthemouseanddragthemouseuntilyougetthesizeanddesiredshape.
• Tochangethepatterninsidethepolygon,
• Rightclickonthepolygonwiththepolygontoolorthepointertool.
• Clickfillandstroke
• Makechoices

Tomakeapolygonwithadifferentnumberofsides,Clicktherightpolygontool,Click Polygon
Settings



Putin aspecificnumber

ClickOK

To make a unique shape,

Clicktherightpolygontool

Makea singleclickonthepage



Movethemousetoanewplace Click

the mouse

Repeatforallnewlines

HandTool

Thehandtoolisusedinlayoutmodetomovethepagestoadesiredposition.

Tomoveapage,
Leftclickthemouseonapageanddragthepageswhereyouwantthem.

Magnifyingtool

Themagnifyingglassisusedtomagnifythedocument.Tomagnifythepage,Clickthe magnifying
tool. Click the page.



CorelDraw
CorelDraw (styled CorelDRAW) is a vector graphics editor developed and marketed by
CorelCorporationofOttawa,Canada.ItisalsothenameofCorel'sGraphicsSuite,which bundles
CorelDraw with a bitmap image editor, Corel PhotoPaint, and other graphics- related
programs (see below). The latest version is designated X6 (equivalent to version 16),
and was released in March 2012.

Supportedplatforms

CorelDraw was originally developed for Microsoft Windows 3 and currently runs on
Windows XP, Windows Vista, and Windows 7. The current version, X6, was released on
20 March 2012.

Versions for Mac OS and Mac OS X were at one time available, but due to poor sales
thesewerediscontinued.ThelastportforLinuxwasversion9(releasedin2000,itdidnot
runnatively;instead,itusedamodifiedversionofWinetorun)andthelastversionforOS X was
version 11 (released in 2001). Also, up until version 5, CorelDraw was developed for
Windows 3.1 xs, CTOS and OS/2.

Characteristicfeatures

Severalinnovationstovector-basedillustrationoriginatedwithCorelDraw:anode-edittool that
operates differently on different objects, fit text-to-path, stroke-before-fill, quick
fill/strokecolorselectionpalettes,perspectiveprojections,meshfillsandcomplexgradient fills.

CorelDrawdifferentiatesitselffromitscompetitorsinanumberofways:

Thefirstisitspositioningasagraphicssuite,ratherthanjustavectorgraphicsprogram. A full
range of editing tools allow the user to adjust contrast, color balance, change the format
from RGB to CMYK, add special effects such as vignettes and special borders to bitmaps.
Bitmaps can also be edited more extensively using Corel PhotoPaint, opening
thebitmapdirectlyfromCorelDrawandreturningtotheprogramaftersaving.Italsoallows a laser
to cut out any drawings.

CorelDraw is capable of handling multiple pages along with multiple master layers.
Multipage documents are easy to create and edit and the Corel print engine allows for
booklet and other imposition so even simple printers can be used for producing finished
documents. Oneof theusefulfeaturesfor single andmulti-page documents istheability to
create linked text boxes across documents that can be resized and moved while the
textitselfresetsandflowsthroughtheboxes.Usefulforcreatingandeditingmulti-article
newsletters etc.



Smalleritems,likebusinesscards,invitationsetc.,canbedesignedtotheirfinalpagesize
andimposedtotheprinter'ssheetsizeforcost-effectiveprinting.Anadditionalprint-merge
feature(usingaspreadsheetortextmergefile)allowsfullpersonalizationformanythings like
numbered raffle tickets, individual invitations, membership cards and more.

CorelDraw's competitors include Adobe Illustrator and Xara Photo & Graphic Designer.
Although all of these are vector-based illustration programs, the user experience differs
greatlybetweenthem.Whiletheseprogramswillreadtheirnativefiletypesandviceversa,
thetranslationisrarelyperfect.CorelDrawcanopenAdobePDFfiles:AdobePageMaker,
MicrosoftPublisherandWord,andotherprogramscanprintdocumentstoPDFusingthe
AdobePDFWriterprinterdriver,whichCorelDrawcanthenopenandediteveryaspectof the
original layout and design. CorelDRAW can also open PowerPoint presentations and
other Microsoft Office formats with little or noproblem.

CorelDrawGraphicsSuite

Over time, additional components were developed or acquired and bundled with
CorelDraw. The list of bundled packages usually changes somewhat from one release to
thenext,thoughthereareseveralmainstaysthathaveremainedinthepackageformany
releases now, including Power Trace (abitmap to vector graphic converter), Photo-Paint
(a bitmap graphic editor), and Capture (a screen capture utility).

ThecurrentversionofCorelDrawGraphicsSuiteX6(version16),containsthefollowingpackages:
 CorelDrawX6,anintuitivevector-illustrationandpage-layoutapplication
 Corel Photo-PaintX6,animage-editingapplication
 CorelPowerTraceX6,autilitytoconvertbitmapsintoeditablevectorgraphics
 CorelConnect,afull-screenbrowsertosearch thesuite’sdigitalcontent



 CorelCaptureX6,ascreencaptureutility
 CorelWebsiteCreatorX6,newwebsitecreationsoftware

CDRFile Format

CDR file format is a proprietary file format developed by Corel Corporation and
primarily used for vector graphic drawings. There is no publicly available CDR file
format specification.

Other CorelDraw file formats include CorelDraw Compressed (CDX), CorelDraw Template
(CDT) and Corel Presentation Exchange (CMX).

In December 2006 the sK1 open source project team started to reverse-engineer the
CDRformat.TheresultsandthefirstworkingsnapshotoftheCDRimporterwere
presentedattheLibreGraphicsMeeting2007conferencetakingplaceinMay2007in
Montreal(Canada).LaterontheteamparsedthestructureofotherCorelformatswith
thehelpof theopensource CDR Explorer.Asof 2008,thesK1project claimstohave the
best import support for CorelDraw file formats among open source software
programs.ThesK1projectdevelopedalsotheUniConvertor,acommandlineopen
source tool which supports conversion from CorelDraw ver.7-X4 formats
(CDR/CDT/CCX/CDRX/CMX) to other formats. UniConvertor is also used in Inkscape
and Scribusopen source projects as an external tool for CorelDraw files importing.

In2007,MicrosoftblockedCDRfileformatinMicrosoftOffice2003withthereleaseof
ServicePack3forOffice2003.Microsoftlaterapologizedforinaccuratelyblamingthe CDR
file format and other formats for security problems in Microsoft Office and released
some tools for solving this problem.

In2012thejointLibreOffice/re-labteamimplementedlibcdr,alibraryforreadingCDR
filesfromv1tothecurrentlylatestX6versionandCMXfiles.Thelibraryhasextensive support
for shapes and their properties, including support for color management and spot
colors, and has a basic supportfor text. The libraryprovides a built-in converter
toSVG,andaconvertertoOpenDocumentisprovidedbywriterperfectpackage.The
libcdrlibraryisexpected to beused inLibreOffice3.6,and thankstopublicAPIitcan be
freely used by other applications.

CorelDrawTools:

Picktool-Select,position,ortransformobjects.

Freehand Pick tool -Selectobjectsbyusingafreehandselectionmarquee. Position
and transform objects.



Shapetool(F10)-Editacurveobjectortextcharacterbymanipulatingnodes.

Smudge Brush tool -Changetheshapeofanobjectbydraggingalongits outline.

RoughenBrushtool-Distorttheedgeofanobjectbydraggingalongitsoutline.

FreeTransformtool-Rotate,skew,mirror,andscaleobjects.

Smear tool-Changetheedgeofanobjectbydraggingalongitsoutline.

Twirltool-Addswirleffectsbydraggingalongtheoutlineofanobject.

Attracttool-Reshapeobjectsbyattractingnodestothecursor.

Repeltool-Reshapeobjectsbypushingnodesawayfromthecursor.

Smoothtool -Smoothobjectbydraggingalongitsoutline.

Croptool-Removetheareasoutsideaselection.

Knifetool-Sliceanobjecttosplititintotwoseparateobjects.

Erasertool(X)-Removeunwantedareasinadrawing.

VirtualSegmentDeletetool-Removeoverlappingsegmentsinobjects.

Zoomtool(Z)-Changethemagnificationlevelofthedocumentwindow.

Pantool(H)-Draghiddenareasofadrawingintoviewwithoutchangingthe zoom level.

Freehandtool(F5) -Drawcurvesandstraightlinesegments.



2-PointLinetool-Drawastraightlinebydrawingfromthestartingpointtothe endpoint.

Beziertool-Drawcurvesonesegmentatatime.

ArtisticMediatool(I)-Addartisticbrush,spray,andcalligraphiceffectsbyusing



freehandstrokes.

Pentool-Drawcurvesinsegments,andprevieweachsegmentasyoudraw.

B-Spline tool -Drawcurvedlinesbysettingcontrolpointsthatshapethecurve without
breaking it into segments.

Polylinetool-Drawconnectedcurvesandstraightlinesinonecontinuousaction.

3-PointCurvetool-Drawacurvebydraggingfromthestartingpointtothe endpoint and
then positioning the center point.

Smart Filltool -Createobjectsfromoverlappingareas,andapplyafilltothose objects.

Smart Drawing tool (Shift+S) -Convertfreehandstrokestobasicshapesor smoothed
curves.

Rectangle tool (F6) -Drawsquaresandrectanglesbydragginginthedrawing window.

3-Point Rectangletool-Drawrectanglesatanangle.

Elipsetool(F7)-Drawcirclesandelipsesbydragginginthedrawingwindow.

3-PointElipsetool-Drawselipsesatanangle.

Polygontool(Y)-Drawpolygonsbydraggiginthedrawingwindow.

Startool-Drawuniform,outlinedstars.

ComplexStartool-Drawstarsthathaveintersectingsides.

GraphPaper tool (D)-Drawagrid.

Spiraltool(A)-Drawsymmetricalandlogarithmicspirals.



BasicShapes tool-Drawtriangles,circles,cylinders,heartsandothershapes.

ArrowShapestool-Drawarrowsofvariousshapesanddirections.

FlowchartShapestool-Drawflowchartsymbols.

Banner Shapestool-Drawribbonobjectsandexplosionshapes.

CalloutShapestool-Drawlabelsandspeech bubbles.

Texttool(F8)-Addandeditparagraphandartistictext.

Tabletool-Draw,select,andedittables.

Parallel Dimension tool-Drawslanteddimensionlines.

HorizontalorVerticalDimensiontool -Drawhorizontalorverticaldimension lines.

Angular Dimension tool-Drawangulardimensionlines.

SegmentDimensiontool-Displaythedistancebetweenendnodesonsingle or
multiplesegments.

3-PointCallouttool-Drawacalloutwithatwo-segmentleadingline.

Straight-LineConnectortool-Drawastraightlinetoconnecttwoobjects.

Right-AngleConnectortool-Drawarightangletoconnecttwoobjects.

Right-AngleRoundConnectortool-Drawarightanglewitharoundedcornerto
connecttwoobjects.

EditAnchortool-Modifytheconnectorlineanchorpointsofobjects.



Blendtool-Blendobjectsbycreatingaprogressionofintermediateobjectsand
colors.

Contour tool -Applyaseriesofconcentricshapesthatradiateintooroutofan object.

Distorttool-TransformobjectsbyapplyingPushandPull,Zipper,orTwister
effects.

DropShadowtool-Applyshadowsbehindorbelowobjects

Envelope tool-Changetheshapeofanobjectbyapplyinganddraggingthe
nodesofanenvelope.

Extrudetool-Apply3Deffecttoobjectstocreatetheillusionofdepth.

Transparencytool-Partiallyrevealimageareasunderneaththeobject.

ColorEyedroppertool-Samplecolors,andapplythemtoobjects

OutlinePen(F12)-Setoutlinepropertiessucjaslinethickness,cornershape,
andarrowtype.

OutlineColor(Shift+F12)-Choosetheoutlinecolorbyusingcolorviewersand
colorpalettes.

UniformFill(Shift+F11)-Chooseasolidfillcolorforanobjectbyusingcolor
palettes,colorviewers,colorharmonies,orcolorblends.

FountainFill(F11)-Fillanobjectwithagradientofcolorsorshades.

PatternFill-Applyapresetpatternfilltoanobjectorcreateacustompatternfill.

TextureFill-Applypresettexturefillstoobjectstocreatetheillusionofavariety of
textures, such as water, clouds and stone.



PostScriptFill-ApplyanintricatePostScripttexturefilltoanobject.

Interactive Filltool(G)-Createafilldynamicallybyusingmarkersinthedrawing
windowandpropertybartochangetheangle,midpoint,andcolor.

MeshFilltool(M)-Fillanobjectbyblendingmultiplecolorsorshadesarranged
overameshgrid.

ADOBEPHOTOSHOP:
Adobe Photoshop is a graphics editing program developed and published by Adobe
Systems.

Adobe's2003"CreativeSuite"rebrandingledtoAdobePhotoshop8'srenamingtoAdobe
Photoshop CS. Thus, Adobe Photoshop CS6 is the 13th major release of Adobe
Photoshop. The CS rebranding also resulted in Adobe offering numerous software
packages containing multiple Adobe programs for a reduced price. Adobe Photoshop is
released in two editions: Adobe Photoshop, and Adobe Photoshop Extended, with the
Extendedhavingextra3Dimagecreation,motiongraphicsediting,andadvancedimage
analysisfeatures.AdobePhotoshopExtendedisincludedinallofAdobe'sCreativeSuite
offerings except Design Standard, which includes the Adobe Photoshop edition.



Alongside Photoshop and Photoshop Extended, Adobe also publishes Photoshop
Elements and Photoshop Lightroom, collectively called "The Adobe Photoshop Family".
In2008,AdobereleasedAdobePhotoshopExpress,afreeweb-basedimageeditingtool to edit
photos directly on blogs and social networking sites; in 2011 a version was released for
the Android operating system and the cooperating system.

FileFormat

Photoshop files have default file extension as .PSD, which stands for "Photoshop
Document."APSDfilestoresanimagewith supportformostimagingoptionsavailable in

Photoshop. These include layers with masks,transparency,
text,alphachannelsandspotcolors,clippingpaths,andduotonesettings.Thisis

incontrasttomanyotherfileformats(e.g..JPGor.GIF)thatrestrictcontenttoprovide
streamlined, predictable functionality. A PSD file has a maximum height and width of
30,000 pixels, and a length limit of 3 Gigabytes.

Photoshop files sometimes have the file extension .PSB, which stands for "Photoshop
Big" (also known as "large document format"). A PSB file extends the PSD file format,
increasingthemaximumheightandwidthto300,000pixelsandthelengthlimittoaround 4
Exabytes. The dimension limit was apparently chosen arbitrarily by Adobe, not based
oncomputerarithmeticconstraints(itisnotclosetoapoweroftwo,asis30,000)butfor ease of
software testing. PSD and PSB formats are documented.

Because of Photoshop's popularity, PSD files are widely used and supported to some
extent by most competing software. The .PSD file format can be exported to and from
Adobe'sotherappslikeAdobeIllustrator,AdobePremierePro,andAfterEffects,tomake
professional standard DVDs and provide non-linear editing and special effects services,
such as backgrounds, textures, and so on, for television, film, and the web.



Photoshop'sprimarystrengthisasapixel-basedimageeditor,unlikevectorbasedimage editors.
Photoshop also enables vector graphics editing through its Paths, Pen tools, Shape
tools, Shape Layers, Type tools, Import command, and Smart Object functions. These
tools and commands are convenient to combine pixel-based and vector-based images
inone Photoshopdocument,becauseitmaynotbenecessaryto usemorethan
oneprogram.Tocreateverycomplexvectorgraphicswithnumerousshapesandcolors, it may
be easier to use software that was created primarily for that purpose, such as Adobe
Illustrator or CorelDRAW. Photoshop's non-destructive Smart Objects can also import
complex vector shapes.

LanguageAvailabilities

Photoshopisavailableinmorethan20languages.Thesearethefollowing:

Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, English, Finnish, French,
German, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese,
Romanian, Russian, Spanish, Swedish, Turkish and Ukrainian. Also Arabic and Hebrew
as of Photoshop CS6.

Plugins

Photoshop functionality can be extended by add-on programs called Photoshop plugin
(or plug-ins). Adobe creates some plug-in, such as Adobe Camera Raw, but thirdparty
companiesdevelopmostplug-in,accordingtoAdobe'sspecifications.Somearefreeand some
are commercial software. Most plug-in work with only Photoshop or Photoshop-
compatible hosts, but a few can also be run as standalone applications.

There are various types of plug-in, such as filter, export, import, selection, color
correction,andautomation.Themostpopularplug-inarethefilterplug-in(alsoknownas a 8bf
plug-in), available under the Filter menu in Photoshop. Filter plug-in can either
modifythecurrentimageorcreatecontent.Belowaresomepopulartypesofplug-in,and some
well-known companies associated with them:

 Colorcorrectionplug-in
 Special effectsplug-in
 3Deffectsplug-in

Adobe Camera Raw (also known as ACR and Camera Raw) is a special plugin, supplied
free by Adobe, used primarily to read and process raw image files so that the resultant
images can be processed by Photoshop. It can also be used from within Adobe Bridge.

Tools
Upon loading Photoshop, a sidebar with a variety of tools with multiple image-editing
functionsappearstotheleftofthescreen.Thesetoolstypicallyfallunderthecategories
ofdrawing;painting;measuringandnavigation;selection;typing;andretouching.Some
toolscontainasmalltriangleinthebottomrightofthetoolboxicon.Thesecanbe



expanded to reveal similar tools. While newer versions of Photoshop are updated to
include new tools and features, several recurring tools that exist in most versions are
discussed below.

Pen Tool

Photoshop includes a few versions of the pen tool. The pen tool creates precise paths
that can be manipulated using anchor points. The freeform pen tool allows the user to
drawpathsfreehand,andwiththemagneticpentool,thedrawnpathattachescloselyto
outlinesof objectsin an image,which is usefulfor isolating them from a background.

Measuring and navigation

The eyedropper tool selects a color from an area of the image that is clicked, and
samplesitforfutureuse.Thehandtoolnavigatesanimagebymovingitinanydirection, and the
zoom tool enlarges the part of an image that is clicked on, allowing for a closer view.

Selection

Byusingpathselectiontool,wecanselectpathnodes.

Cropping

Thecroptoolcanbeusedtoselectaparticularareaofanimageanddiscardtheportions
outsideofthechosensection.Thistoolassistsincreatingafocuspointonanimageand excluding
unnecessary or excess space. Cropping allows enhancement of a photo’s
compositionwhiledecreasingthefilesize.The"crop"toolisinthetoolspalette,whichis located
on the right side of the document.

Slicing

The"slice"andsliceselecttools,likethecroptool,areusedinisolatingpartsofimages.
Theslicetoolcanbeusedtodivideanimageintodifferentsections,andtheseseparate parts
canbeusedaspiecesof aweb page design onceHTMLand CSSareapplied.The slice select
tool allows sliced sections of an image to be adjusted and shifted.

Moving

Onceanareaofanimageishighlighted,themovetoolcanbeusedtomanuallyrelocate the
selected piece to anywhere on the canvas.
Marquee

The marquee tool can make selections that are single row, single column, rectangular
andelliptical. Anareathat has been selectedcan be edited withoutaffectingthe restof
theimage.Thistoolcanalsocropanimage;itallowsforbettercontrol.Incontrasttothe crop tool,
the "marquee" tool allows for more adjustments to the selected area before cropping.
The only marquee tool that does not allow cropping is the elliptical.



Lasso

The lasso tool is similar to the "marquee" tool, however, the user can make a custom
selection by drawing it freehand. There are three options for the "lasso" tool – regular,
polygonal, and magnetic. The regular "lasso" tool allows the user to have drawing
capabilities. Photoshop will complete the selection once the mouse button is released.
The user may also complete the selection by connecting the end point to the starting
point. The “marching ants” will indicate if a selection has been made. The "polygonal
lasso" tool will only draw straight lines, which makes it an ideal choice for images with
manystraightlines.Unliketheregular"lasso"tool,theusermustcontinuallyclickaround
theimagetooutlinetheshape.Tocompletetheselection,theusermustconnecttheend point to
the starting point just like the regular lasso tool. "Magnetic lasso" tool is considered the
smart tool.

Quick Selection

The quick selection tool selects areas based on edges, similarly to the magnetic lasso
tool. The difference between this tool and the lasso tool is that there is no starting and
endingpoint.Sincethereisn’tastartingandendingpoint,theselectedareacanbeadded on to
as much as possible without starting over.

Magic Wand

The magic wand tool selects areas based on pixels. The user only needs to click once,
andthistoolwilldetectpixelsthatareverysimilartoeachother.Iftheeyedroppertool is selected
in the options bar, then the magic wand can determine the value needed to evaluate
the pixels; this is based on the sample size setting in the eyedropper tool.
Whentheimagerequiresmorethanafewclicks,thistoolbecomesadisadvantage.The
usermustdecidewhat settingstouseorif the image isrightforthistool.

Eraser
The eraser tool does exactly what it’s called.It erases an image based on the layer it is
on. If the user is on the text layer, then any text that the tool is dragged across will be
erased.Theerasedareawillconvertthepixelstotransparent,unlessitisthebackground layer.
The size and style of the eraser can be selected in the options bar. This tool is unique
in thatit can take the form of the paintbrush and pencil tools. In addition to the
straighterasertool,therearetwomoreavailableoptions–backgrounderaserandmagic eraser.

Typing

Photoshopalsoprovides toolsfor addingandeditingtext.The typetools createanarea
wheretextcanbeentered,andthetypemasktools createaselectionareathathasthe shape of
text. Thetype tool creates vector-basedtext, sosymbols,lettersand numbers in various
fonts and colors can be re-sized while maintaining the same quality.



Retouching

Thereareseveraltoolsthatareusedforretouching,manipulatingandadjustingphotos, such as
the clone stamp, eraser, burn, dodge, smudge and blur tools. The clone stamp
toolsamplesaselected portionof an image,andduplicatesitoveranotherareausinga brush
that can be adjusted in size, flow and opacity. The smudge tool, when dragged across
part of an image, stretches and smudges pixels as if they are real paint, and the
blurtoolsoftensportionsofanimagebyloweringtheamountofdetailwithintheadjusted area.

Content-aware

Content-awareness is a useful aspect of Photoshop where image editing is done
automaticallyandintelligently.Itcomesintwoforms,content-awarescaling,andcontent- aware
filling, in which elements in a background automatically recompose according to the
areas a userof theprogram decides tofillorscale. More specifically, content-aware scaling
works by rescaling an image and causing its content to adapt to the new dimensions
and preserving important areas of it. Content-aware filling functions by
matchingtone,color,andnoiseofanareaoftheimagethatcontainedanobjectordetail in which
the user decides to remove.

Healingtools

With improvement retouching tools like the Clone Stamp tool and Healing Brush tool,
imperfections of an image can easily be removed. These tools essentially function by
locatingasourcepoint(ormultiplesourcepoints)thatcanbescaledorrotatedinorder to cover
an imperfection or unwanted detail in a specific area of an image.

Puppetwrap

Similar to the content-aware tool, the puppet warp toolreveals Photoshop’s intelligence
by allowing a user to reposition an object in an image such as a flower or arm. This is
donebyusingpointsthatoutlinethestructureofanobjectandeasilyrepositioninginthe wanted
orientation.

Video Editing
InAdobeCS5Extendededition,videoeditingiscomprehensiveandefficientwithabroad
compatibilityof videofileformatssuchasMOV, AVI, MPEG-4,and FLVformatsandeasy
workflow. Using simple combination of keys video layers can easily be modified, with
other features such as adding text and the creation of animations using single images.

3D

With the Extended version of Photoshop CS5, 2D elements of an artwork can easily
become three-dimensional with the click of a button. Extrusions of texts, an available
library of materials for three-dimensional and even wrapping two-dimensional images
around3Dgeometryareallpossiblewiththisversionof Photoshop.Realismcanalsobe added
to an image using the 3D features of Photoshop such as animating imagebased lights
and depth of field.



Mobile integration

Third-partyplug-in hasalso been added tothe most recent version of Photoshop where
technologies such as the iPad have integrated the software with different types of
applications. Applications like the Adobe Easel painting app allows the user to easily
createpaintingswiththeirfingertipsanduseanarrayofdifferentpaintfromdrytowetin order to
create rich color blending.

CameraRaw

With the CameraRaw plug-in, RAW images can be processed without the use of Adobe
Photoshop Light room, along with other image file formats such asJPEGs, TIFFs, or
PNGs. The plug-in allows users to remove noise without the side-effect of
oversharpening, add grain, and even perform post-crop vignetting.

HTML/DHTML,DREAMWEAVERWeb
ScriptLanguageHTML

IntroductiontoHTML

HTML (Hypertext Markup Language)isusedtocreatedocumentontheWorldWide
→eb.Itissimplyacollectionofcertainkeywords called‘Tags’thatarehelpfulinwriting

thedocumenttobedisplayedusingabrowseronInternet.Itisaplatformindependent language

that can be used on any platform such asWindows, Linux, Macintosh, and so on. To

display a document in web it is essential to mark-up the different elements

(headings,paragraphs,tables,andsoon)ofthedocumentwiththeHTMLtags.Toview



a mark-up document, user has to open the document in a browser. A browser

understands and interpret the HTML tags, identifies the structure of the document

(whichpartarewhich)andmakesdecisionaboutpresentation(howthepartslook)of the

document.HTML also provides tags to make the document look attractive using

graphics, font size and colors. User can make a link to the other document or the

different section of the same document by creating Hypertext Links also known as

Hyperlinks.

WEBDESIGNING

Website:CollectionofWebpagesandWebpagesis madebyHTMLTags.

Internet:24HourspresenceonInternetwithWorldWideReach.

Web designing: Static Site:WithoutDatabase|Photoshop(WebTemplates/

Homepage)

HTML|DHTML Dreamweaver|FlashAnimation|Css&DivTag.

Web development: Dynamic Site: Database Site | Java Script |ASP.NET | PHP | Ms-

Access | MySQL | Sql Server

Requirement forWebsite:DomainName|Hosting(ServerSpace)|Website

HTML - Hyper Text Markup Language The language used to develop web pages is
called HTML. HTML is the language interpreted by a Browser. Webpage are also called

html documents. HTML is a set of special codes. HTML is specified on TAGS.

Forcreation ofHTML fileswerequired Two ways:

Editor:ForwritingpurposeormakingHTMLfilesNotePadisbesteditoritis support coding
language.

Browser: For output display there are of two type of browsers Internet Explorer
and Netscape Navigator.

ThecontentsofHTMLpagearewritteninTags/Attributes.

HTMLTags:Tagsareinstructionsthatoneembeddeddirectlyintothetextofthe
document.An HTML tagis a signal toa browser thatit shoulddo somethingother than

justthrowtextuponthescreen.ByconnectionallHTMLtagsbeginwithanopenangle

bracket(<)andendwithaClosesangleBracket(>) HTML tagscanbeof twotypes:



Paired Tags: A tag is said to be paired tag if it, along with a companion tag, close the
text.

Singular Tag: The second type of tag is the singular or stand-alone tag. It does
not have a companion tag.

Tag Attributes & Value: AdditionalinformationsuppliedtoanHTMLtagis
knownasAttributesofatag.Attributesarewrittenimmediatelyfollowingthetag,

separated by a space. Like:

<HRSize=5Color=”Red”Width=70%Align=”Right”>

HereHR = Tag

Size, Color, Width, Align = Attributes

5, Red, 70%, Right= Values

Basicstructure ofHTMLDocument:

EveryHTMLprogramhasarigidstructure.

<HTML> StartTag|OpeningScript
<HEAD> Informationplacedinthissectionisessentialtotheinnerworkingof

Documentandhasnothingtodowiththecontentofthedocument.

<TITLE> Explanationofpagepurpose,DisplayinTitleBarof I.E.
</TITLE> ClosingTag

</HEAD> ClosingTag

<BODY> Information and Links / Secondary Links / Footers means any type

of Text or Graphics for Page.

</BODY> ClosingTag

</HTML> ClosingTag|Closing Script

ParagraphBreaks: Ablanklinealwaysseparateparagraphsintextualmaterial.Thetag
thatprovidesthisfunctionalityis<P>.<P>tagisusedtocreateanewparagraph.

Line Breaks: When text needs to start from a new line and not continue on the same

line, the <BR> tag should be used.



Heading Style: HTMLsupportssixdifferentlevelsofheadings.Thehighest-levelheader format
is

<H1>andthelowestlevelis<H6>.

AlignAttribute:Alignmentattributesareoftenusedwiththetext,image.
Align=Left/Center/Right<H1Align=”Left”>SoftBrain</H1>

DrawingLines:Thetag<HR>drawslinesandhorizontalrules.TheAttributestothe

<HR>tagare:

<HRSize=5Color=”Red”Width=70%Align=”Right”>

TextLevelElements:TextlevelElementschangestheappearancetofunctionoftext.

Bold: Boldelement<B>and</B>causestexttoappearinaboldtypeface.

<B>SoftBrain</B>

Italic: Italicelement<I>and</I>causesthetexttoappearinItalictypeface.

<I>SoftBrain</I>

Underline:Underline element <U> and </U> causes text to underline.
<U>

SoftBrain </U>

Strike: Strikeelementindicatesthattextenclosedin<S>and</S>willhave a line

drawn in the middle of text.

<S>

SoftBrain</S>

Teletype: Teletypeelementchangesthefontlikeamonospacedtypewriterfont.

<TT>SoftBrain</TT>

Superscripts:Raisedonepointtextupperword15thAugustorSoftBrainTM. 15

<SUP>th</SUP>August15th August

Subscript:TextRaiseddownonepointdownward.

H<sub>2</sub>SO<sub>4</sub> H2SO4



ControllingFontSizeandColor:Alltextspecifiedwithinthetags<Font>and</Font> will
appear in the font size and color as specified as attributes of the Tag <Font>The
attributes:

Face=Setsthefonttobespecifiedfontname.

Size=Setsthesizeofthetext.Sizecantakevaluesbetween1to7.

Color =Setsthecolorofthetext.

<Fontface=“Arial”size=4color=”green”>SoftBrainInformaticTechnology Pvt.

Ltd. </Font>

Bgcolor Attributes: Specifiesbackgroundcolorusingcolorname.<Body
Bgcolor=”RED”>

TextAttributes:Specifiesforegroundcolororthecolorofthetext.
<Body Text=”Aqua”>

UsingSpecialCharacters:

LIST STYLE

Listsarethebestmethodoforganizinginformationandpresentingitinastructure fashion

basically there are three kinds of lists. They are:

OrderedList(Numbering):Anorderedliststartwiththetag<ol>andendswith</ol>.
EachListItem<Li>startwithtag<Li>.Iftag<Li>isnotpresentatthebeginning,thelisted items

appear on the same line. Using Attributes: Type Attribute type=”1” will give
Counting numbers (1,2..........) type=”A” will give Uppercase letters (A,B..........)

type=”a” will give Lowercase letters (alb..........) type=”I” will give
Uppercase Roman numerals.(I,II,III......) type=”i” will give Lowercase Roman
numerals.(ixia........)

Non-breakingspace
Copyright Sign

&nbsp;
&copy; Copyright©

RegisteredTrademark &Reg; Softbrain®

Trademark &#8482; SoftbrainTM



StartAttribute:Thestartattributeallowsyoutospecifythebeginningofthelist’s numbers. (Start=”1”)

UnorderedList(Bullet):Weusethetag<UL>and</UL>forunorderedList.

Attributes of Unordered List type=”circle” type=”square”
type=”disc”

Definitionlist:Thedefinitionlistusesthe<DL>starttagandthe</DL>endtagtocreate a
definition list. Definition list consists of two parts.

Definition term=Appears after the Tag <DT>

Definitiondescription=AppearaftertheTag<DD>

Result In Internet Explorer: KEYBOARD

ANINPUT DEVICE

ADDITONOFGRAPHICS/IMAGESINHTMLDOCUMENTS

Otherthantext,HTMLallowsplacingofstaticandanimatedimagesinanHTML

page.

The commonly used image file types are GIF (Graphic Interchange Format) JPEG (Joint

Photographic Experts Group) also called as JPG. To add an image in HTML document,

youjustneedtoincludethe<IMG>tagwithareferencetothedesiredimage.The

<IMG>(image)tagisanemptyelement(i.e.itdoesn’trequireaclosingtag).

<IMGSRC=”imagename.gif”>

<IMGSRC=”imagename.jpg”>

Image Element Attributes:

Align Attributes with Text: Align=Top / Middle / Bottom
E.g.:<Imgalign=”middle”src=”picture.gif”>

AlignAttributeswithFloatingImage:Align=Left/ Right

Border:specifiesthesizeofthebordertoplacearoundtheimage.



Height: specifiestheheightoftheimage.

Width: specifiesthewidthoftheimage.

Hspace: indicates the amountof spaceto the left and right of the image.

Vspace: indicatestheamountofspacetothetopandbottomoftheimage. Alt

Attribute: ALT attribute for the <IMG..........>tag allows for substitution of a
descriptionstringoftexttoholdtheplaceoftheimage. <Img Alt=”Success
IsAJourney”Src=”Image.jpg”> Alt

working for text

<ahref=”filename.html”title=”SuccessIsAJourney”>linkcontent</a>

CREATINGTABLES

Table present information in the form of rows and columns. To include a table in

yourwebpagesyoufirstneedtocreatethetablestructureandforthatyouuseHTML’s

TableTags.

<TABLE>Thetable’sbeginningwitha<TABLE>tagandtheendwitha

</TABLE>tag.

<TR>Thetablerowelement<TR>withanoptional</TR>endtagcreatesa horizontal row of
cell.

<TH>Thetableheading<TH>withanoptional</TH>createsleadingcells.

<TD>Thetabledataelement<TD>tagswithanoptional</TD>endtag.

Table Attributes:<Align>Attribute:
<TableAlign=”Left”/”Center”/”Right”>

<Border>Attribute: <Table Border=5>

BgcolorAttribute:<TableBgcolor=”ColorNameOrColor Value”>

<TrBgcolor=”ColorName”>

<TdBgcolor=”ColorName”>

<ThBgcolor=”ColorName”>

BackgroundAttribute:ThissetsanimageontheBackgroundoftable.



<TableBackground=”Computer.jpg”>

Caption: Thistagisoptionalanditcontainstable’sdescription.

<CaptionAlign=Top/Bottom/Left/Right>CaptionText</Caption>

Width & Height Attribute: <Table Width=”300” Height=”400”>

Cell spacing Attribute: You can use cellspacingattributeto controlthe spacing
between each cell in the table.

<Table Cell spacing=”Number”>

CellpaddingAttribute:(Spaclinebetweencellcontentandcellborder)
<TableCellpadding=”Number”>

Rowspan Attribute: Therowspanattributeisusedinacelltomakethecell’s
content merge with another cell in a row. <Td
Rowspan=”Number”> <Th Rowspan=”Number”>

ColspanAttribute:Similar to ROWSPAN,COLSPAN attribute is used in a cell to
make the cells content merge with another cell in a column.

<TdColspan=”Number”><ThColspan=”Number”>

LINKINGDOCUMENTS

LINKS:HTMLallowslinkingto other HTMLdocumentsas wellas images.

ClickingonaSectionoftextoranimageinonewebpagewillopenanentirewebpage or an

image. The text or an image that provides such linkages is called Hypertext, a

Hyperlink or a Hotspot. Every Hyperlink.

1. Appears inbluecolor.

2. Thehyperlinktext/imageareunderlined.

3. When the mouse cursor is placed over it, the standard arrow mouse cursor changes

to the shape of a hand.

Thebluecolor,whichappearsbydefault,canbeoverridden.Tochangethese

linkcolorstherearethreeattributesthatcanbespecifiedwiththe<BODY>tag.These are:



Link: Changethedefaultcolorofahyperlinktowhatevercolorisspecifiedwiththistag.
Alink :( Active Link) Changes the default color of a hyperlink that is activated to
whatever color is specified with this tag.

Vlink:(VisitLink)Changesthedefaultcolorofahyperlinkthatisalreadyvisitedto whatever color is
specified with this tag.

TheAnchorTag:AnchorelementsareusedtolinkbetweentwoormultipleHTML
documents.”Anchor”tagstartswith<A>andenclosewith</A>.The<A>tagrequiresthe

HREFattributeand(hyperlinkreference)attributeacceptstheURLofthelinkedpage.
<AHREF=”filename.html”>content</A>

Everyhyperlinkhastwocomponents:Thesourceandthedestination.
<ahref=”http.//www.yahoo.com/”>OPENYAHOOSITE</A>

ImagesasHyperlink:JustastextcanactasaHyperlink,soalso imagescanactas hyperlinks.

<Ahref=”abc.html”><img src=”image.jpg”></A>

ExternalLink:linkswithotherhtmldocument.

InternalLink:linkinasamedocument.Theanchorelementisusedtocreateboth external and
internal links.

NameAttribute:Named Anchor are used to create links to a specified section
withindocument.

Thisisatwostepprocess: AtTopofpageafterBodyTag

<ANAME=”LOCATION”>

At bottom of page before Body Tag <A
HREF=”#LOCATION”>Content</A>

MARQUEE
MarqueeTag:Forscrollingtextandimage.

http://www.yahoo.com/


<Marquee>-----------------------</Marquee>

MarqueeAttributes

<Marqueebehavior=”slide”></marquee>Inthistextscrollsforonetimeonly.

<Marqueebehavior=”alternate”></marquee>Inthistextwillscrollcontinuouslyleft to
right.

<Marqueebehavior=”scroll”></marquee>Inthistextwillscrollcontinuously.

For direction of scrolling
<Marqueebehavior=”slide”direction=”right”/”up”/”down”>

Forbackground color/width/height

<Marqueebehavior=”slide”bgcolor=”red”direction=”right”width=”500”height=20>

Forspeedcontrollingin marquee

<Marquee scroll amount=1 maximum slow & 1000 maximum fast>

<Marqueescrolldelay=1000maximumslow&1maximumfast>

MULTIMEDIA

Multimediarefersto“MultipleMedium”thatistheabilitytoaddsoundandmoving pictures
to your webpages.

AddingVideo:<embedsrc="movies.mpg"height="200"width="200">

Adding Sound: Webpage contain basically two varieties of sounds that play
wheneverthevisitoraccessesthewebpagesthatisthebackgroundsound,andwhen the

visitor clicks something. The most common sound file formats are MIDI (Musical

Instrument Digital Interface),WAV (as inWave), AU (Audio) and (Audio Interchange

File Format).

Soundfilescanbeaddedinmanyoftheways.wecanusethe<A>anchortagso

thatthevisitorhastheoptionwhethertohearthesoundornot.Forexample:

<Ahref=”music.wav”>Click Here For Background Music </A>Astheuser
clicksonthetext,thebackgroundsoundstarts. Sothevisitorhastheoptionwhetherto hear the
sound or not.



Secondoptionrequires<Bgsound>tag:<Bgsoundsrc=”Soundurl”>

Here the src attribute specifies how many times the sound should play. If loop is

specify loop = No or infinite to play the sound is an endless loop.

AddingAnimatedGif’s:(GraphicsInterchangeFormat)

<imgsrc=’A.gif”width=100height=100>

FORMCreation in HTML

Creating AForm:Webpagescanbeinteractiveiftheycollectinformationfrom the

user. An HTML form is used for creating interactive web pages. The information

entered by the user is passed back to a web server where it might be recorded in a

Database for further use.So form is simply a collection of fields of information. These

fieldsofinformationcanbeintheformof textboxes,radiobuttons,pulldownmenus

etc.Commonusesof forms areOnline orderforms,Feedbackforms,e-mailregistration

forms,oranywebpageinwhichinputisrequiredfromtheuserinordertocompletea given

task.An HTML form consists of two parts.The first part,the user can see and which he

fillout and next one is the part, the user can’t see.The second part specifies how the

server should process the user’s information.Here we commenly used PHP script.

TheFormTag:Aformmuststartwitha<FORM>tagandendwitha</FORM>tag.Ithas mainly
two attributes:

1. Action

2. Method
Syntax:<Formaction=”URL”method=get/post>Form

Elements............</Form>

Actionisusedtospecifye-mailaddressthatwillreceivetheforminformation.If
youhavewrittenaformhandlertowhichthedataintheformwillbesent,thenyouwill

havetoaddanaction=”←RL”attributetospecifythelocationofthehandler.



The Method attributetells thebrowser howto sendthe user’s data to the
server.Thereareonlytwopossiblevaluesforthemethodattribute:Method=”get”or

Method=”post’. The default value is “post”.

UsingFormControlElements:The form element can contain different elements to create

form controls.

InputElement:The<input>tagallowsusertoinputinformation.

Text: Usedtocreatethesinglelinetextboxes.

Password:Similartotext,exceptthecharactersyoutypearenotseenonscreen.

Checkbox:Asonoroffswitch.

Radio:Similartoacheckbox,exceptthatinagroupofradiobuttonsonlyoneradio button
can be on at a time.

Submit:Submitsaformtobeprocessed.

Reset:Clearsalltheinputonaform.

Button: createsabuttonsimilarinappearancetoasubmitbutton.
File:Canbeusedtosendafilefromthesurfer’scomputeralongwiththerestoftheform data.

Form Creation:

Fieldsetandlegendtag:<Fieldset>tagisusedtogroupmoreformcontrolstogether. The

<legend> tag, which is optionalthese tags require closing tag.The Syntaxis :

<Fieldset>

<Legend>GroupLabelText</Legend>

Control1 Control2 Control3 Control4

</Fieldset>

<html>

<head><title>FeedbackOnline Form</title></head>



<bodybgcolor=”black”text=”white”>

<form>
<fieldset>
<legendalign=”right”>Forminfo@softbrain.org</legend>

InputElement:The<input>tagallowsusertoinputinformation.The<input>element
consistsof<input>tagalongwithtypeattribute(tospecifywhattypeofformcontrolyou

want),theNameattribute(toindicatethefieldname),andotheroptionalattribtes.The

typeattributecanaccepttext,checkbox,radiobuttonsetc.asitsvalue.Belowisalistof all

possible values of Type.

<inputtype=”text”name=”text-id”value=”default-text”size=”n”
maxlength=”n” read only>

The name attribute is used asanidentifierforthe contentsof theform

componentwhentheformissubmitted.Thisnameisnotvisibletotheuserandmustbe

uniquewithintheform.Thevalueattributeisoptionalandisusedtosupplyintialtextto

thetextfield.Thecontentofthisattributewillbeshownonthetextfield,unlesstheuser changes

it.We can specify the physical size of the text input box by using size attribute.The

default value is usuallya length of 20 characters.You can,also set the number of

characters a user can input.The maxlength attriubte does this.This setting

shouldnotbelessthanthevalueofthesizeattribute.Otherwiseyouruserwon’tbeable

totypetotheendof theboxandmightgetconfused.Thedefaultvalueofmaxlengthis

unlimited.Thereadonlyattributeisusedtodisablethecontentsofthetext.The<label>tag is
used for given bold heading names in form.

Textfield: themostcommontypeofform<input>istext.Itpresentstheuserwithaprompt for a

singlelineoftext.Thesefieldsarecommonlyusedforaname,address,emailaddressetc.

<inputtype=”text”name=”text-id”value=”default-text”size=”n”maxlength=”n”>

mailto:info@softbrain.org


<label>Full Name</label>
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;&nbsp;&nbsp;&nbsp;

<inputtype=”text”name=”t1”size=25maxlength=25value=””><br>

<label>FullAddress</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;

<inputtype=”text”name=”t2”size=25maxlength=25value=””><br>

Checkbox: A checkbox is simply an empty box and contain a checkmark when
activated.Aninputtagwithattributetype=”checkbox”offerstheuseran“on”or“off”

switch.Itissimilartoaradiobutton,butanynumberofcheckboxesmaybeswitchonat

sametime.Ifacheckboxisswitched“on”whentheformissubmitted,itsvalueattribute is

submitted as the form data for the named form component.Each checkbox has a

seprate name specified by the name attribute. The syntax is:

<inputtype=”checkbox”name=”boxid”value=”checkbox”checked>

<label>Internet/E-Shopping</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="checkbox"name="c1"value="checkbox"checked>

&nbsp;&nbsp;Computer&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="checkbox" name="c2">

&nbsp;&nbsp;Laptop&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="checkbox" name="c3">

&nbsp;&nbsp;Ipod&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="checkbox" name="c4">

&nbsp;&nbsp;UPS&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;



<inputtype="checkbox" name="c5">

&nbsp;&nbsp;Mobiles&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;<br>

Radio Button: Radio buttons allows the user to choose one of the several options.On
selectingoneoftheoptionstheotheroptionsareautomaticallydeselected.Thebuttons appear

as small circles. with prompt and the selected one appears with a solid dot in it.You can

indicate the default choice by using a checked attribute.You have to use a

uniquevalueforthenameattributeforallradiobuttonsinaparticularset.Syntax:

<inputtype=”radio”name=”radioid”value=”radiobutton”checked>

<label>Gender</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp; <input
name="radiobutton"
type="radio"value="radiobutton">&nbsp;&nbsp;&nbsp;
&nbsp;Male

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;

<input name="radiobutton"
type="radio"value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Female<br>

Pull down Lists: This element creates a menu control. Using this either a drop down
menu or a list box can be displayed in the web page. Also this element must contain

morethanoneoption.Hereyouuse<Select>insteadof<Input>andithasaclosing

tag</select>. These fields allow user to select single or multiple responses..The name

attribute establishes a name for the select field and is used for form processing. The

sizeoptionissimplythenumberofoptionsyouwanttoshowinthewindow.Bydefault, its value

is one specifying size value greater than one turns the pull down list into a

scrollinglist.Youcanusethemultipleattribiutetosettheselectfieldtoacceptonlyone

option.ToselectmultipleoptionspressCtrlKeyandclickontheoptions.The<Option>

tagincludesthelistitems.Foreachlistitem,theremust bean<Option>tag.The closing tag is

optional. You can use Value attribute to specify the text to be submitted



whentheparticularitemisselected.Useselectedattributetoindicatethedefaultmenu item.

<label>Year</label>
<selectname=”Textid”size=”n” mulitple>
<optionvalue=”ChoiceId1” selected>2000</option>

<optionValue=”ChoiceId2”>2001</option>

</select>

<label>Dateof Birth</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;MM&nbsp;&nbsp;&nbsp;

<selectname="s1"size=1>

<optionname="01">january</option>

<optionname="02">february</option>

<optionname="03">march</option>

<optionname="04">april</option>

<option

name="05">may</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

DD&nbsp;&nbsp;&nbsp;

<selectname="s2"size=1>

<optionname="01">01</option>

<optionname="02">02</option>

<optionname="03">03</option>

<optionname="04">29</option>

<optionname="05">30</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&

nbsp;&nbsp;

YY&nbsp;&nbsp;&nbsp;



<selectname="s3"size=1>

<optionname="01">2001</option>

<optionname="02">2002</option>

<optionname="03">2003</option>

<optionname="04">2004</option>

<optionname="05">2005</option>
</select><br>

Text Area Tag: Itisanextensionoftextelement.Theinputelementtype=”Text”
createsasinglelinetextboxandTextareatagcreatesamultiplelinetext box.Itsetsan

areawithinaforminwhichtheusercantypealargersectionoftext.Thetextareatag presentsa

multiple text window with the size specified bythe rows and colsattributes.

Rowsgivetheheightandcolsgivethewidthofthetextarea.

<Textareaname=”text-Id”rows=”n”cols=”n”>TypeanyTexthere...

</Textarea>

<label>TypeYourMessageHere</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<textareaname=”ta”rows=15cols=60></textarea><br><br>

File Control: Thiscontrolletstheusersubmitafileontheircomputeralongwiththe
form.Thesizeattributespecifiesthephysicalsizeofthefieldsinputbox.Theaccepts attribute is

used to restrict thefiletypes allowed inafileupload.

<Inputtype=”file”name=”file-id”size=”n”accepts=”file-type”>

<label>attachyourResume</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;



&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="file"name="file"><br><hr>

Password:Passwordfieldisexactlysimilartotextfield,exceptthatitdisplays
****(asterisks)insteadoftheactualinput.Thesefieldsaremainlyusedforconfidential

contents.

<inputtype=”password”name=”passwordid”value=”defaulttext”>
<label>Login:</label><br>

<label>User

Name<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;

<inputtype="text"name="t1"size=25maxlength=25value=""><br>
<label>Password<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&

nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<inputtype="password"name="pass"size=25 maxlength=25><br><hr>

ButtonValue: Createsabuttonsimilarinappearancetoasubmitbutton,exeptthatthis
kindofbuttondoesn’tdoanythinginparticular.←singbuttonvalueoftypeattributeyou could

have buttons of your choices. You normally require these buttons for executing various

scripts. These buttons have no default functions like submit & Reset. The name attribute

assigns a name to the button and is used for form processing. The value

attributesacceptsa text that appearsonthebutton.Thebutton sizewillbe controlled

directlybythetextlength.TheONCLICKattributegivesthenameofthescript thatisto be

activated when the button is clicked.

<Inputtype=”button”name=”buttonid”value=”clickhere”
onclick=”Script”>

Image Button: Exactlythesameasasubmitbutton,exceptthatyoucanspecifyany image
instead of the normal gray button appearance. An input element with



type=”Image”createsanimagebutton.Insteadoftextanimageof yourchoiceis

displayed.Theattributesforanimagebuttonaresimilartotheattributesfor<IMG>tag.

HereyouhavetospecifySRCorImagesforaligningtheminleft,centerorright

<inputtype=”image”name=”img”src=”pic.jpg”height=50width=100>

Submit Button: Everyformmusthaveasubmitbuttonasafterfillinguptheform,the
visitorneedstosubmittheinformationtoyou.Aninputtagwithtype=”Submit”provides

abuttonthatsubmitstheinformationinthecompleteformtotheURL,givenasthe

actionattributeoftheformtag.Bydefault,”Submit”iswrittenoverthebuttonistaken

fromthevalueattribute.Thebuttonsizewillbecontrolled directlybythetextlength.

<inputtype=”submit”name=”sub”value=”Submit”>

ResetButton:Theresetvalueofthetypeattributecleansallformentriestothedefault once or
leaves them blank if no defaults are specified.As the reset button can simply wipe off all

the work done, therefore it should be well labeled and should never be placed before

submit button.

<inputtype=”reset”name=”res”value=”Reset”>

</fieldset>

</form></body></html>

FRAMES

Framesareusedtocreateadocumentthatdividesthebrowserwindowintodifferent parts
and display a different web page in each of them.A frame set document is a

document that defines one or more frames by using frameset and frame elements.

Framescancommunicatewitheachothersothatanactionperformedonapageinone

framecanchangethecontentsandbehaviorof anotherframe.Acommonframelayout

usesanindexframewithlinksontheleft,andacontentframeontheright.Asyouclick



onthelinksontheleftframe,thecorrespondingHTMLpagewillappearontheright

frame.Oneframecanbeusedtokeepsomeinformationstaticwhiletheotherframe can

contain the actual content of different sections of website.

The <Frameset>Tag: Thesplittingofabrowserscreenintoframesisaccomplished
withthe<frameset>and</frameset>tagsembeddedintotheHTMLdocument.The

<frameset>tagrequiredoneofthefollowingtwodifferentattributesdependingon whether

the screen has to be divided into rows or columns.

Rows & Cols: Row attribute is used to divide the screen into multiple rows. Cols
attributeisusedtodividethescreenintomultiplecolums.Itcanbesetequaltoalistof values.

Depending on the required size of each Rows and Columns. The value can be:

1. Anumber of pixels.

2. Expressedasapercentageofthescreenresolution.
3. Thesymbol,’*’whichindicatestheremaining space.

Example :<Frameset

Rows=”50%,50%></Frameset>Result:Itdividesthebrowserscreenintotw

oequalhorizontalsections.
<FramesetCols=”50%,50%></Frameset>

Result:Itdividesthebrowserscreenintotwoequalverticalsections.

The <frame>tag: Oncethebrowserscreenisdividedintorows(horizontally)and
columns(vertically),eachdifferentHTMLdocument.Thisisachievedbyusing the

<Frame>tagwhichtakesinthefollowingattributes:

Name=”name”:Givestheframeauniquenamesoitcanbetargetedbyother documents. The name
given must begin with an alphanumeric character.

<FrameName=”AA”>

Src“Url”: IndicatestheURLofthedocumenttobeloadedintotheframe.



Creating FramedDocuments: Creatingframesisactuallyquitesimple.Firstofallyou
needtodecideashowyouwanttodividethebrowser’s windowof thewebpage.Then

writethehtmldocumentthatyouwanttoputinthepagesegments.Inadditiontothisa master

document is to be written which is used to specify what goes where. Suppose we

wanttodivideapageintotworowsandfourcolumns.ThentheHTMLcodeforthe frameset will

be:

<html>

<head><title>FRAMEONLINE..... </title></head>

<frameset>

<frameset cols="30%,*">



<frameset rows="50%,50%">

<frame name="aa">

<frame name="bb">

</frameset>

<frameset rows="50%,50%">

<framename="cc">

<frame name="dd">

</frameset>

</frameset>

</frameset>

</html>

The<Frameset>and<Frame>tag:Themasterpagedoesn’thavea<body> tag.Instead,
it uses

<Frameset>tags.The<Frameset>tagisincludedafterthe<Head>tagandit established

frames within the HTML document. Itdoes all the dividing. It requires a closing tag

and there may be any number of frameset tags within an HTML

document.Thecolsattributeisusedforverticalframeswhereastherowsattributeis

usedforhorizontalframes.Thewidthorheightisspecifiedasacomma-delimitedlist of

sizesin pixels,percentageorasa proportion of the remainingspace byusing“*”.

Anotherbasictagisthe<FRAME>tag.Itcontainstheframecontentandittells the

browser what to put in each frame. Each frameset must include a

<FRAME>definitionforeachdivision.Asinourexampletherewerefourpartitionsand so

four <FRMAE>tags. Notice that frame does not have a closing tag.



Frame Border Attributes: By default, most browser use a frame border. Border
attributesthatcontroltheframeborder.Toturnoffframebordersetborder=0andfor

turnonbordersetborder=8.Youcanusetheseattributesbothinthe<frameset>or

<frame>tags.Toremoveallthebordersfromyourframesaddthoseinthe

<frameset>tagandtoremove theborderfromindividualframes include these

attributesinthecorresponding<frame>tag.Youcanalsosetthecoloroftheborderby Just add

bordercolor=”purple”.

Controlling Scroll Bars: Scrolling controls the appearance of horizontal and vertical
scroll bars in a frame. This takes the value Yes / No / Auto.

In simple words, if the frame’s content goesbeyond the frames width, most

browsersadd scrollbarsso that the usercansee thefullcontent. Even through scroll

barsareusefultoseetheentireframe’scontent,sometimestheycanbeunnecessary and

visually disturbing. You can control the use of scroll bars in a frame by including

scrolling attributes.

Yesmeanstheframegetsscrollbars-whethertheyareneededornot.

No meanstherewillbeanyscrollbars,evenifyourframecontentismuchlarge. The

browser will simply display as much as it can.

Auto is default If scroll bars are needed, theyappear, it theyare not needed
they stay conveniently out of the way.

Targeting Named Frames: Whenever a hyperlink which loads a document in a
frameiscreated,thefilereferencedinthehyperlinkwillbeopenedandwillreplace the

current document that is in the frame.

Inasituationwherethenewdocumentneedstobeopenedinadifferentframe while

keeping the document from which the newdocument was browser open in a different

frame, a simple HTML coding technique must be used.

SincethehyperlinkmustopenanHTMLfileinanotherframe,theframein

whichtheHTMLfileistobeopenedneedtobenamed.Thisisdonebyusingthe



name attribute of the <FRAME>tags. The name takes one parameter, which is the

framename.Thehyperlinktagwillhavetobesuppliedwiththefollowinginformation:

1. Thefilename.htmlfilethathastobe opened.

2. Thename oftheframewherethefilename.html file hastobeopened.
TheattributeviawhichtheframenameisspecifiedistheTARGETattribute,

whichisapartofthe<A></A>tag.Thisinformationisgivenas: TARGET=”framename”

<a href=”filename.html”
TARGET=”framename”>Link Content</a>

WebEditorNotepad

There will be times when you will want to edit textualfiles.Textualfiles are different

from documents created by WordPad, Word, WordPerfect or some other word

processingprograminthattheycontainnoimbeddedcodes.Editingthesefileswitha word

processing program can introduce special characters that make these files unusable.

Instead, use Notepad which allows you to edit the file as pure text.

Textual files will normally have a TXT file extension, but there are several special

purposefilesinWindowsthatmustbepuretext.Someofthemoreimportantofthese include

your CONFIG.SYS, AUTOEXEC.BAT, WIN.INI and SYSTEM.INI (These files existed in

earlierversion ofWindows, buthave beeneliminated inWindowsXP).You

maygettothepointofwantingtoplaywiththesefiles.Ifso,useNotepadtoeditthese

andnotWordPadasyoursystemcannotusetheresultingWordPadfile.Ifyoudecide you

want to create a web page, but don't have an HTML editor, you will want to use

NotepadsoasnottointroducethosenastycharactersassociatedwithWordPad,etc.

Inadditiontohavingatooltouseineditingthosespecialfilesonyoursystem,learning

Notepadcanprovideagoodfoundationforlearningsomeoftheothertoolsthatcome

withWindows95/98/ME/XPaswellasanumberoftheapplicationsthatyoumaywant to add

to your system later. Notepad is simple to learn but has some features in common

with other programs.



The first thing I want to point out in the above is that I have entered some text into

Notepad.Okay,let'slookatsomeofthefeaturesofNotepad.Let'sstartoffbylooking

ateachofthemenusacrossthetopofNotepad.Beforewegototheindividualmenus, notice

something about themenubar itself. See theunderlined letters in each of the menu

items (File, Edit, Format, View, etc.) (Under Windows XP, the underlines are

onlyvisiblewhenyouholddownthe<Alt>key-previouslytheunderlineswerealways

visible)?Thesearemeaningful.Ifyouholddownthe<Alt>keyandpresstheseletters, you will

select that menu. Obviously you can select each menu with the mouse, but this

gives you an alternative way of getting into them. So, you can get into the File menu

by pressing <Alt>F.

FileMenu



ThisistheFilemenu.Noticeacoupleofthingsaboutthismenu.Noticethe"..."atthe end of

several selections. This indicates that selecting these items will take you to a dialog

box that will allow you to carry out that operation.Notice the code down the

rightsideofthemenu-Ctrl+N,Ctrl+O,etc.Thesearehotkeysyoucanusefromwithin

thedocumentwithouthavingtogointothemenu.Forexample,holdingthe<Ctrl>key down

and pressing N is the same as going into the File menu and selecting New.

Thesehotkeyscansaveyousometimeingettingtothesefunctions.Iwouldn'ttryto

memorizethesehotkeysrightnow,butjustmakeamentalnoteofthem-you'lllearn them

over time as youfind them appropriate to your situation.

New-Thiswillstartanewdocument.Ifyouarecurrentlyworkingonadocumentthat

youhaven'tsaved,thesystemwillpromptyoutosavetheolddocumentbeforestarting a new

one.

Open...-ThisallowsyoutobringanexistingdocumentintoNotepadtoviewand/oredit it. You'll

see the following dialog box when you make this selection:



This is the standard Open dialogboxused bymostWindows programs. It consists of

atoolbaracrossthetopthatshowsyouwhichfolderyouarecurrentlyinalongwitha couple of

control buttons for getting to where you want to go. The main part of the

Opendialogboxshowsyouthefiles/foldersthatmatchthecriteriaforthisapplication.

Nextiswherethesystemwilltellyouthenameofthefileitthinksyouwant.Rightnow,

itdoesn'tknowsoitassumesyouwanttolookatallTXTfiles.Nextiswhereyoucan

tellthesystemwhattypeoffilesyouareinterestedinlooking at.Bydefault,Notepad looks at

Text Documents (*.TXT), but you can change this to look at anything else. Finally,

you can either Open the selection or Cancel this operation.

Save - If you are making modifications to an existing file, Save will put the changes

backintothefileafterconfirmingthatyoureallywanttomakethechanges.Ifthefile you are

working on is a new file, Save works the same as Save As....

SaveAs...-SaveAs...bringsupadialogboxsimilartotheOpendialogboxabove.In

Notepadyougettosavethefilewhereveryouwant,butthebestplacewouldbeinMy

Documents.It'seasyenoughtochangefoldersandsaveafileanywhereonthe



system you want. See Naming a File for some suggestions on how to organize your

data.

Page Setup... - The Page Setup... dialog box allows you to customize some of the

thingsyouseewhenyouprintyourdocument.Forexample,youcanchangethesize

ofyourpaper,customizetheheaderandfooteroneachpageaswellasthemarginat

thetop,bottomandeitheredgeofthepaper.ThePageSetup...dialogboxlookslike this:

Print...-Thisisastandardprintoperation.ItbringsupthePrintdialogwindowwhereyou can modify

the printer information.

Exit - This shuts down Notepad. If the file you've been working on has not been saved,

you will be prompted to save the file before Notepad exits.

EditMenu



The Editmenu contains thosefunctions thatallow you tomanipulate the information

youhaveonthescreen.Inthiscase,therearefouritemsthatappeardiminthemenu. The

reason for this is that these items are not available at the present time. In most

cases,youhavetohavesomethingselectedfortheseitemstowork.Windowsdoesa pretty

good job of communicating with you to tell you what you can and cannot do.

AlsonoticethatmostoftheitemsintheEditmenuhaveakeycombinationontheright

(Ctrl+Z,etc.).Thesearehotkeysthatcanbeusedfromwithinthedocumentwithout

havingtogototheEditmenu.Forexample,youcandoaCopyfromwithinadocument

byholdingdownthe<Ctrl>keyandpressingthe"C"key.Idon'trecommendthatyou

tryandmemorizethesehotkeysjustnow.Instead,Iwouldrecommendthatyoujust

makenoteofthemasyouusethemenuitemsandovertimepickuponthoseyouuse most

frequently.

Undo - Notepad does have a rather neat feature called the Undo. In essence, this is

yourOopsbutton.Ifyoumakeamistakeandsuddenlysay"Oops",youcanselectthe Undo

and reverse whatever it was you just did. Unless I'm mistaken, the Undo item will

only work on the most recent change you've made to your document.

Cut - Again, this item is only available if you have something selected in your

document. Otherwise you have nothing to Cut. You can select some piece of your

document by holding down the left mouse button and dragging across the

letters/words/sentencesthatyouwanttoselect.Yourselectionwillhavewhiteletters and a

blue background. Now you will be able to Cut this selection. Cut removes the



selectedtextfromyourdocumentandputsitontheClipboard.Theinformationisnot totally

deleted, but is being held in case you want to put it somewhere else.

Copy-CopyisverysimilartoCut.TheonlydifferenceisthatwithCopy,yourselected

textisnotremovedfromthedocument.Instead,acopyofyourselectedtextisplaced on the

Clipboard for you to use later.

Paste - Once you have some text on the Clipboard (using either Cut or Copy above),

you canmove to wherever you would like to put thistext and Paste itbackinto your

document.Inotherwords,thecombinationofCutandPasteallowsyoutomovetext

aroundwithin yourdocumentwhilethecombinationof CopyandPasteallows youto

duplicate information.

Delete - When you Delete text from your document, it is gone. If you do this by

accident, you can use the Undo function to bring it back, but otherwise it is gone.

Delete does not place the selected text on the Clipboard.

Find... - As you've already seen, this function opens a dialog box that allows you to

enter the text you want to search for along with a couple of pieces of information to

helpNotepadperformthesearch.Ifthetextisfound,itwillbeselectedreadyforyou to Cut,

Copy or overtype.

Find Next - This function simply repeats a previous Find.... This is useful if you have the

same text in several different places within your document.

Replace - This function allows you to locate some text within your document and

replaceitwithsomeothertext.Itevenhastheabilitytoperformitsfunctionglobally

throughthedocument,butbecarefulofusingthisasitcangetyouintotrouble.For

example,supposeyouwantedtoreplace"eat"with"ate"globallythroughouta



document.This function would do it, but it would also change "eaten" to "ateen",

"cheat"to"chate" and"defeat" to "defate".

GoTo... -InGotoline,typethelinenumberyouwantthecursortojumpto.Youdo

nothavetohavelinenumbersinyourdocumentforthiscommandtowork.Linesare

counteddowntheleftmarginbeginningatthetopofthedocument.

SelectAll-Ifthereissomethingyouwanttodowithallthetextinyourdocumentat the same

time, all you have to do is select the Select All function and your entire document

will be selected. Now you can either Cut or Copy all the text to your Clipboard.

Time/Date-TheTime/DatefunctionisaneatfeatureofNotepad.Somepeopleliketo keep a

journal and in a journal, you might want to have the date and time as part of the

document. Obviously, you can type in the date and time, but with the Time/Date

function,Notepadwillautomaticallyinsertthedateandtimelikethis:7:47AM2/27/98. Format

Menu

WordWrap - In some cases, you may want the text you type to appearon the same

line,butmostofthetime,you'dliketobeabletoseeallthetextonthescreenatthe

sametime.Ifyouonlyhavealittlebitofinformation,youmightbeabletoenlargethe



Notepadwindowtoseeallthetext.AnotherwayofhandlingthisistoselecttheWord

Wrapfunction.Thiswilltakewordsthatdon'tfitintheNotepadwindowandwrapthem

downtothenextline.Acheckmarkappearswhenwordwrapisturnedon.Wrapping

textenablesyoutoseeallthetextontheline,butitdoesn'taffectthewaytextappears when it is

printed.

Font... -Thisallowsyoutochangethefontusedtodisplaythefileyouhaveopen.It doesn't

change the font of the file itself. It simply allows you to view/edit files using

whatever font you wish.

ViewMenu

This menu only contains one item; Status Bar which will place an extra line at the
bottom of the Notepad window to keep you informed of what has or will be done as

you work in Notepad.

Help Menu



Most programs in Windows have a Help menu that provides information about using

that particular program. The Help menu may not answer all your questions about a

program, but I would encourage you to explore what is there before you look

elsewhere. Most companies marketing software today are providing more Help and

less hardcopy documentation.

Help Topics - Notepad is a very simple program to use as it doesn't contain a lot of

bellsandwhistles.Asaresult,theHelpTopicsisnotverylong.Youshouldbeableto explore all

of Help Topics in just a few minutes. I would encourage you to do so for two

reasons. First, you'll know nearly everything there is to know about Notepad. Second,

you'll become familiar with the format of the Help facility Microsoft uses so you'll

know what to expect in other Microsoft products.



AboutNotepad -ThefunctionoftheAboutforanyprogramissimplytoletyouknow

whatversionoftheprogramyouarerunning.Fromtimetotime,theprogrammermight include

some additional information about your system, but don't expect this. Here's what

my version of About Notepad looks like:

WebBrowserInternetExplorer

BasicTerms

OneofthemorepopularandfastestgrowingareasincomputingistheInternet.

TheInternetisacollectionoflargecomputernetworks,eachofwhichisacollectionof smaller

networks.A network is composed of several computers connected together

forthepurposeofsharinginformationandresources.ConsideryourcomputeratFloyd

College.Your computer is connected to the local network at the college, which is in

turnconnectedtoPeachnet,whichisconnectedtotheInternet.Thesoftwareusedto connect

computers is called Transmission Control Protocol/Internet Protocol, or TCP/IP.

TheWorldWide Web

Modern computers have the ability to deliver information in a variety of forms

such as graphics, sound, video, animation, as well as text.The ability to deliver

information in these different forms is called multimedia.On the Internet this

multimedia capability is available in a form called hypermedia.Hypermedia is any

varietyofcomputermediaincludingtext,graphics,videoandsound.OntheInternet,

hypermediaisusuallyaccessedthroughtheuseofahyperlink.Ahyperlink,orlink,is

aspecialsoftwarepointerthatpointstothecomputerthatcontainstheinformationin

whateverformattheinformationexists.Thecollectionof hyperlinksthroughoutthe

InternetcreatesanetworkoflinkscalledtheWorldWideWeb.Eachcomputerinthe

Webthatcontainshypermediathatcan bereferencedbyhyperlinksandaccessedby other

computers is called a Web Site.Hundreds of thousands of Web sites around the

world can be accessed through the World Wide Web.



URL(UniformResourceLocator)

The URL of a Web page is a unique address of each individual Web page at

theWebsitesontheInternet.AtypicalURLiscomposedofthreeparts.Wewilluse the URL

below to explain the function of each part.

The first part of any web address is the protocol.A protocol is a set of rules

thatcomputersfollow.Mostwebpagesusehttp,whichstandsforhypertexttransfer

protocol.HTTP describes the rules for transmitting hypermedia documents

electronically.Theprotocolisenteredinlowercaseashttpandisfollowedbyacolon and two

forward slashes.The colon and the two forward slashes are required

punctuation.Other protocols used on the internet include FTP which stands for file

transferprotocol,gopherwhichgivestherulesformenudrivendocumenttransfer,and telnet

which describes the rules for remote terminal sessions.

ThesecondpartofaURListhedomainname.ThedomainnameistheInternet

addressofthecomputeronwhichtheWebpagesarelocated.Inourexampleabove, the

domain name is www.softbrain.org The last part of the domain name gives an

indicationofthetypeoforganizationresponsiblefortheWebsite.Forexample,com at the

end indicates a commercial site, gov indicates a government site, and edu indicates

an educational site.

The third part of the Web address is the file specification of the web address.

This part of the Web address shows the filename of the web page as well as which

folder or folders contain the Web page.This is called the path name of the page.

HTML(HyperTextMarkupLanguage)

Web pages are created using a special formatting language called hyperText

Markup Language.HTML formatting codes are used to display the pictures and

graphicsusedtocreateWebpages.WhenyouareviewingaWebpage,youcansee theHTML

codeusedtocreatethepagebyselectingthe“↑iew”pull-downmenuand then clicking on

“Source”.

http://www.softbrain.org/


HomePages

Ahomepageistheintroductorypageof aWebsite.Allotherwebpagesforthat site can

usually be reached through the home page.

InternetBrowsers

A browser is a program that makes using the World Wide Web easier by

removingthe complexityof havingto rememberthe rules, syntaxand commandsfor

accessingWeb pages.Internet Explorer is the browser that you will be using in this

course.Another popular browser is Netscape Navigator.

StartingInternetExplorer

BeforeyoucanuseInternetExplorer,itmustbeinstalledonyourcomputerand

youmustbeconnectedtotheInternetthrougheitheralocalareanetworksuchasthe one at

Floyd College or a modem.If the program is installed, you start Internet

Explorereitherbydoubleclickingonitsicononthedesktoporbyclickingonthestart button,

Programs, andthen Internet Explorer.When the program starts, you should see the

Floyd College home page.The title of the web page will be displayed in the title bar.

TheInternetExplorerWindow

The Internet Explorer window contains several features to make your work on

the Internet easy.Several of these features are common to all Windows 95

applications such as the title bar at the top with the menu bar containing pull-down

menus below it.

Below the pull-down menus is the standard toolbar.Each of the main features of the

Internet Explorer screen is discussed below:

MenuBar



Themenubarcontainsseveralbuttonswhichareusedtogroupcommandsinto

groups.File contains the commands which relate to file operations such as saving a

file or printing a file.The Edit menu contains commands for editing your work.To

display a menu choice such as File, click on the word File in the menu bar.A list of

choicesshouldappearbelowthewordfile.Toselectoneofthesemenuchoices,click on the

appropriate choice from the pull-down menu.

Displayarea

Most web pages are too large for the entire page to be seen on the computer

screen atonetime.When viewing a page in Internet Explorer,you willusuallysee a

scrollbarattheright sideof yourscreen,which canbeusedtoscrolldown andview the rest

of the document.Use the arrows on the top and bottom of the scroll bar to move up

and down through the document.

Someof thewords ona web page willbe displayed inblueletters.Thisisthe

default color of text which is a hyperlink.A hyperlink is a pointer that sends your

computertoanotherplaceontheInternetsimplybyclickingonthelink.Picturesand graphics

can also be hyperlinks.As your mouse pointer is moved over a hyperlink,

thepointerchangestoapointinghandtoshowyouthatwhateverisdisplayedonthat

portionofthescreenisalink(pointer)toanotherplaceontheInternet.

StandardToolbar

Thebuttonsonthestandardtoolbarallowyoutoperformcommontasksquickly and

more easily than doing those same tasks using the choices on the pull-down

menus.Twoveryimportantbuttonsarebackandforward.Thesebuttonsallowyou

tomovethroughthewebpagesthatyouhaveviewedinInternetExplorer.Theback

buttontakesyoubackonescreenatatimewhiletheforwardbuttonmovesyouforward one

screen at a time.Each button on the toolbar is normally gray.Color is added when the

mouse pointer is placed over a button.

Another important button on the standard toolbar is the STOP button.Some

webpagesareverylargeand takeconsiderabletimetoloadanddisplay.Youmight see the

first part of a page and decide that you do not need this page or you might decide

that you do not want to wait for the entire page to load.Clicking the STOP button will



stop a webpage from being downloaded.



AddressBar

TheAddressBarcontainsawhitetextboxwhichdisplaystheURLfortheweb page

currently displayed.The URL of a web page is its Internet address.These will

bediscussedinmoredetailbelow.Youcanalsotypeawebaddressintothisboxand press

ENTER to load the web page in Internet Explorer.

InternetExplorerIcon

The Internet Explorer Icon rotates while a connection to a web site is being

made, a web page is being loaded into memory, and a web page is being displayed

on your screen.

StatusBar

TheStatusBardisplaystheURLof alinkwhenthemousepointerpassesover

thelink.Italsoprovidesinformationabouttheprogressofyourrequesttoloadanew web

page.

Toolbars

Several toolbarsare available in Internet Explorer.Eachone contains buttons

that enable you to easily move between web sites and stop a page from being

downloaded.

InternetAddresses

Allinternetaddresseshavethesamegeneralformatasshownbelow:

http:// www.softbrain.org

Thefirstpart,http://,letsthecomputerknowthatyouarelookingforawebserver,not

newsormailserver.Themiddlesection,www.mcp.com,isthenameofthecomputer

http://www.softbrain.org/
http://www.mcp.com/


whichcontainsthefilesyouarelookingfor.Thepartthatappearsaftertheslash



names the folders and filenames of the documents you are looking for.The .html

indicates the type of document you are looking for, in this case HyperText Markup

Language which is the standard language in which all web documents are written.

↔oucanleaveoffthe“http://”whentypinganinternetaddressinInternetExplorer. Internet

Explorer also assumes that the address will be in the form

www.softbrain.organditisnotnecessarytotypethewwwandthecom.Thesewillbefilledinbyin

ternet explorer if you leave them out while typing an internet address.

Note:Many computers on the internet are case sensitive so you need to make sure

thateveryletterthatshouldbecapitalizediscapitalized.Alsomakesurethatyouare using a

forward slash “/” when necessary instead of the backslash “\”.

TheLinksToolbar

Thelinkstoolbarprovidesasetoflinkstogetthenewuserorientedtotheinternet.It comes

with connections to a variety of places including Best of the Web, Microsoft’s

HomePage,theWebGallery,ProductNews,andToday’sLinks.Ifyouselectoneof the links

shown on this bar, Explorer opens that Web Page.From there you can

accessinformationindiverseareasbyfollowingthelinksshownonthescreen.Asan example,

if you choose Best of the Web, you can access information on travel,

entertainment,sports,andmuchmorejustbyfollowingthelinks.Travelthroughthe

layersandeventuallyyouwillreachanarticlediscussingthesubjectinwhichyouare

interested.

ForwardandBackButtons

Two of the most useful buttons on your screen are shown in the upper left corner of

yourscreenonthestandardtoolbar.Thesearetheforwardandbackbuttons.Many times as

you explore on the internet, you will need to move back to a page that you have

already visited.By clicking the back button you can move back through the

pagesyouhavevisitedoneatatime.ThenyoucanclicktheForwardbuttontomove forward

through the pages as you browse for information.

Note:Onceyoumovebacktoyourfirstpage,theBackbuttonwillbegrayindication that

http://www.softbrain.org/


you have traveled as far as possible in this direction.



Note:Youcanonlyusetheforwardbuttonafteryouhavefirstgoneback.Until

yougoback,theforwardbuttonwillbegrayindicatingthatthisoptionis

unavailable.

HomeButton

If you become hopelessly lost in your internet explorations, you can always click the

homebuttontoreturntoyourStartingPage.Thispagecouldbeoutofdateespecially

ifitisonethatisupdatedfrequently,soyoumightneedtoclickontherefreshbutton to display

the latest version of the page.

Links

TheWorldWideWebismadeofmillionsofwebpagesthatarejoinedtogetherbyhypertext links

that provide a truly “point and click” environment for accessing information on your

computer.These linksarereallypointersthat instruct yourcomputerwhereto go on the

Internet to access the information you requested.By default, links are displayed in blue

text,butawebpagecandisplayitslinksinanycolor.Thereisoneadditionalwaythatyou can

identify a link.When the mouse pointer is moved over a hypertext link, the pointer

changes to a hand.When the mouse pointer changes to the pointing hand, you will see

the URL of the link displayed in the status bar located at the bottom of your screen.

Using Links

Linksareactivatedbyplacingthemousepointeronthelinkandclickingoncewiththe left

mouse button.When you click on the link, Internet Explorer loads whatever

document, file, or web page that is attached to that link.While a document is being

loaded,thesmallglobeintheupperleft-handportionofthescreenwillspin.Explorer will load

the text of a web page before it loads the graphics to allow you to begin

readingthecontentsofthepagewhilethegraphics,whichloadmuchslower,arebeing

displayed.Whiteboxeswillbedisplayedtomarkthelocationofthegraphicsthatwill be

shown later.When the globe stops spinning, the page is completely loaded.

Note:Iftheglobestopsspinninghalf-waythroughaturnorthemessage“connecting

tohost”isdisplayedatthebottomofthescreenforanextendedperiodoftime,then

youhaveaproblemwiththewebpageyouaretryingtoload.Eitherthesitewasbusy



orjustnotworkingforsomereason.Ifthishappens,clickthe“STOP”buttonlocated on your

toolbar at the top of the screen.

TheRightMouse Button

Once a web page isdisplayed, you might want to save the page forlateruse, or you

might want to use a graphic on the page as wallpaper.To perform either of these

tasks,usetherightmousebutton.Let’ssupposethatyoufindanimagethatyouwant

tosaveonyourharddiskforlateruse.Pointtotheimagewithyourmouseandclick the “right”

mouse button.A shortcut menu will pop up giving you choices such as

savingtheimageorusingtheimageaswallpaper.Inourexamplewehavefoundan

imagethatwewanttosaveonourharddisk,sowewillselect“SavePictureAs”from

theshortcutmenuthatappears.Youwillbeaskedtonametheimageyouaresaving and

select a location for saving the file.Click OK when you are finished.You could also

select “Set

As→allpaper”tomakethepicturethewallpaperthatwillbedisplayedonyourdesktop.

Using History

Internet Explorer provided other ways to move around in the pages you have visited

thanjustusingtheBackandForwardbuttons.TheHistoryListallowsyoutoinstantly move to

any site that you have recently visited.History keeps track of not only the sites you

have visited today, but also keeps track of the sites you have visited in the

pastfewweeks.Theexactlengthof timeasitestaysinhistoryis determinedbythe

user,butthedefaulttimeistwoweeks.Tousethisfeature,clickontheHistorybutton

atthetopof yourscreenandselectthesiteyouwishtorevisitfrom thelist.

Savinga WebPage

If you are doing research, you are going to need to save the information that you

locatesothatyoucanuseitatalatertime.Websiteschangesooftenthatyoucannot be

assured that the files you find onWednesday will still be there on Thursday.For this

reason, saving files is an extremely important function of computer applications. To

save a web page, follow these steps:



1. Withthewebpageopen,clickonthefilepull-downmenu.



2. Selectthelocationwhereyouwanttostorethefile.

3. Givethefileanappropriatename.

4. Clickthesavebuttoninthedialogbox.

Note:Whenyousaveawebpage,allyouaresavingisthehtmlcode.Thegraphic that were

on the original site will be missing.

AddingLinkstotheFavoritesMenu

When you are searching on the Internet, you will undoubtedly find certain sites that

youwillwishtovisitoften.Youcanaddthesesitestoalistof"favorite"sites.Thisis

alsocalledabookmark.Bookmarksontheinternetarejustlikebookmarksinabook. The

mark your place.

Toaddawebpagetoyourlistoffavorites,followthesesteps:

1. Whileviewingthepageyouwishtobookmark,clickonthe"favorites" pulldown

menu.

2. Select"AddtoFavorites".

3. Inthenamebox,typethenamethatyouwishInternetExplorertouseinyour list of

favorites.

4. ClickOKandthissitewillbeaddedtoyourlistoffavorites.

AccessingtheFavoritesMenu

To viewa page that you have listedas afavorite, simplyclick on the"Favorites" button on

the standard toolbar and select the webpage that you wish to go to.



WebFrameworkDreamweaver
Dreamweaverisawebauthoringprogramthatusesa→↔SI→↔G“whatyouseeiswhat you get”

interface. The HTML code is being created and is accessible to you if you want

toplaywithit.

Finally,let’sgetstartedwithDreamweaver.

Launch Dreamweaver

1. StartDreamweaver.Youshouldseeastartup screen.3
DreamweaverletsyoupublishyourWebsitebyeasilyuploadingyourWebsitetoa

→ebserver.Rightnowwewon’tbeworryingaboutthat.Fornow,youwillbecreating

andviewingyoursitelocally(whichmeansthesitewillbelocatedonyourcomputer).

Weneedtodefineyoursite:

CreateaNewSite

2. FromtheSitemenu,chooseManageSites…TheManageSitesBoxshouldappear.

3. ClickNewandthenchooseSitefromthepop-upmenu.

4. ClickontheAdvancedTabunderSiteDefinitionforUnnamedSite1.

LocalInfo

LocalInfoiswhereweputintheinformationaboutthefilesthatareonyourlocalcomputer (which is

where all your files are or will be for now).

5. IntheAdvancedTab,underCategory,chooseLocalInfo.4

6. NexttoSiteName,type:MyFirstDreamweaverWebsite.Youwillusethisnamewhen

yougointoDreamweavertoretrievethefilesassociatedwiththissite.Thisnamehas to be

unique within Dreamweaver.

7. NexttoLocalrootfolder,clickontheyellowfoldericontobrowseforwhereyouwant



tostoreyourwebsiteonyourlocalcomputer.Youmaywishtocreateanewfolderto



sore your files in. I stored my Web site on F: (my flash drive) in a folder I called My

Website. This is now your Root Folder

8. Click DONE. You should see a Files panel on the right side of your screen. The Local

View in the Files Panel will display all the files for your Web site that are in the Root

Folderonyourcomputer.Laterwewilladdinformationaboutconnectingtotheserver. The

Remote View shows which files have been uploaded to the server.

9. Oncewe’veenteredallthisinformationaboutlocalandremoteservers,itwillbesetup

forusnexttimeweuseDreamweaveronthiscomputer.←nfortunately,itdoesn’twork

thatwayon lab computers. If youmove to another computer,youwill have to set up

your Web site on the new computer as well. 5

WHAT’SAROOTFOLDER?

The local root folder is where you will keep ALL the files for your web site. You can

createsubfoldersunderit,butconsiderittobetheparentofallparentfolders.↔ou’ll keep all

of the files and subfolders for your Web site (including html pages, images,

multimediafiles,etc.)eitherintherootfolderorasubfolderundertherootfolder..

MakingyourfirstWebPage:

10. UndertheFilemenuatthetop,chooseNew.

11. In the NewDocument dialog box, make sure you have BlankPage selected, the Page

Type is HTML, and the Layout is <none>.

12. Click Create.YoushouldnowseeablankWebpageintheDocumentWindow.

13. UndertheFileMenu,chooseSave.

14. IntheSaveAsbox,findyourWebsitefolderandsaveyourfileasindex.html

15. ClickSave.IntheFilespanel,youshouldnowseeindex.html.Congratulations!↔ou’ve

created your first →eb page using Dreamweaver. ←nfortunately, it’s pretty boring at

the moment.



SavethePage



RULESOFTHUMBfornamingwebfiles:

• Donotusespacesorspecialcharacters,suchasthosefoundaboutthenumberkeyson the

keyboard, in your file names. You can use dashes and underscores. (e.g.,

my_page.html)

• Always use a 3- or 4-character file extension for every file you use on the Web. In the

case of a regular Web page, always use .html or .html.

• Be very specific about capitalizing because most Web servers are case-sensitive.
Give yourWeb Page a Title In the document toolbar, find the Title box.

16. Onthedocumenttoolbar,locatetheTitlefield.6

17. Typeinatitleforyourpage.Feelfreetobecreative(butnotindecent).HitEnter.

18. The title doesn’t show up on the page, but will appear in tabs and across the top of

browsers. Adding Some Content Add Content to the Page

19. In the Document window, type in a good title. This one will be the head of yourWeb

page.Ifyoucan’tthinkofanything,youcanalwaysuse,“AardvarkAdoptionSocietyof

Delaware”.

20. Add a subtitle. Again, it can be anything you want. If you’d prefer, it could be, “→e

speak for Aardvarks who can’t speak for themselves.”

21. Nowthatyou’vegotagoodtitle,addsomecontent.Logically,itshouldgowiththetitle.

Typeoneortwolinesnowfornow.→e’lladdmorelater.(Ifyoucan’tthinkofanything, feel free

to throw in some of the Aardvark content).

Nowlet’sformatthecontent:

22. OntheWebpage,highlightthetitle.

23. In the PropertyInspector, click on the Formatdrop down arrow, and choose Heading 1.

Note:IfyoudonotseethePropertyInspector,chooseWindow>>Properties.



24. Onthewebpage,highlightthesecondlineoftext.

25. FromtheFormatmenuonthePropertyInspector,chooseHeading2.

Note:Whenformattingyourtext,keepinmindthattextsizesinHTMLarerelativesizes.

Thismeansthat,whenyourpageisviewedinabrowser,thetextsizewilldependonthe default

text size settings on each user’s computer. Relative sizes give users the

abilitytoadjustthetextsizetosuittheirindividualneeds.
Thisoptionisespeciallyimportantforpeoplewithvisualimpairments,butitmeansthat

theappearanceofyourpagesmayvaryfromcomputertocomputer.PlayingwithFont

Properties

26. HighlighttheSubtitle.Changethefontsizeto24.7

27. Highlight any word on the page and click the Bold icon ( ) on the Property Inspector.

The selected word appears bold.

28. Highlight the title click the gray square to the right of the Size popup menu in the

Property Inspector. A grid of colored squares appears, and the cursor changes to an

eye dropper.

29. Click the eyedropper on the desired color. The field to the right of the color swatch

reflects the code →eb browsers need to correctly display the color you’ve chosen.

30. Clickanywhereonthepage to deselectthetext. The previouslyselectedtextappears in the

new color.

Alignment

31. 1.Highlightthetitleandsubtitleonthepage.

32. Click the Align Center button ( ) on the Property Inspector. The titles should now be

centered on your page.

CreatingLists

33. Firstweneedtoaddalist.8



34. Typeinatitleforyourlistandthentypeinalistofitems.Makesurethereareatleast

3itemsinyourlist.Makesureyouhitreturnaftereachitem.(Feelfreetousealistfrom the

aardvark homework if you can’tthink of your own.)

35. Highlight the list title and choose Heading 3 from the Format menu on the Property

Inspector.

36. HighlightthelistitemsandclicktheUnorderedListbuttononthePropertyInspector.
37. Theitemsappearasabulletedlist.

38. NowtypeinanotherListtitleandanotherlistofitems.

39. HighlightthetitleandselectHeading3.

40. Highlight the rest of the items and click the Ordered List button on the Property

inspector(nexttotheorderedlistbutton).Theitemsshouldnowappearinanumbered list.

41. Saveyourwork.Getintothehabitofsavingyourworkregularly.

Page Properties

In this section you will learn how to set your page’s background color, as well as the

defaulttextandlinkcolors.Thesesettingsdifferfromwhatyou’vedonesofaronthe

PropertyInspectorbecausethey’llapplytoallthetextandlinksonthepage—notjust a

selected piece of text.

42. FromtheModifymenuatthetopoftheworkspace,choosePageProperties.

43. Tochangethetextcolor,clickthebottomrightcornerofthetextcolorbox.

44. Usingtheeyedropper,chooseacolorbyclickingonanyofthecolorswatches.

45. Similarly, you can change the background color for the page using the Background

color setting. 9

46. Youcanalsochangethecoloroflinks,activelinks,andvisitedlinks.Anactivelinkisa

linkjustwhentheuserclicksit.Acolorchangeletstheuserknowthats/heclickedon



alink.Avisitedlinkisonethattheuserhasalreadyclickedonandvisited.Acolor change lets the

user knows /he’s already visited that link.

47. Select“Links”fromtheCategorymenuatleft,thenmakeyourselectionsforlink,visited link,

and active link colors as you did in Step 3.

48. ClicktheApplybuttontoseehowyourcolorchoiceslookontheindexpage.ThePage

Properties dialog box will remain on the screen.

49. →henyou’resatisfiedwiththecolorsyou’vepicked,clickOK.

Note:Youcanaddabackgroundimageifyouwant.Browsetofindanimagebythe background image.

See what it looks like. Now you know that’s an option. →e’ll talk about this option more

later. For now, go back to a solid color background.

Note: If you changed the colorforanytext usingthe PropertyInspector,those changes will

override general page color choices.

WebPage Preview

As you create a page in Dreamweaver, the page may not look exactly like it would in

abrowser. To preview the page in a browser:

50. ChooseFile>>PreviewinBrowser>>i.e.explorerorNetscapeorpresstheF12key.

Awebbrowser,suchasNetscapeorInternetExplorer,opensandloadsthewebpage.

51. TakealookatyourpagetoseehowitwillappearontheWeb.

52. Whenfinished,closethebrowserandswitchbacktoDreamweaver.

NOTE: Colored or underlined text can be mistaken for links. Choose your color

schemesothatthelinksstandoutfromrestofthetext.Thetextandlinksalsoshould

standoutfromthe background forreadability.Whenselectingcolors, keep itsimple. Too

many colors can be distracting or confusing.

AddingImages



Note:Anyeditingorresizingofanimageshouldbecompletedbeforeitisaddedtoaweb page.

53. Firstyouneedanimage.Feelfreetofindoneonyourownthatsuitsthethemeofyour

webpage.Ifyoudon’tfeellikeit,I’veincludedanimageonmy→ebsitethatyoucan download.

54. Next,addittoyourWebpage.
55. Placeyourcursorbelowthesub-headerinyourdocumentandpressEntertwice.

56. 2.ChooseInsert>>Image.TheSelectImageSourcedialogboxwillappear.

57. 3.Usingthedialogbox,locateandselectanimage,thenclickOK.10

58. 4.Youwillfirstencounteraprompttoaddaccessibilityattributes:

59. TypeabriefdescriptionoftheimageintheAlternatetextbox,thenclickOK.

60. Becauseyou’retryingtouseafilethatliesoutsideyourrootfolder(mywebsite),you’ll receive

the following message:

61. ClickYes.TheCopyFileAsdialogboxwillappear.

62. ClicktheSavebuttontoplaceacopyoftheimagefileinsideyourmywebsitefolder.

63. Theimagewillappearonyourwebpage.

64. ClicktheRefreshbuttonontheFilespanel()andtheimagefilewill appearinthelist of local

files.

Delete an Image

65. IntheDocumentwindow,clickontheimagetoselecttheimage.

66. PresstheDeletekey.Theimagedisappears.

67. To reverse the deletion, use the Undo command. From the Edit menu, choose Undo.

The image should re-appear on the page.

CreateaSecond Page



Next,youwillcreateasecondpageforyourWebsite.

68. FromtheFilemenu,chooseNew…TheNewpagedialogboxappears.

69. ClicktheCreatebutton.Thenewfilewillappearinthedocumentwindow.

70. SaveyournewpageinthemywebsitefolderasPage2.html
71. IntheTitlefield,typeanappropriatetitleforthispage.→e’lleventuallymakeitintoa

Calendar of Events Page, if that helps you decide on a title.

72. Saveyourwork.

PagePlanning:WhenplanningyourWebsite,youwillneedtodecidehowtoorganize each

Web page. What will be placed on each page? Divide your site into pages for simple

access. If your readers want to read or print only a calendar of events, you don’t

want them to have to print the entire site to see it. Your site planning will also

include how the pages will be linked together.

Page Navigation

Nowthatwehavetwopages,youcanlinkthemtogether.→e’lllinktheindex.htmlpage to the

Page2.html and vice versa. It’s easy in Dreamweaver!

73. UsethetabsontheDocumenttoolbartotogglebacktotheindexpage.

74. Ontheindexpage,typesomedescriptivetextthatdescribesyourPage2.html.

75. Highlightthetextyouwanttomakealink.

76. InthePropertyInspector,clickontheBrowseforFileicontotherightofthelinkbox. A Select

File dialog box appears. 12

77. UsingthedialogboxlocateandselectthefilePage2.html.

78. ClicktheOKbutton.Cool!Youjustmadealink!

79. Theselectedlinkedtextisunderlinedandappearsinthelinkcoloryouchose.Inthe Property

Inspector, the Link field reads: “Page2.html



80. Saveyourworkandpreviewthepageinabrowser.



81. Testthelink.Whenfinished,returntoDreamweaver.

82. Now,trylinkingPage2.htmlbacktotheindexpage.

83. Saveyourworkandtestthenewlinkinabrowser.
Note:Thetextyouuseforyourlinkshouldbebriefbutdescriptive,givingyourvisitorsan idea of

where the link will take them even before theyclick it.

Let’scompare:clickhereformoreinformationlacksdetail.

ComparedtoCalendarofUpcomingEvents,whichisclear andconcise?

84. LinktoaWeb Page

85. Nextlet’saddanexternallink.BythatImeanlet’slinktoa→ebpagethatislocated

somewhereonthe→orld→ide→eb.→e’llneedtousethefull(absolute)←RLtolink to this

page.

86. Gotothebottomofyourindex.htmlpageandtype“MoreinfoonAardvarks”.

87. Highlightthetextyoujusttyped.

88. IntheLinkboxinthePropertyInspector,typehttp://en.wikipedia.org/wiki/Aardvark/ and

press Enter.

89. The text you selected should now link to →ikipedia’s web page on Aardvarks. To

make sure the link works properly, preview the page in a browser.

90. SwitchbacktoDreamweavertocontinueeditingyourpage.

AddanE-mailLink

Now you’ll make your e-mail address a link so that visitors can send you questions

andcomments via email.

91. Atthebottomofyourpage,type“Sendmeanemail”andhighlightthewordemail.

92. From the Insert toolbar (across the top, below File Edit, etc.), click on the envelope

icon to insert an email link.

http://en.wikipedia.org/wiki/Aardvark/


93. PlaceyourcursorintheE-mailboxandtypeyouremailaddress:

94. HitOK.Youre-mailaddressappearsasalink.
95. Save your work. Please note that the email link will try to open a desktop email

programifyouhaveoneonyourcomputer.However,ifthecomputeryou’reworking on

doesn’thave an email program set up, testing this link won’t work.

Note:OneoftheadvantagesincreatingacourseWebsiteisaddingappropriatelinks to other

sites on the Web. You may want to compile a list of links that support your

instructional goals. This allows you to supplement your page with appropriate Web

resources. Plus it’s always fun to look around at other relevant pages to learn new

things about your topic and create your own relevant Webliography.

Creatinga Linkwithin aPage

CreatetheTargetofthelink

96. Placeyourcursoratthetopofyourpage

97. ChooseInsert>>NamedAnchor.TheNamedAnchordialogboxwillappear.

98. IntheAnchorNamebox,typeanamefortheanchor.Thisshoulddescribethecontent in that

section of the page.

99. ClickOK.Ayellowanchorwillappearjustbeforethetext.Iftheyellowanchorsymbol does

not appear, then choose View >> Visual Aids >> Invisible Elements.

Create alinkto the anchor

100. Atthebottomofthepage,type“BacktoTop”.Highlightthistext.

101. On the Property Inspector, click on the point-to-file icon to the right of the Link field

and drag it to the schedule anchor symbol. (You literally click on it and, without

releasing the mouse, drag it over the anchor symbol in your Web page).

As the arrowhead moves over the anchor, the anchor name preceded by the pound

sign(#)willappearinthe linkfield.Theselectedtextisnowalink,andisunderlined with a

different text color.



Theformthatthistypeoflinkusesisdifferentfromastandardlink.Inthelinkfield,a

poundsignappearsfollowedbythenameoftheanchor.The#(poundsign)indicates that the

link is to an anchor on the Web page.

Note:WhenplanningyourWebsite,youwillneedtodecidehowtoorganizelinksbetween all the

pages.

Agoodpracticeistoplacelinkstootherpagesatthetopandthebottomofeachpage. Also, each

page should be linked to your home page (index.html).

PageLayoutwith Tables

We can use Tables to lay out the format of text and images. A table has rows and

columns and may be used for layout in a number of ways, including placing text or

images side by side on a page. In this section, you’ll make a table that shows the

Calendar dates and events for an Aardvark Sanctuary.

Create a Table

102. PlaceyourcursoratthetopofPage2.htmlafterthetext.Now,you’llinsertatablewith 3 rows

and 2 columns.

103. FromtheInsertmenu,chooseTable.TheTabledialogboxappears.

104. UnderTablesize,adjustthesettingsasfollows:

Rows=3

Columns=2

Table width = 75 %

Borderthickness=115

105. ClickOK.Thetablewillappearonyourpage.

106. Placeyourcursorintheupper-leftcellofthetableandtype:“ScheduleofEvents”

107. Onthesecondrow,intheleft-handcelltype:Date



108. Pressthe[Tab]keytomovetothenextcellinthetable.



109. Type:Event

110. Pressthe[Tab]keyagaintomovetothenextrow.

111. Type in a date. Move to the next cell, and type in a description of an event. As you

type in a long paragraph, the words wrap within a cell.

112. PresstheTABkey,andanewrowisautomaticallyaddedtothetable.Enterthedate and event

description in the fourth row.

MergeCells

We want the Schedule of Events to be centered across the entire table. To do that, we

first need to merge the two top cells in the table.

113. Clickanddragyourcursorfromlefttorightacrossrow1.↔ou’llnowmergethosetwo cells

into one.

114. Choose Modify >> Table >> Merge Cells. Now, in row 1, you should see one large

cell.

Insert anImage

115. Place your cursor in the right-hand cell of the last row. Press the [Tab] key to add a

new row.

116. Placeyourcursorintheright-handcellofthatnewrow.ChooseInsert>>Image.The Select

Image Source dialog box appears.

117. Navigate to an image – either one you’ve downloaded and is on your flash drive or

one from my Web site that you can download.

118. ClickOK.Theimageyouchosewillappearinthetablecell.

Addanewrowtothetable.

Afteryouhavecreatedatable,youmayneedtoaddinformationinthemiddleofthetable. You can



add rows or columns to expand the table.



119. Clickinthethirdrowofyourtable.

120. ChooseModify>>Table>>InsertRow.

Anewrowappearsinthetable.

121. Click in the second column of the new row and insert another image (your choice).

The image appears in the cell.

122. Clickinthecelltotheleftoftheimageandtypesomerelevantinformationinthecell.

Delete arow

Thetablecanalsobeadjustedbyremovingunnecessaryrowsorcolumns.

123. Clickinthesecondrowofyourtable.

124. From the Modifymenu, choose Table, and then choose Delete Row. The rowand its
contents are deleted. Table

Resizecolumnsandrows

Dependingonthecontentyouaddtoyourtableyoumightfindthatcolumnsaretoowide or narrow.

Youcanadjustthecolumnwidthtobetterfitthecontentinyourtable.

125. Placethecursoroverthelinedividingthecolumns.Thecursorturnsintoatwoheaded arrow.

126. Clickanddragthetwo-headedarrowtowardtherighttothemiddleofthetable.The columns
are re-sized.

127. Placethecursorovertherightsideofthetable.Clickanddragthetwo-headedarrow to resize
the table again.

128. Saveandpreviewthepage.

Try changing the size of the browser window. Notice that the table size changes as
thebrowserwindowsize changes –why? The reasonthetable sizeisnot constant is
because the widthof the table isexpressedas apercentageof the totalwidth of the
browserwindow,inthiscase,75%.Ifyouwishtolockthetabletoaspecificsize,you have to
express the table dimensions differently.

Table dimensions can also be expressed as fixed using “pixels”. A pixel is a single
point in a graphic image. Screens are divided into thousands (or millions) of pixels,
arranged in rows and columns. On a 17 →eb page, a recommended pixel size for a
table’s width would be no higher than 600. (Assuming a screen resolution of 800 x
600).



When your table is selected, youcanview andchange the table widthontheProperty
Inspector.

Experimentwith cellcolor andother options

129. Toaddbackgroundshadingtoacellorrow,selectthecell(s)andclickonthebottom corner of
the Bg color box on the Property Inspector

130. Clickonaswatchwiththeeyedroppertochooseacolor.

131. Try various formatting options for the rest of the table using the Property Inspector.
Change the size, coloror style of the text, and trythe alignment options.

132. Saveyourworkandpreview.

LANGUAGEC&C++

PROGRAMMINGLANGUAGE C
WhyweuseLanguage?

Weuselanguageduetofollowingreasons:
 Itstoresdata
 Howtointeractbetweeninputandoutput
 Theoperatorusestotransformandcombinedata.

WhatisC?

By 1960 languages come into existence. COBOL was being used for commercial
purposes, FORTRAN for Engineering and Scientific applications. An International
committee was setup to develop languages. This committee came out with a language
called ALGOL60. ALGOL-60 never really became popular because it seemed tooabstract,
too general. To reduce the abstractness and generality a new language called
Combined Programming Language (CPL) was developed at Cambridge University. CPL
wasan attempttobringALGOL60newversion,butCPL turnedouttobe sobig,having so many
features, that it was hard to learn and difficult to implement. BCPL (Basic Combined
Programming Language) developed by Martin Richards at Cambridge University aimed
to solve this problem by bringing CPL down to its basic good features.
Butunfortunatelyitturnedtobelesspowerfulandtoospecific.DennisRitchieinheritthe features
of CPL and BCPL and made a language named C. C forms the basis for many advanced,
highly powerful and effective programming languages. C is a programming language
developed at AT&T’s Bell Laboratories of ←SA in 1972. It was designed and
writtenbyamannamedDennisRitchie.InthelateseventiesCbegantoreplacethemore familiar
languages of that time like PL/I, ALGOL etc. No one pushes C. C seems so



popular,becauseitisreliable,simpleandeasytouse.TheconceptofCderivesitsorigin



from a primitive form of C which was called Basic Combined Programming Language
(BCPL) developed by Ken Thompson of Bell Laboratories which he referred to as ‘B’. By
now it might not be difficult to guess that a name as cryptic as C was conferred to it
because it was considered to be a modified more adaptive successor of “B”. C’s
compactness and coherence is mainly due to the fact that it’s a one man language.

CBasics

BeforeweembarkonabrieftourofC'sbasicsyntaxandstructureweofferabriefhistory of C and
consider the characteristics of the C language.

In the remainder of theChapter we will look at thebasic aspects ofC programs suchas C
program structure, the declaration of variables, data types and operators. We will
assume knowledge of a high level language, such as PASCAL.

ItisourintentiontoprovideaquickguidethroughsimilarCprinciplestomosthighlevel languages.
Herethesyntaxmay be slightlydifferentbutthe concepts exactlythe same.

Cdoes haveafewsurprises:

• Many High level languages, like PASCAL, are highly disciplined and
structured.

• Howeverbeware--Cismuchmoreflexibleandfree-wheeling.Thisfreedom gives
C much more power that experienced users can employ. The above
example below (mystery’s) illustrates how bad things could really get.

CharacteristicsofC
Webrieflylist some ofC's characteristicsthatdefine thelanguageand also have leadto its
popularity as a programming language. Naturally we will be studying many of these
aspects throughout the course.

• Smallsize
• Extensiveuseoffunctioncalls
• Loosetyping--unlikePASCAL
• Structuredlanguage
• Lowlevel(Bitwise)programmingreadilyavailable
• Pointerimplementation-extensiveuseofpointersformemory,array, structures

and functions.

C has nowbecomeawidelyusedprofessional languagefor various reasons.

• Ithashigh-levelconstructs.
• Itcanhandlelow-levelactivities.
• Itproducesefficientprograms.



• Itcanbecompiledonavarietyofcomputers.



Featuresof C

LowLevelLanguageSupport ProgramPortability

PowerfulandFeatureRich BitManipulation

HighLevelFeatures ModularProgramming

EfficientUseof Pointers

FeaturesofCProgrammingLanguage:
CProgrammingiswidelyusedinComputerTechnology;WecansaythatCProgramming is
inspiration for development of other languages. We can use C Programming for
different purposes. Below is some of the Features of C Programming language -



1. LowLevelFeatures:



1. C Programming provides low level features that are generally provided by the
Lower level languages. C is Closely Related to Lower level Language such as
“Assembly Language“.

2. ItiseasiertowriteassemblylanguagecodesinCprogramming.

2. Portability:

1. C Programs are portable i.e. they can be run on any Compiler with Little or no
Modification

2. CompilerandPreprocessormakeitPossibleforCProgramtorunitonDifferentPC

3. Powerful

1. Provides→ideverityof‘DataTypes‘
2. Provides→ideverityof‘Functions’

3. ProvidesusefulControl&LoopControlStatements

4. Bit Manipulation

1. C Programs can be manipulated using bits. We can perform different operations at
bit level. We can manage memory representation at bit level.

2. It provides wide verity of bit manipulation Operators. We have bitwise operators to
manage Data at bit level.

5. HighLevel Features:

1. It is more Userfriendlyas comparetoprevious languages. Previouslanguages such as
BCPL, Pascal and other programming languages never provide such great features
to manage data.

2. Previous languages have theirpros and consbut CProgrammingcollectedalluseful
features of previous languages thus C become more effective language.

6. ModularProgramming
1. Modular programming is a software design technique that increases the extent to

which software is composed of separate parts, called modules
2. CProgramConsistofDifferentModulesthatareintegratedtogethertoformcomplete

program

7. EfficientUseofPointers

1. Pointershavedirectaccesstomemory.

2. CSupportsefficientuseofpointer.



C Program Structure

ACprogrambasicallyhasthefollowingform:

• PreprocessorCommands
• Typedefinitions
• Functionprototypes--declarefunctiontypesandvariablespassedto function.
• Variables
• Functions

Wemusthaveamain()function. A

function has the form:

typefunction_name(parameters)
{

localvariables

CStatements

}

If the type definition is omitted C assumes that function
returns an integer type. NOTE: This can be a source of problems in a program.

SoreturningtoourfirstCprogram:

/*Sampleprogram*/

NOTE:

main()
{

printf(``ILike Cn'');
exit ( 0 );

}

• Crequiresasemicolonattheendofeverystatement.
• printfisastandardCfunction--calledfrommain.
• nsignifiesnewline.Formattedoutput--morelater.
• exit() is also a standard function that causes the program to terminate.

Strictlyspeakingitisnotneededhereasitisthelastlineofmain()andthe program



will terminate anyway.



Letuslookatanotherprintingstatement:
printf(``.n.1n..2n...3n'');The

output of this would be:

.

.1
..2
...3

C Keywords

Keywordsarethesetofpredefinedwordswhosefunctionalityhasbeenexpressedtothe
compiler and whenever called upon they furnish their task with utmost comfort. The
keywords cannot be used for any function other than what it is defined for, not even as
variablenames.Thiscodeofconductitwillresultingivinganewmeaningtothekeyword,
whichisnotpermissiblebythecomputer.Thereare32keywordsinCwhichareusedat various
points in a program to launch the proficiency of the language.

C Instructions

Thedifferenttypes ofconstants,variables and keywords thenext logical stepisto learn
howtolearntheyarecombinedtoforminstructions.Therearefourtypesofinstructionin C:

 Type DeclarationInstruction
 Input/Output Instruction
 ArithmeticInstruction
 Control Instruction

Type Declaration Instruction: We can declare the type of variables used in C Program
by using this instruction. Any variable used in a program must be declared before using
itanystatement.ThetypedeclarationstatementusuallywrittenatthebeginningoftheC
program.

int EmpCode; float
Bsalary;
charEmpName

Input/OutputInstruction:We can perform the function of supplying input data to a
program and obtaining the output results from it.
Arithmetic Instruction: We can perform arithmetic operations between constants and
variables.
Control Instruction:Wecancontrolthesequenceofexecutionofvariousstatementsin a C
program.

Variables



Aprogramismadeofdataandinstructionstomanipulatethosedata.Notethatdatahave to be
stored somewhere, and thus will need some memory space in the RAM.

A variable is an entity that is used to store data. Without variables, there is no way (or
actually NO PLACE) to store data. A variable has

 aname(morespecificallyasymbolicname)
 anassociatedphysicalmemoryspace(portioninaRAM)
 adatatype
 avalue(dependsondata type)
 ascope
 a lifetime

Howdoyoudeclareavariable?

InC,thesyntaxfordeclaringavariableisasfollows:

<variablename>

Thesymbol<item>meansthatitisrequiredtospecifytheitemenclosedwithinapairof angled
brackets.A semicolonsignifiestheend of adeclaration.Amissingsemicolon will cause the
compiler to generate a syntax error. Variables should be named following the C naming
conventions.

Example:char

ch;

inti;float f;

double d;

It is possible to declare several variables of the same type on the same line. In such
a case, a comma should be inserted between two variables. A missing comma will
generate a syntax error.

Example:

charch1,ch2; int

x, y, z;

floathourly_rate,number_of_hours,salary;double

numerator, denominator;



BasicDataTypes
The languages of C support several types of Data, each of which is represented in a
variedmannerwithinthememory.Thedatainthememorycanbeof integertypeorof character
type or of integer with decimal points. Whenever an integer or a character is
usedinaprogramthecomputershouldbeabletoidentifywheretostoreitinthememory.
Thebasicdatatypesaredepictedinatabularformattogetabetterunderstandingofthe basics of
C programming.

DataTypeDescription Memory Range Format
Requirement Specifier

Int whole numbers 2 bytes -32768 to %d,%i
long - 4 bytes +32767 %ld

Char Characters 1Byte 0to255 %c,%s

Float Numbers with 4 Bytes 1.0E-37 to %f
Decimals 1.0E+37

Double Numberswith 8Bytes 1.7E-308to %lf

Int: The particular data type deals in storing only whole integer numbers and they are
incapableofdealingwithfractionsornumberwithdecimals.Thenumberwhichtheycan deal
with a range from -32768 to +32767. An int requires 2 bytes of memory by most
computers.

Char : Thechardatatypeholdsindividualcharactersoralphabetsandtheyrequireonly 1 byte
of memory. Most compilers permits a range of0 to 255 regarding the char data type.

Float:Afloatdatatypeisinvolvedinrestoringfloatingpointnumbersortoputitsimply,
itisusedtostorenumberswithdecimalpoint.Thefloatdesires4bytesforstorageand has a
fractional precision of 6 digits.

Double : A double data type is also used for the restoration of floating point numbers.
Thedifferenceliesintheprecisionandstoragespace.Doubleoffersagreatprecision,of
about15digitsandcompilerrequires8bytestostoreadouble.Therangeswithinwhich the float
can be represented are 1.7 E - 308 to 1.7 E + 308 resp.

QualifiersUsedWithBasic Data Types

To expand the horizon of the basic data types, making it more flexible and adaptable to
getintovarioussituationswithprecisenessandaccuracy.Thequalifiertaggedtothedata types
are LONG, SHORT, SIGNED AND UNSIGNED. To make any data type a qualifier, the
name of the qualifier has to be tagged before the data type.

Long :As the name suggests the qualifier long extended the range of the data type to
whichitisprefixed.Itcanbeappliedtoonlytheintanddoubledatatypesanditexpands
thespectrumofrangefromamaximumof2,147,483,647to-2.147,483,647.Alongint



requiresmemorythatismorethananordinaryintandthereforetakes4bytesforstorage. To
make an integer a long qualifier just addsthe word long before it.

Short:Thisqualifierismostinterestingbecauseifanordinaryinthasthesamememory value
asthatof longi.e. 4bytesa shortwillhave 2 bytes,butif anint hasmemoryof 2 bytes a short
will have the same memory i.e. 2 Bytes.

Signed:By using signed data qualifier that data type can accommodate both positive
andnegativenumbers.Whenavariableissignedithasthesamepositiveandnegatives range as
a regular int. By default an int is a signed data type.

Unsigned:The qualifier unsigned is tagged mostly to int and it also has the same

memory requirement as that of ordinary int i.e. 2 bytes. Unsigned integer have a range

from 0 to 65535.Constants
ANSI C allows you to declare constants. When you declare a constant it is a bit like a

variabledeclarationexceptthevaluecannotbechanged.Theconstkeywordistodeclare a

constant, as shown below:

intconsta=1;const int
a =2;

Note:

 You can declare the const before or after the type. Choose one an stick to
it.

 Itisusualtoinitializeaconstwithavalueasitcannotgetavalueanyother way.

The preprocessor #define is another more flexible (see Preprocessor Chapters) method
to define constants in a program. You frequently see const declaration in function
parameters. This says simply that the function is not going to change the value of the
parameter.Thefollowingfunctiondefinitionusedconceptswehavenotmet(seechapters
onfunctions,strings,pointers,andstandardlibraries)butforcompletenesofthissection it is
included here:

voidstrcpy(char*buffer,charconst*string)

The second argument string is a C string that will not be altered by the string copying
standard library function.

Operators inC :

Operatorscanbrieflybedefinedasthetoolsusedforsolvingvariousmathematical,
conditional,relationalandlogicalproblems.Theoperatorsthatyouwillbedealingwith



are arithmetic operators, unary operators, relational and logical operators. The items in
between which the operators are placed are called operands.

Arithmeticoperators:
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed

+ Addition

- Subtraction

* Multiplication

/ Division

% (Modulus)Findsthe remainder
UnaryOperators:
Therearetwotypesofunaryoperators:-

 Theincrementoperator(denotesas‘++’)
 Thedecrementoperator(denotes as‘--’ )

Whentheincrementoperatorisprefixedtoavariablewhichholdsanintegeritincreases
thevalueofthenumberbyone.Similarlythedecrementoperatordecreasesthevalueby one.

RelationalandLogicalOperators:

Operators Significance

< Lessthan

<= Lessthanorequalto

> Greaterthan

>= Greaterthanorequalto

EqualityOperators Significance

== Equalto

!= Notequalto

LogicalOperators Significance

&& And



|| Or

! Not

Assignmentis=i.e.i=4;ch=`y';

Increment ++,Decrement --whicharemoreefficientthantheirlonghandequivalents,
forexample:--x++ isfasterthanx=x+1.

The++and--operatorscanbeeitherinpost-fixedorpre-fixed.Withpre-fixedthevalueis
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

Intheexamplebelow,++zispre-fixedandthew--ispost-fixed: int
x,y,w;

main()
{
x=((++z)-(w--))%100;
}

Thiswouldbeequivalentto:

intx,y,w;

main()

{

z++;
x=(z-w)%100;
w--;

}

The%(modulus)operatoronlyworkswithintegers.Division/isforbothintegerandfloat
division.Sobecareful.Theanswerto:x=3/2is1evenif xisdeclaredafloat!!

RULE:Ifbothargumentsof/areintegerthendointegerdivision.

Somakesureyoudothis.Thecorrect(fordivision)answertotheaboveisx=3.0/2or
x=3/2.0or(better)x=3.0 /2.0.Thereisalsoaconvenientshorthandwaytoexpress



computationsinC.Itisverycommontohaveexpressionslike:i=i+3orx=x*(y+2) this
canwritten in C (generally) in a shorthand form likethis:



Whichisequivalentto(butmoreefficientthan)?

So we can rewrite i = i + 3 as i += 3 and x=x*(y+2)asx*=y+2.

NOTE:thatx*=y+2meansx=x*(y+2)andNOTx=x*y+2.

Comparison Operators

Totestforequalityis==

Awarning:Bewareofusing``=''insteadof``=='',suchaswritingaccidentally if

(i=j).....

ThisisaperfectlyLEGAL Cstatement(syntacticallyspeaking)whichcopiesthevaluein
"j"into"i",anddeliversthisvalue,whichwillthenbeinterpretedasTRUEif j isnonzero. This is
called assignment by value -- a key feature of C.

Notequalsis:!=

Otheroperators<(lessthan),>(graterthan),<=(lessthanorequals),>=(greaterthan or
equals) are as usual.

Pointers

Csupportstheuseofpointers,atypeofreferencethatrecordstheaddressorlocationof an object
or function in memory. Pointers can be dereferenced to access data stored at the
address pointed to, or to invoke a pointed-to function. Pointers can be manipulated
usingassignmentorpointerarithmetic.Therun-timerepresentationofapointervalueis
typicallya rawmemoryaddress (perhapsaugmented byan offsetwithin-word field),but
since a pointer's type includes the type of the thing pointed to, expressions including
pointers can be type-checked at compile time. Pointer arithmetic is automatically scaled
bythesizeof thepointed-todatatype.Pointersareusedformanydifferentpurposesin
C. Text strings are commonly manipulated using pointers into arrays of characters.
Dynamic memory allocation is performed using pointers.



StatementsinCLanguage
Cneedssomekindofmanagerialsystemwhichinstructsthecomputerwhatfunctionhas
tobeperformedatwhichtime.Thecontrolstatementactasamanager.Youwillamaze at the
functions the different control statements handle. For example in a program you may
have a statement in which a multiplication operation is to be performed and in the next
an addition operation and after the next line there may be a statement which may
wantitselftoberepeated8timesandanotherstatementmaylikeitselftobeskippedand
attendedtoatalaterstage.Alltheseconditionsaremanagedbythecontrolstatements.

Thesequencecontrolstructureisoneofthebasicuncomplicatedcontrolstatements.The idea is
very simple. In the sequence control instructions the statements to be executed are
done so in a serial manner one after the other. The C compiler first executes the
openinglineandthenmovesontothenextandsoon.Inaserialfashionandthe entire program is
executed in this manner.

ConditionalStatement
C program executes program sequentially. Sometimes, a program requires checking of
certainconditionsinprogramexecution.Cprovidesvariouskeyconditionstatementsto check
condition and execute statements according conditional criteria. These statements are
called as 'Decision Making Statements' or 'Conditional Statements’.
FollowingsarethedifferentconditionalstatementsusedinC:

1. If Statement
2. If-ElseStatement
3. NestedIf-ElseStatement
4. Switch Case

IfStatement:Theifstatementcanbeusedtotestconditionssothatwecanaltertheflow of a
program. Code:

#include<stdio.h>in
t main()

{
intmark;charpass;
scanf("%d",&mark);
if (mark>40)pass
="y";return0;

}

If-Else Statement: Theifstatementfirsttestsifaconditionistrueandthenexecutesan instruction and
the else is for when the result of the condition is false. Code:

#include<stdio.h>int
main()



{



intmark;charpass;
scanf("%d",&mark);
if(mark>40)
{

}
else
{

}

pass = "y";
printf("Youpassed");

pass="n";printf("You failed");

return0;
}

The SwitchStatement: Theswitchstatementisjustlikeanifstatementbutithasmany
conditions and the commands for those conditions in only 1 statement. It is runs faster
thananifstatement.Inaswitchstatementyoufirstchoosethevariabletobetestedand
thenyougiveeachoftheconditionsandthecommandsfortheconditions.Youcanalso
putinadefaultifnoneoftheconditionsareequaltothevalueofthevariable.ForLoop, While
Loop, Break and Continue
Controlstructuresarebasicallyofthreetypes–

• Sequence statements
• Iterativestatements
• Selectionstatements

Sequence Statements : All the State in a program except the iterative & statements.
They are generally the individual statements which perform the task of input, output,
assignment declaration etc.

IterativeStatementisthoserepeatedexecutionofaparticularsetofinstructionsdesired
numberoftimes.Thesestatementsaregenerallycalledloopsfortheirexecutionnature.

TypesofLoopingStatements:

Basically, the types of looping statements depend on the condition checking mode.
Condition checking can be made in two ways as : Before loop and after loop. So, there
are 2(two) types of looping statements.

• Entrycontrolledloop
• Exitcontrolledloop

1. Entrycontrolled loop :



Insuchtypeofloop,thetestconditionischeckedfirstbeforetheloopisexecuted.



Somecommonexamplesofthisloopingstatementsare:

• while loop
• forloop

2. Exitcontrolledloop:

In such type of loop, the loop is executed first. Then condition is checked after block of
statements are executed. The loop executed at least one time compulsorily.

Somecommonexampleofthisloopingstatementis:

do-whileloop

InClanguagetheiterativestatements(loops)canbeimplementedinthethreeloopsand they are

The For Loop Syntax-

for(initialization;condition; incrementation)
{

bodyofloop
}

ForLoopwillperformitsexecutionuntiltheconditionremainssatisfied.If thebody of the
loop consists of more than one statement then these statements are made compound
by placing the open and closed curly brackets around the body of the loop. For loop is a
count loop. The initialization condition and incrementation may be done in the same
statement. For loop will not execute at least once also if the condition is false at the
first time itself.

TheWhileLoop
Syntax–

Initialization;
While(condition)

{
Body of loop;

Incrementation;
}

In this loop, initialization, condition and incrementation is done in the three different
statements.This loopsis count as wellas event loop. In caseof while loops the bodyof
theloopwillconsistofmorethanonestatementbecauseeachtimeonestatementwillbe of
incrementation. Hence the open and closed curly brackets are required.



Do-While LoopStatement:

ThethirdloopstatementavailableinCisdo-whilestatementsyntax:-Initialization;
Do
{
Body of loop;
Incrementation;
}while(condition)

AnintroductiontoArrays

The concept of arrays depends on other data types, which was meant to facilitate the
storage of abundant amount of number and wasting an entire delivery of space in the
memory.Itwouldbelikebuyingtwodozenbooksandultimatelyusingoneanddumping
therestinthegarbage.Arrayscanbedefinedasacollectionofsimilarelements.Anarray of
elementscanbe formedonlyif alltheelementsareofoneparticulardatatypei.e.all
ofthemareeitherintegerorcharacterorafloatingpointnumber,buttherecannotexist an array
which hosts an combination of these data types.

Advantageof Arrays

Theusageofarraysiscrucialtoanyprofessionalprogramming.Arraysjustmakethelife of
aprogrammerabiteasier.Itrelieveshimof aburdenof havingtokeepnamingthe variables. An
array is a single variable holdingmultiple data. Each data is referred to by
itselementnumber,Ifforinstance,youwishtostorealistofItemsyoucouldjustname the
variable ‘item_code’ and keep storing the data byreferring to item_code (1), item_code
(2),item_code (3),.........................etc.

ArrayDeclaration
Like other variables an array needs to be declared so that the compiler will know what
kindofanarrayandhowlargeanarraywewant.Inourprogramwehavedonethiswith the
statementint sal [20] ;
Hereintspecifiesthetypeof thevariable,justasitdoeswith ordinaryvariablesandthe word
salspecifies the nameof the variable. The [20] howeveris new. Thenumber20 tells
howmanyelements of the type int will be in ourarray. This numberis often called
the“dimension”ofthearray.Thebracket([])tellsthecompilerthatwearedealingwith an array.

TypesofArrays

Thearrayisdividedintotwoparts:

 SingleDimensionalArrays
 MultidimensionalArrays

SingleDimensionalArrays:

The single dimensional arrays as the name suggested, handles only a single advance of



similarelements.Thatistosayyoucanonlyhaveonerowofelementsandthesizeofa



single dimensional array depends on the programmer. Basically the single dimensional
arrays facilitate the accommodation of many similar elements in a single variable. The
succeedingsectionsafterwhichyouwillhaveacloudlessviewofthesingledimensional arrays.

MultidimensionalArrays:

Themultidimensionalarraysaretwoormorearraysclubbedtogether.Theycanbeoftwo
dimensional type or three dimensional types or more, but you can restrict the research
only to two and three dimensional arrays. An example of the two dimensional arrays is
the matrix because like the matrix the two dimensional arrays have two matrices one
symbolizingtherowelementsandtheotherthecolumnelements.Thethreedimensional array
is a shade different because the first arraylist the number of tables of the two
dimensionalarrays.Therestofthetwoarraysaresimilartothetwodimensionalarrayin the
sensethat one isfor the rowand the other is for the column.

ArrayInitialization

The initial step of declaring of an array is done. You have given it a variable name and
also declared its size but upto this stage the array is empty. It is like a box without any
book in it. Similarly declaration of variable is done but some values have to be passed
into it. You must be aware of initializing ordinary variables but how do you initialize an
array in which more than one value has to be initialized into one array variable.

EnteringData intoan Array:
Youhavedeclaredanarraybygivingitaspecificnameandsizeyoucantryandexplore the
individualities of each element in the array, that is to say how each element is
addressed in an array. Array element indexing always start with 0.
Number[ 0 ] 1st element
Number[ 1 ] 2ndelement
Number[ 2 ] 3rd element
Number[ 3 ] 4th element
Thismeansthat[0]willholdthefirstvalue,[1]thesecond,[2]thethird&soonIfyou
wanttoaccessthefourthelementofthearray“sal”youhavetowritesal[3].

Cdescribestwodistinct methods:

a) Static Initialization
b) DynamicInitialization

Static:

Thearrayonceinitializedinthiscannotbealteredbytheuser.Thismeansthateachtime
theprogram isexecuted,thesamevaluesareutilizedandtheycanbealteredonlyfrom
thecode.Itdoesn’trequiretheusertoinputvaluesforthearray.Thistypeofinitialization
isdoneatthetimeofthedeclarationofthearray.Thevaluetobeinsertedarementioned
inthebracesintsal[4]={101,102,103,104,105};
inta[2]={201,202,320};



Inthestaticinitializationthenumberofvaluestobeallocatedinmentionedinthesquare
bracketandtheelementismentionedinthecurlybraces.Theelementsareinitializedin a static
mode.

Dynamic:

In static initialization you noticed that the elements of the array are initialized while
declaringthearray,butthereisproblem.Ifyouwanttoalterthevaluesorifyouwantthe user to
supply the values then static initialization will turn out to be a raw thing. That is
wheredynamicinitializationtakescontrolofthereigns.Theusercanbeallowedtoenter the
values of his choice into the array and when the program return the values are not
retainedandtheycoverthewayfornewvalues.Dynamicinitializationcanbedoneusing the For
Loop
for(i=0;i<=10;i++)

{
printf(“Entervalues“);

scanf(“%d”,&sal[i]);
}

Arrayinsidethe Memory
Theelementstoredinaserialorderortheyarestoredrandomly. int sal

[ 8 ] ;
Thestatementindicatesthatanarrayvariableistobecreatedwhichisofanintegerdata
typeandthearraycanhold8elements.Inthememory16byteswillbereservedbecause each
integer will be 2 Bytes long. The arrayis initializedwith some numbers, this array will
host some unrelated numbers. Once the arrayis initialized the elements are stored in a
continuous manner.

201 202 203 204 205 206 207 208

31123114311631183120312231243124
The number entered by the user is registered in a successive pattern and each element
takes 2 bytes. This is exactly how it represented in the memory of a computer. The
number below the element location is the address of the location and each element has
its unique address in the memory by which it is identified.

MultiDimensional Arrays:

Multi dimensional array requires separate brackets for each subscript. One dimensional
arrayhasapairofsquarebrackets,atwodimensionalarraywillhavetwopairsofsquare brackets,
three dimensional array three pairs of square brackets and so on.

TwoDimensionalArrays:

A two dimensional array can be visualized as an array below an array. Two dimensional
arrays will have two pairs of square brackets.
Syntax:-datatypearrayname[statement1][statement2]
The two dimensional array is often referred to as a matrix. The statement one and two
are the subscripts thatthe two dimensional array will hold. One will specifythe rowand
expression, two will specify the column and they indicate the number of array elements
associated with each subscript.



intA [4][2 ];



Column0 Column1
RowNo0 4200 10
RowNo1 6500 20
RowNo2 7850 30
RowNo3 3450 40

ThustheelementinA[0][0]willbe1000andtheelementA[3][3]willbe40.Therestof the
numbers can be figured by having a look at the above table. In the memory the
elementareplacedinasequentialpatternsuchthattheelement[0][0]willbefirstfollowed
bytheelementin[0][1]followedby[1][0]andsoon.

CharacterArrays
Cisalsoflexiblethatitextendsitsservicestocharacteralso.Itmeansthatarrayscanbe
formedusingevencharacters.Onesucharrayof charactersiscalledstring.A stringisa
collection of characters that are in a particular order.
charname[10]=“Ankush” ;
Inthe above example name is an array with an element holding capacity of 10 and it
holdsastringcalled“Ankush”Thefirstelementisstoredinthe[0]thpositionofthearray name.That
is, the alphabet A will stored in the [ 0 ] th position , nwill be in the [ 1 ] st position and
so on till [ 9]th element.
A doubt may arise that while the array can accommodate 10 values only 6 have been
entered. What happens to the rest? Since only 4 values have been accommodated the
7th value will be a null character ( \0 ) which represents the end of the string. This will
placedautomaticallyattheendofthestringifanyofthearrayindexesarevacant.Ablank space
cannot exist between any two characters while taking input from the user unless
accompanied by a specific format specifier.

Strings

Agroupofintegerscanbestoresinanintegerarray.Similarlyagroupofcharacterscan
bestoredinacharacterarray. Characterarrayaremanyatimealsocalledstrings.Most
languagesinternallytreatstringsascharacterarrays,butsomehowconcealthisfactfrom the
programmer. Character arrays or strings are used by programming languages to
manipulate text such as words and sentences. A string constant is a one dimensional
arrayofcharactersterminatedbyanull(‘\0’)forexample,charname[]={‘I’,‘T’,’
T ’,’C’,‘O’,‘M’,’P ’, ’← ’, ‘T ’, ‘E ’, ‘R’,‘
\0’}
Eachcharacterinthearrayoccupiesonebyteofmemoryandthelastcharacterisalways ‘\ 0 ’.
→hat character is this? It looks like two characters, but it is actually only one
character,eitherthe \indicatingthatwhatfollows it is somethingspecial. ‘ \0 ‘is called
nullcharacter.Notethat‘\0’and‘0’arenotsame.ASCIIvalueof‘\0‘is0whereasASCII value of ‘0
‘is48It showsa waya characterarrayisstored in memory. Theelements
ofcharacterarrayarestoredincontiguousmemorylocations.Theterminatingnull(‘\0‘
)isimportant, because it isthe onlywaythe functionsthat work with a stringcan know
wherethestringcanknowwherethestringends.Astringnotterminatedbya‘\0‘isreally a string,
but merely a collection of characters.



WithCcompileralargesetofusefulstringhandlinglibraryfunctionsareprovided.



Function Use

strlen Findslengthofastring

strlwr Converts a string to lowercase

strupr Converts a String to Upper Case

strcat Appendsonestringattheendofanother

strcpy CopiesaString into Another

strcmp Comparestwostrings

strdup DuplicatingaString

strrev ReversingaString
strlen ( )

This function counts the number of characters present in a string.
void main ( )

{chararray[]=”Hello“,new[20];

intsize, size1, size2 ; printf(“Entera

String “ ); scanf ( “ %s ”,new ) ;

size = strlen ( array ) ;

size1=strlen(“

SoftBrainComputers “ );

size2=strlen(

new ) ;

printf(“\nLengthofstring%sare%d”,array,size);printf(“\nLengthofSecond string %s
are %d ” ,”SoftBrain

Computers”,size1);

printf(“\nLengthofThirdstring%sare%d“,new,size2); getch( ) ;

}

strcpy()

This function copies the contents of one string into another. The base addresses of the
source and target strings should be supplied to this function.
voidmain()

{
charsource[]=”SoftBrainComputers“;
chartarget[20],old[10],new[10];



printf(“EnteraString“);scanf(“%s”,



old ) ; strcpy ( target, source) ;
strcpy( new ,old ) ;

printf(“\nSourceStringare%sandtargetStringare%s“,source,target);
printf(“\nSecondSourceStringare%sandSecondtargetStringare%s“,old,new); getch ( ) ;

}
On supplying the base addresses strcpy ( ) goes on copying the characters in source
stringintotargetstringtillitdoesn’tencountertheendofsourcestring(‘ \0‘).Itisour
responsibilitytoseetoitthatthetargetstring’sdimensionisbigenoughtoholdthestring meal,
character by character.

strcmp ( )

This is a function which compares two strings to find out whether they are same or
different.Thetwostringsarecomparedcharacterbycharacteruntilthereisamismatch or end
of one of the strings is reached, whichever occurs first. If the two strings are identical,
strcmp ( ) returns a value 0. If they are not, it returns the numeric difference between
the ASCII values of the non-matching characters.

Function

A function is a self contained block of statements that perform a coherent task of some
kind. Every C program can be thought of as a collection of these functions. Sometimes
the interaction with this person is very simple sometimes it’s complex.
You have atask which isalways performedexactlyin the same way... saya servicingof
yourmotorbike.Whenyouwantittobedone,yougototheservicestationandsay“I’s time, do it
now↔ou don’t need to give instructions, because the mechanic knows his job. ↔ou
don’t need to be told when the job is done. ← assumes the bike would be serviced in
the usual way, the mechanic does.
AsimpleCfunctionwhichoperatedinmuchthesamewayasthe,mechanics.Wewillbe
lookingattwothingsaprogramthatcallsoractivatesthefunctionandthefunctionitself.
voidmain ( )

{message();
printf(“\nThanksafterreturnoffirstfunction“); getch

( ) ;
}
message()
{
printf(“\n→elcometothefirstfunctionprogram“);
}

Note:
AnyCprogram containsatleastonefunction.
Ifaprogramcontainsonlyonefunction,itmustbemain().
InaCprogramiftherearemorethanonefunctionspresent,thenone(andonlyone)of
thesefunctionsmust be main(),because program executionalways begins with main (
).
ThereisnolimitonthenumberoffunctionsthatmightbepresentedinaCprogram.Each
functioninaprogramiscalledinthesequencespecifiedbythefunction callsinmain( ).



After each function has done its things, control returns to main ( ).When main ( ) runs
out of function calls, the program ends.

Functions maybedivided into threecategories.

 Without argumentswithoutreturnvalue
 Withargumentswithoutreturnvalue
 Withargumentswithreturnvalue

Withoutargumentswithoutreturnvalue

For functions of this type neither the caller function nor the called function takes any
arguments. When a function is called the control jumps directly to the function and
executesthestatementsthatarespecifiedwithinthecalledfunction.Afterthestatement is the
called function isexecuted, the control returns to the mainprogram.

Withargumentswithoutreturnvalue

For function this the caller function transport some values to the called function or the
functiondefinitelywherethesevaluesareusedforsomespecificfunctionorcomputation but
once the computed value is found out within the called function the value is not
returned back to the caller function .

With argumentswithreturnvalue

In this type of functions the values as the arguments are being passed into the called
functions where theywill be computed and a definite result is relayed back to the caller
function and the valuewill be printed from there.

Advantageof Functions:

Aprogrammercanidentifywhateveractionsareperformedrepeatedlyonvariousparts of the
program, write them as a function and call the function from various part of the
programwheneverneeded.Thisapproachavoidscodeduplication.Insteadofduplicating
thesamecodeindifferentpartsoftheprogram,youjustwritethefunctiononceandcall it from
different parts of the program thus reducing the executable file size and redundancy of
code, making the maintenance of code easy.
In a multi tasking system like Unix there is a direct relationship between the amount of
memory a program consumes and the speed with which it runs You will in general find
that large programs which demand a lot of memory sluggish.
Breaking down your program into subroutines lends your program a structure. You can
divide your task into multiple sub-tasks, develop a function for each sub task, and
integratedthemintoasingleprogram.Onceafunctioniswrittenandcompletely tested,
aprogrammercanexpectittosmoothlyfitinwiththerestoftheprogrammodules.Once
afunctioniswritten,testedandfoundtobeworkingaspertheexpectations,thefunction
canbeloadedintoalibrary,andcanbeusedinanalltogether differentapplication.This approach
encourages code reusability.

Thetypesofvariablesare:
 LocalVariables



 Global Variables

LocalVariables:

The fact that main is a function and you can declare any number of variables within it.
Soif aruleholdsgoodforonefunctionwhycan’titforotherfunctions?Itdefinitelycan.
You can declare a variable inside any function belonging to any size and type. Thus
variables declared inside a function are called local variables and are valid and can be
used within that function. The life of these variables exists until they are within the
function. It is same as the value of particular variables in a program cannot exist for all
the programs. Anyattemptto breakthe rules will result an error.

Global Variables:

BeforeyoucanaccuseCofbeinginefficientincertainareasitpopsupwithanalternative. The
alternative for reducing the before mentioned problem is declaring the variables globally.
The globalvariables areotherwise called externalvariablesandunlikethe local
variableswhichareconfinedonlytothefunctionwhichhasthem,theglobalvariablescan
beusedanywhereintheprogramTheglobalvariablesaredeclaredoutsidethemaini.e. before
beginning the program and the values hold good throughout the program. The storage
for global variables is in a fixed region of memory set aside for this specific purpose by
the compiler. The effectiveness of declaring globally can be felt when many functions in
a program use the same data.
Defining a variable as global is particularly advantageous because its value is made
availabletoallotherfunctions.Buttheonlyriskfactorinvolvedinthisisthatifanyfunction
manipulates or alter the global variable than any other function using the same variable
at the same time gets the altered value.

Recursion in Functions

Recursioningeneraltermsmeansrepeatingitself.Arecursivefunctionisaprocesswhere
thefunctioncallsitselfrepeatedlyuntilaparticularconditionissatisfied.Itismorelikethe loop
conditions. But the difference lies in that each action or recursion is based in the result
of the previous one.
A recursive result triggers the recursive action for the next result until the condition is
satisfied.Foraproblemtobe solved recursivelytherearetwo conditionstobe satisfied. The
problem must be written in a recursive form, the recursion must have a condition which
seals the recursion.

Cprogramto checkoddor evenusingmodulusoperator

#include<stdio.h>m

ain()
{ intn;

Printf("Enteraninteger\n");
Scanf ("%d",&n);



if(n%2==0) Printf
("Even\n");
Else
Printf("Odd\n");

return 0; }

We can use bitwise AND (&) operator to check odd or even, as an example consider
binaryof 7 (0111)when we perform7& 1theresultwillbe oneandyou mayobserve
thattheleastsignificantbitofeveryoddnumberis1,so(oddnumber&1)willbeone always and
also ( even number & 1 ) is zero.

Cprogramtocheckodd orevenusingbitwise operator

#include<stdio.h>m

ain()
{ intn;

printf("Enteraninteger\n");
scanf("%d",&n);

if (n& 1==1 )
printf("Odd\n"); else
printf("Even\n");
return 0; }

Findodd oreven usingconditional operator

#include<stdio.h>m

ain()
{ intn;

printf("Inputaninteger\n");
scanf("%d",&n);

n%2==0?printf("Even\n"):printf("Odd\n"); return

0; }

Cprogramto checkodd orevenwithout usingbitwise ormodulus operator

#include<stdio.h>m



ain()



{ intn;

printf("Enteraninteger\n");
scanf("%d",&n);

if((n/2)*2==n)
printf("Even\n"); else

printf("Odd\n");

return 0; }

Incprogramminglanguagewhenwedividetwointegerswegetanintegerresult,For
exampletheresultof7/3willbe2.Sowecantakeadvantageofthisandmayuseitto
findwhetherthenumberisoddoreven.Consideranintegernwecanfirstdivideby2
andthenmultiplyitby2if theresultistheoriginalnumberthenthenumberiseven
otherwisethenumberisodd.Forexample11/2=5,5*2=10(whichisnotequalto
eleven),nowconsider12/2=6and6*2=12(sameasoriginalnumber).Theseare some logic
which may help you in finding if a number is odd or not.

Primenumberprogram inclanguage

#include<stdio.h>in

t main()
{
intn,i=3,count,c;

printf("Enter the number of prime numbers required\n");
scanf("%d",&n);

if(n>=1)
{
printf("First%dprimenumbersare:\n",n);
printf("2\n");

}

for(count=2;count<=n;)
{
for(c=2;c<=i-1;c++)
{ if(i%c

==0)
break;

} if(c
==i)
{

printf("%d\n",i);



count++;



}
i++;
}

return0;}

DownloadPrimenumberprogram.
Output of program:

C program for primenumberor not

#include<stdio.h>m

ain()
{
intn,c=2;

printf("Enteranumbertocheckifitisprime\n"); scanf("%d",&n);

for(c=2;c<=n-1;c++)
{
if(n%c==0)
{
printf("%disnot prime.\n",n);
break;

} }
if( c

== n )
printf("%disprime.\n",n);

return 0; }

C program for primenumberusing function



#include<stdio.h>



intcheck_prime(int);

main()
{
intn,result;

printf("Enteranintegertocheckwhetheritisprimeornot.\n"); scanf("%d",&n);

result = check_prime(n);

if(result==1 )
printf("%d is prime.\n", n);

else
printf("%disnotprime.\n",n);

return0;
}

intcheck_prime(inta)
{ intc;

for(c=2;c<=a-1;c++)
{
if(a%c==0)
return 0;

} if(c ==
a ) return
1; }

There are much logic to check prime numbers, one given below is more efficient
thenabove method.
for(c=2;c<=(int)sqrt(n);c++)
Onlycheckingfrom2tosquarerootofnumberissufficient.There are
much more efficient logic available.

PROGRAMMINGLANGUAGEC++
Introduction

Object-orientationisintroducedasanewprogrammingconceptwhichshouldhelpyouin
developinghighqualitysoftware.Somepeoplewillsaythatobject-orientationis
``modern''.Whenreadingannouncementsofnewproductseverythingseemstobe
``object-oriented''. ``Objects'' are everywhere. In this section we will try to outline
characteristicsofobject-orientationtoallowyoutojudgethoseobject-orientedproducts.
Roughly speaking, we can distinguish the learning curve of someone who learns to



program:



• Unstructuredprogramming,
• proceduralprogramming,
• modular programming and Object-orientedprogramming.

Unstructured Programming

Usually, people start learning programming by writing small and simple programs
consisting only of one main program. Here ``main program'' stands for a sequence of
commands or statements which modify data which is global throughout the whole
program.

Figure:Unstructuredprogramming.Themainprogramdirectlyoperatesonglobaldata.

Procedural Programming

Withproceduralprogrammingyouareabletocombinereturningsequencesofstatements
intoonesingleplace.Aprocedurecallisusedtoinvoketheprocedure.Afterthesequence is
processed, flow of control proceeds right after the position where the call was made

ModularProgramming

With modular programming procedures of a common functionality are grouped together
intoseparatemodules.Aprogramthereforenolongerconsists ofonlyonesinglepart.It
isnowdividedintoseveralsmallerpartswhichinteractthroughprocedurecallsandwhich form
the whole program.

Object-orientedprogrammingsolvessomeoftheproblemsjustmentioned.Incontrastto the
other techniques, we now have a web of interacting objects, each house-keeping its
own state.

Figure:Object-oriented programming. Objects of the program interact by sendi
messages to each other.



AbstractDataTypes

Someauthorsdescribeobject-orientedprogrammingasprogrammingabstractdatatypes
andtheirrelationships.ADTsareusedtodefineanewtypefromwhich instancescanbe
created.ADTsprovideanabstractviewtodescribepropertiesofsetsofentities;theiruse is
independent from a particular programming language.

Class
AclassisanactualrepresentationofanADT.Itthereforeprovidesimplementationdetails
forthedatastructureusedandoperations.WeplaywiththeADTIntegeranddesignour own
class for it:
class Integer { attributes:
inti

methods:
setValue(intn)
IntegeraddValue(Integerj)
}

Aclassis the implementation of an abstract data type (ADT).
Itdefinesattributesandmethodswhichimplementthedatastructureand operations

of the ADT, respectively. Instances of classes are called objects.
Consequently,classesdefinepropertiesandbehaviorofsetsofobjects.
Object

Objectsareuniquelyidentifiablebyaname.Thereforeyoucouldhavetwodistinguishable
objectswiththesamesetofvalues.Thisissimilarto``traditional''programminglanguages
whereyoucouldhave,saytwointegersiandjbothofwhichequalto``2''.Pleasenotice



theuseof``i''and``j''inthelastsentencetonamethetwointegers.Werefertothesetof values at
a particular time as the state of the object.

Definition (Object) Anobject isan instanceof a class. It can be uniquelyidentifiedbyits
name and it defines a state which is represented by the values of its attributes at a
particulartime.Thebehavior ofanobjectisdefinedbythesetofmethodswhichcanbe applied
on it.

Message

A running program is a pool of objects where objects are created, destroyed and
interacting. This interacting is based on messages which are sent from one object to
another asking the recipient to apply a method on itself. A message is a request to an
object to invoke one of its methods. A message therefore contains

the name of the method and
the arguments of the method.

Inheritance

With inheritance we are able to make use of the a-kind-off and are-a relationship. As
described there, classes which are a-kind-of another class share properties of the latter.
In ourpoint and circleexample, we can define a circle which inheritsfrompoint:

classCircleinheritsfromPoint{ att
ributes: int radius

methods:
setRadius(int newRadius)

getRadius()}

ClassCircleinheritsalldataelementsandmethodsfrompoint.Thereisnoneedtodefine them
twice:We just use already existing and well-known data and method definitions.

Definition (Inheritance) Inheritance is the mechanism which allows a class A to inherit
propertiesof a classB.Wesay``A inheritsfrom B''.Objects of classA thus have access to
attributes and methods of class B without the need to redefine them. The following
definitiondefinestwotermswithwhichweareabletorefertoparticipatingclasseswhen they use
inheritance.

Definition(Superclass/Subclass)IfclassAinheritsfromclassB,thenBiscalledsuper
classofA.AiscalledsubclassofB.Objectsofasubclasscanbeusedwhereobjectsof
thecorrespondingsuperclassareexpected.Thisisduetothefactthatobjectsofthe
subclasssharethesamebehaviorasobjectsofthesuperclass.



Figure:Asimpleinheritancegraph.

Multiple Inheritance

One important object-oriented mechanism is multiple inheritances. Multiple inheritances
do notmeanthatmultiple subclasses sharethe same super class.It alsodoes not mean
thatasubclasscaninheritfromaclasswhichitselfisasubclassofanotherclass.Multiple
inheritances mean that one subclass can have more than one super class. This enables
the subclass to inherit properties of more than one super class and to ``merge'' their
properties.

Figure:DeriveadrawablestringwhichinheritspropertiesofPointandString.

Definition (Multiple Inheritance) If class A inherits from more than one class, ie. A
inheritsfromB1,B2,...,Bn,wespeakofmultipleinheritance.Thismayintroducenaming conflicts
in A if at least two of its super classes define properties with the same name.

Inheritancebetweenclasses

AkeyfeatureofC++classesisinheritance.Inheritanceallowscreatingclasseswhichare derived
from other classes, so that they automatically include some of its "parent's"
members,plusitsown. Forexample, we aregoingto supposethatwe want todeclarea
seriesof classesthatdescribe polygonslike ourCRectangle,orlikeCTriangle.Theyhave
certain common properties, such as both can be described by means of only two sides:
height and base.



This could be represented in the world of classes with a class CPolygon from which we
would derive the two other ones: CRectangle and CTriangle.

Whatisinheritedfrom the base class?

Inprinciple,aderivedclassinheritseverymemberofabaseclassexcept:

 itsconstructoranditsdestructor
 its operator=() members
 itsfriends

Althoughtheconstructorsanddestructorsofthebaseclassarenotinheritedthemselves, its
default constructor (i.e., its constructor with no parameters) and its destructor are
always called when a new object of a derived class is created or destroyed.

AbstractClasses
With inheritance we are able to force a subclass to offer the same properties like their
super classes. Consequently, objects of a subclass behave like objects of their super
classes. Sometimes it make sense to only describe the properties of a set of objects
without knowing the actual behavior beforehand.

StaticandDynamic Binding

Instronglytypedprogramminglanguagesyoutypicallyhavetodeclarevariablespriorto
theiruse.Thisalsoimpliesthevariable'sdefinitionwherethecompilerreservesspacefor the
variable.Definition (Static Binding)If the typeT of a variable is explicitlyassociated with
its name N by declaration, we say, that N is statically bound to T. The association
process is called static binding.

Polymorphism
Polymorphismallowsanentity(forexample,variable,functionorobject)totakeavariety of
representations. Therefore we have to distinguish different types of polymorphism which
will be outlined here.

The first type is similar to the concept of dynamic binding. Here, the type of a variable
depends on its content. Thus, its type depends on the content at a specific time:

v:=123 /*visinteger*/ ...
/* use v as integer */v := 'abc' /*v
"switches" to string */... /*use
v as string */

Definition (Polymorphism) The concept of dynamic binding allows a variable to take
different types dependent on the content at a particular time. This abilityof a variable is



calledpolymorphism.Anothertypeofpolymorphismcanbedefinedforfunctions.For



example, suppose you want to define a function is Null () which returns TRUE if its
argument is 0 (zero) and FALSE otherwise.

Function templates

Functiontemplatesarespecialfunctions thatcan operate with generictypes. Thisallows
ustocreateafunctiontemplatewhosefunctionalitycanbeadaptedtomorethanonetype
orclasswithoutrepeatingtheentirecodeforeachtype.InC++thiscanbeachievedusing
template parameters. A template parameter is a special kind of parameter that can be
used to pass a type as argument: just like regular function parameters can be used to
pass values to a function, template parameters allow to pass also types to a function.
Thesefunctiontemplatescanusetheseparametersasiftheywereanyotherregulartype.

The format for declaring function templates with type parameters is: template <class

identifier>function_declaration;template<typenameidentifier>function_declaration;

Theonlydifferencebetweenbothprototypesistheuseofeitherthekeywordclassorthe keyword
typename.

Templatespecialization

If we want to define a different implementation for a template when a specific type is
passed as template parameter, we can declare a specialization of that template. For
example,let'ssupposethatwehaveaverysimpleclasscalledmycontainerthatcanstore
oneelementof anytype andthat ithasjustonememberfunction called increase,which
increases its value. But we find that when it stores an element of type char it would be
more convenient to have a completely different implementation with a function member
uppercase, so we decide to declare a class template specialization for that type.

Exceptions

Exceptionsprovideawaytoreacttoexceptionalcircumstances(likeruntimeerrors)inour
program by transferring control to special functions called handlers. To catch exceptions
we must place a portion of code under exception inspection. This is done by enclosing
that portion of code in a try block. When an exceptional circumstance arises within that
block, an exception is thrown that transfers the control to the exception handler. If no
exception is thrown, the code continues normally and all handlers are ignored.

Standard exceptions

The C++ Standard library provides a base class specifically designed to declare objects
tobethrownasexceptions.Itiscalledexceptionandisdefinedinthe<exception>header file
under the namespace std. This class has the usual default and copy constructors,
operators and destructors, plus an additional virtual member function called what that
returns a null-terminated character sequence (char *) and that can be overwritten in



derived classes to contain some sort of description of the exception.



TypeCasting

Convertinganexpressionof agiventype intoanothertypeisknownastype-casting.We have
already seen some ways to type cast:

Implicit conversion

Implicitconversionsdonotrequireanyoperator.Theyareautomaticallyperformedwhen a
value is copied to a compatible type.

Explicitconversion

C++isastrong-typedlanguage.Manyconversions,especiallythosethatimplyadifferent interpretation
of the value, require an explicit conversion.

Data Types

Table:Built-intypes.



ExpressionsandOperators

Expressions are combined of both terms and operators. The first could be constants,
variables or expressions. From the latter, C offers all operators known from other
languages. However, it offerssomeoperatorswhich couldbe viewed asabbreviationsto
combinations of other operators. In C almost everything is an expression. For example,
the assignment statement ``='' returns the value of its right-hand operand. As a ``side
effect''italsosetsthevalueof theleft-handoperand.Thus,ix=12;

sets the value of ix to 12 (assuming that ix has an appropriate type). Now that the
assignment is also an expression, we can combine several of them; for example:



kx=jx=ix=12;



What happens? The first assignment assigns kx the value of its right-hand side. This is
thevalueoftheassignmenttojx.Butthisisthevalueoftheassignmenttoix.Thevalue
ofthislatteris12whichisreturnedtojxwhichisreturnedtokx.Thuswehaveexpressed

ix=12;

jx=12;

kx=12;in

one line.

Statements

Cdefinesallusualflowcontrolstatements.Statementsareterminatedbyasemicolon``;''.
Wecangroupmultiplestatementsintoblocksbyenclosingthemincurlybrackets.Within each
block, we can define new variables:

{
inti; /*Defineaglobali*/ i

=1;/*Assignithevalue0*/{
/*Beginnewblock*/inti;/*
Definealocali*/i=2;/*Set its value to
2 */
} /*Closeblock*/

/*Hereiisagain1fromtheouterblock*/
}

Tableof Statements



Functions

AsCisaprocedurallanguageitallowsthedefinitionoffunctions.Proceduresare
``simulated''byfunctionsreturning``novalue''.Thisvalueisaspecialtypecalledvoid.

Functionsaredeclaredsimilartovariables,buttheyenclosetheirargumentsin parenthesis (even if
there are no arguments, the parenthesis must be specified):

intsum(intto);/*Declarationofsumwithoneargument*/ int
bar(); /*Declarationofbarwithnoarguments*/ void
for(int ix, int jx);

/*Declarationofforwithtwoarguments*/



Pointersand Arrays

One of the most common problems in programming in C++ is the understanding of
pointers and arrays. In C (C++) both are highly related with some small but essential
differences. You declare a pointer by putting an asterisk between the data type and the
name of the variable or function:

char*strp; /*strpis`pointertochar'*/

Youaccessthecontentofapointerbydereferencingitusingagaintheasterisk:

*strp='a'; /*Asinglecharacter*/

As in other languages, you must provide some space for the value to which the pointer
points.Apointertocharacterscanbeusedtopointtoasequenceofcharacters:thestring. Strings
in C are terminated by a special character NUL (0 or as char ',\0).

Arraysas parameters

Atsomemomentwemayneedtopassanarraytoafunctionasaparameter.InC++itis not
possible to pass a complete block of memory by value as a parameter to a function,
butweareallowedtopassitsaddress.Inpracticethishasalmostthesameeffectandit is a much
faster and more efficient operation.

Pointers

We have already seen how variables are seen as memory cells that can be accessed
usingtheiridentifiers.Thiswaywedidnothavetocareaboutthephysicallocationofour data
within memory, we simply used its identifier whenever we wanted to refer to our
variable.Thememoryofyourcomputercanbeimaginedasasuccessionofmemorycells, each
one of the minimal size that computers manage (one byte). These singlebyte memory
cells are numbered in a consecutive way, so as, within any block of memory,
everycellhasthesamenumberasthe previousoneplusone.Thisway,eachcellcanbe easily
located in the memory because it has a unique address and all the memory cells
followasuccessivepattern.Forexample,ifwearelookingforcell1776weknowthatitis goingto
be right between cells1775 and1777, exactlyone thousand cellsafter776and exactly one
thousand cells before cell 2776.

Referenceoperator (&)
As soon as we declare a variable, the amount of memory needed is assigned for it at a
specificlocationinmemory(itsmemoryaddress).Wegenerallydonotactivelydecidethe
exactlocationofthevariablewithinthepanelofcellsthatwehaveimaginedthememory tobe-
Fortunately,thatisataskautomaticallyperformedbytheoperatingsystemduring
runtime.However,insomecaseswemaybeinterestedinknowingtheaddresswhereour
variableisbeingstoredduringruntimeinordertooperatewithrelativepositionstoit.



Dereferenceoperator(*)



Wehavejustseenthatavariablewhichstoresareferencetoanothervariableiscalleda pointer.
Pointers are said to "point to" the variable whose reference they store. Using a pointer
we can directly access the value stored in the variable which it points to. To do
this,wesimplyhavetoprecedethepointer'sidentifierwithanasterisk(*),whichactsas
dereferenceoperatorand that canbe literally translated to "valuepointedby".

Nullpointer

A null pointer is a regular pointer of any pointer type which has a special value that
indicatesthatitisnotpointingtoanyvalidreferenceormemoryaddress.Thisvalueisthe result of
type-casting the integer value zero to any pointer type.

int*p;p=0;//phasanullpointer value

Do not confuse null pointers with void pointers. A null pointer isa value that anypointer
maytaketorepresentthatitispointingto"nowhere",whileavoidpointerisaspecialtype of
pointer that can point to somewhere without a specific type. One refers to the value
storedinthepointeritselfandtheothertothetypeofdataitpointsto.

Pointersto functions

C++ allows operations with pointers to functions. The typical use of this is for passing a
function asan argument to anotherfunction,since these cannotbe passed dereference. In
order to declare a pointer to a function we have to declare it like the prototype of the
functionexceptthatthenameofthefunctionisenclosedbetweenparentheses ()andan asterisk
(*) is inserted before the name:

C++Program

Hereweintroducethefirstprogramwhichissooftenused:aprogramwhichprints``Hello, world!''
to your screen:
#include <stdio.h>

/*Globalvariablesshouldbehere*/

/*Functiondefinitionsshouldbehere*/ int
main(){
puts("Hello, world!");

return 0;
}/*main*/



The first line looks something strange. Its explanation requires some information about
howC(andC++)programsarehandledbythecompiler.Thecompilationstepisroughly
dividedintotwosteps.Thefirststepiscalled``preprocessing''andisusedtoprepareraw C code.
In this case this step takes the first line as an argument to include a file called stdio.h
into the source. The angle brackets just indicate that the file is to be searched in the
standard search path configured for your compiler. The file itself provides some
declarationsanddefinitionsforstandardinput/output.Forexample,itdeclaresafunction called
put(). The preprocessing step also deletes the comments.

Constructor

With constructors we are able to initialize our objects at definition time as we have
requested it for our singly linked list. We are now able to define a class List where the
constructorstakecareofcorrectlyinitializingitsobjects.Ifwewanttocreateapointfrom another
point, hence, copying the properties of one object to a newly created one, we
sometimes have to take care of the copy process. For example, consider the class List
which allocates dynamically memory for its elements. If we want to create a second list
which is a copy of the first, we must allocate memoryand copy the individual elements.

Destructors

Consider a class List. Elements of the list are dynamically appended and removed. The
constructor helps us in creating an initial empty list. However, when we leave the scope
ofthedefinitionofalistobject,wemustensurethattheallocatedmemoryisreleased.We
thereforedefineaspecialmethodcalleddestructorwhichiscalledonceforeachobjectat its
destruction time:
voidfor(){

Listalist;//List::List()initializesto
//emptylist.
... //add/removeelements
} //Destructorcall!

Destruction of objects takes place when the object leaves its scope of definition or is
explicitly destroyed.The latter happens, when we dynamically allocate an object and
release it when it is no longer needed. Destructors are declared similar to constructors.
Thus, theyalso use the nameprefixed bya tilde (~) of thedefiningclass.

Identifiers

Valid identifiers are a sequence of one or more letters, digits or underscore characters
(_). Neither spaces nor punctuation marks or symbols can be part of an identifier. Only
letters, digits and single underscore characters are valid. In addition, variable identifiers
alwayshavetobeginwithaletter.Theycanalsobeginwithanunderlinecharacter(_), but in
some cases these may be reserved for compiler specific keywords or external identifiers,
as well as identifiers containing two successive underscore characters
anywhere.Innocasetheycanbeginwithadigit.Anotherrulethatyouhavetoconsider



wheninventingyourownidentifiersisthattheycannotmatchanykeywordoftheC++



language or your compiler's specific ones, which are reserved keywords. The standard
reserved keywords are:

asm, auto, bool, break, case, catch, char, class, const, const_cast, continue, default,
delete,

do,double,dynamic_cast,else,enum,explicit,export,extern,false,float,for,friend,goto,

if,inline,int,long,mutable,namespace,new,operator,private,protected,public,register,

reinterpret_cast,return,short,signed,sizeof,static,static_cast,struct,switch,template, this,

throw, true, try, typedef, typeid, typename, union, unsigned, using, virtual, void,

volatile, wchar_t, while.

Operators inC++

Operators can briefly be defined as the tools used for solving various mathematical,
conditional, relational and logical problems. The operators that you will be dealing with
are arithmetic operators, unary operators, relational and logical operators. The items in
between which the operators are placed are called operands.

Arithmeticoperators:
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed
+ Addition

Subtraction

* Multiplication

/ Division
% (Modulus)Findsthe remainder

UnaryOperators:
Therearetwotypesofunaryoperators:-

 Theincrementoperator(denotesas‘++’)
 Thedecrementoperator(denotesas‘--’)

Whentheincrementoperatorisprefixedtoavariablewhichholdsanintegeritincreases
thevalueofthenumberbyone.Similarlythedecrementoperatordecreasesthevalueby one.

RelationalandLogical Operators:



Operators Significance

< Lessthan

<= Lessthanorequalto

> Greaterthan

>= Greaterthanorequalto

EqualityOperators Significance

== Equalto

!= Notequalto

LogicalOperators Significance

&& And

|| Or

! Not

Assignmentis=i.e.i=4;ch=`y';
Increment ++,Decrement --whicharemoreefficientthantheirlonghandequivalents,
forexample:--x++ isfasterthanx=x+1.

The++and--operatorscanbeeitherinpost-fixedorpre-fixed.Withpre-fixedthevalueis
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

Comparison Operators

Totestforequalityis==

Awarning:Bewareofusing``=''insteadof``=='',suchaswritingaccidentally

if(i=j).....

ThisisaperfectlyLEGAL Cstatement(syntacticallyspeaking)whichcopiesthevaluein
"j"into"i",anddeliversthisvalue,whichwillthenbeinterpretedasTRUEif j isnonzero. This is
called assignment by value -- a key feature of C.

Notequalsis:!=

Otheroperators<(lessthan),>(greaterthan),<=(lessthanorequals),>=(greaterthan or equals)
are as usual.



Statements in C Language

Cneedssomekindofmanagerialsystemwhichinstructsthecomputerwhatfunctionhas
tobeperformedatwhichtime.Thecontrolstatementactasamanager.Youwillamaze at the
functions the different control statements handle. For example in a program you may
have a statement in which a multiplication operation is to be performed and in the next
an addition operation and after the next line there may be a statement which may
wantitselftoberepeated8timesandanotherstatementmaylikeitselftobeskippedand
attendedtoatalaterstage.Alltheseconditionsaremanagedbythecontrolstatements.

Thesequencecontrolstructureisoneofthebasicuncomplicatedcontrolstatements.The idea is
very simple. In the sequence control instructions the statements to be executed are
done so in a serial manner one after the other. The C compiler first executes the
openinglineandthenmovesontothenextandsoon.Inaserialfashionandtheentire program is
executed in this manner.

ConditionalStatement
C program executes program sequentially. Sometimes, a program requires checking of
certainconditionsinprogramexecution.Cprovidesvariouskeyconditionstatementsto check
condition and execute statements according conditional criteria. These statements are
called as 'Decision Making Statements' or 'Conditional Statements’.
FollowingsarethedifferentconditionalstatementsusedinC:

5. If Statement
6. If-ElseStatement
7. NestedIf-ElseStatement
8. Switch Case

IfStatement:Theifstatementcanbeusedtotestconditionssothatwecanaltertheflow of a
program. Code:

#include<stdio.h>in
t main()

{
intmark;charpass;
scanf("%d",&mark);
if (mark>40)pass
="y";

return0;
}

If-Else Statement: Theifstatementfirsttestsifaconditionistrueandthenexecutesan instruction and
the else is for when the result of the condition is false. Code:

#include<stdio.h>int
main()



{



intmark;charpass;
scanf("%d",&mark);
if(mark>40)
{

}
else
{

}

pass = "y";
printf("Youpassed");

pass="n";printf("You failed");

return0;
}

The SwitchStatement: Theswitchstatementisjustlikeanifstatementbutithasmany
conditions and the commands for those conditions in only 1 statement. It is runs faster
thananifstatement.Inaswitchstatementyoufirstchoosethevariabletobetestedand
thenyougiveeachoftheconditionsandthecommandsforthe conditions.Youcanalso
putinadefaultifnoneof theconditionsareequaltothevalueof thevariable.
For Loop, While Loop, Breakand Continue
Controlstructuresarebasicallyofthreetypes–

• Sequence statements
• Iterativestatements
• Selectionstatements

SequenceStatements:AlltheStateinaprogramexcepttheiterative&statements.They are
generally the individual statements which perform the task of input, output, assignment
declaration etc.

IterativeStatementisthoserepeatedexecutionofaparticularsetofinstructionsdesired
numberoftimes.Thesestatementsaregenerallycalledloopsfortheirexecutionnature.

TypesofLoopingStatements:

Basically, the types of looping statements depend on the condition checking mode.
Condition checking can be made in two ways as : Before loop and after loop. So, there
are 2(two) types of looping statements.

• Entrycontrolledloop
• Exitcontrolledloop

2.Entrycontrolled loop :



Insuchtypeofloop,thetestconditionischeckedfirstbeforetheloopisexecuted.



Somecommonexamplesofthese loopingstatementsare:

• while loop
• forloop

2.Exitcontrolledloop:

In such type of loop, the loop is executed first. Then condition is checked after block of
statements are executed. The loop executed at least one time compulsorily.

Somecommonexampleofthisloopingstatementis:

do-whileloop

InClanguagetheiterativestatements(loops)canbeimplementedinthethreeloopsand they are

The For Loop Syntax-

for(initialization;condition;incrementation)
{

bodyofloop }

ForLoopwillperformitsexecutionuntiltheconditionremainssatisfied.If thebody of the
loop consists of more than one statement then these statements are made compound
by placing the open and closed curly brackets around the body of the loop. For loop is a
count loop. The initialization condition and incrementation may be done in the same
statement. For loop will not execute at least once also if the condition is false at the first
time itself.

TheWhile Loop

Syntax–
Initialization;
While(condition)

{
Body of loop;

Incrementation;
}

In this loop, initialization, condition and incrementation is done in the three different
statements.This loopsis count as wellas event loop. In caseof while loops the bodyof
theloopwillconsistofmorethanonestatementbecauseeachtimeonestatementwillbe of
incrementation. Hence the open and closed curly brackets are required.



Do-While LoopStatement:

ThethirdloopstatementavailableinCisdo-whilestatementsyntax:-Initialization;
Do
{
Body of loop;
Incrementation;
}while(condition)

Overloadedfunctions.

InC++twodifferentfunctionscanhavethesamenameiftheirparametertypesornumber
aredifferent.Thatmeansthatyoucangivethesamenametomorethanonefunctionif
theyhaveeitheradifferentnumberofparametersordifferenttypesintheirparameters.

Inline functions.

Theinlinespecifierindicatesthecompilerthatinlinesubstitutionispreferredtotheusual
function call mechanism for a specific function. This does not change the behavior of a
function itself, but is used to suggest to the compiler that the code generated by the
functionbodyisinsertedateachpointthefunctioniscalled,insteadofbeinginsertedonly
onceandperforma regularcalltoit, which generallyinvolvessomeadditionaloverhead in
running time.

Recursively

Recursivelyisthepropertythatfunctionshavetobecalledbythemselves.Itisusefulfor
manytasks,likesortingorcalculatesthefactorialofnumbers.Forexample,toobtainthe
factorialofanumber(n!)themathematicalformulawouldbe:

n!=n*(n-1)*(n-2)*(n-3)...*1

Classesdefinedwithstructand union

Classes can be defined not only with keyword class, but also with keywords struct and
union.Theconceptsofclassanddatastructurearesosimilarthatbothkeywords(struct and
class) can be used in C++ to declare classes (i.e. struct can also have function
members in C++, not only data members). The only difference between both is that
membersofclassesdeclaredwiththekeywordstructhavepublicaccessbydefault,while
members of classes declared with the keyword class have private access. For all other
purposes both keywords are equivalent.

Theconceptofunionsisdifferentfromthatofclassesdeclaredwithstructandclass,since
unionsonlystoreonedatamemberatatime,butneverthelesstheyarealsoclassesand can thus



also hold function members. The default access in union classes is public.



Friendfunctions

In principle, private and protected members of a class cannot be accessed from outside
the same class in which they are declared. However, this rule does not affect friends.
Friends are functions or classes declared as such. If we want to declare an external
functionasfriendofaclass,thusallowingthisfunctiontohaveaccesstotheprivateand
protectedmembersofthisclass,wedoitbydeclaringaprototypeofthisexternalfunction within
the class, and preceding it with the keyword friend.

Preprocessor directives

Preprocessor directives are lines included in the code of our programs that are not
programstatementsbutdirectivesforthepreprocessor.Theselinesarealwayspreceded by a
hash sign (#). The preprocessor is executed before the actual compilation of code
begins, therefore the preprocessor digests all these directives before any code is
generated by the statements.

These preprocessor directives extend only across a single line of code. As soon as a
newlinecharacterisfound,thepreprocessordirectiveisconsideredtoend.Nosemicolon (;) is
expected at the end of a preprocessor directive. The only way a preprocessor
directivecanextendthroughmorethanonelineisbyprecedingthenewlinecharacterat the end
of the line by a backslash (\).

Macrodefinitions(#defines, #undef)

Todefinepreprocessormacroswecanuse#define.Itsformatis:

#define identifier replacement

When the preprocessor encountersthisdirective, it replaces any occurrence of identifier
in the rest of the code by replacement. This replacement can be an expression, a
statement, a block or simply anything. The preprocessor does not understand C++, it
simply replaces any occurrence of identifier by replacement.

Input/outputwithfiles

C++providesthefollowingclassestoperformoutputandinputofcharactersto/fromfiles:

 ofstream:Streamclasstowriteonfiles
 ifstream:Streamclasstoreadfromfiles
 fstream:Streamclasstobothreadandwritefrom/tofiles.

These classes are derived directly or indirectly from the classes’ istream, and ostream.
We have already used objects whose types were these classes: cin is an object of class
istream and cout is an object of class ostream. Therefore, we have already been using
classes that are related to our file streams. And in fact, we can use our file streams the
samewaywearealreadyusedtousecinandcout,withtheonlydifferencethatwehave to
associate these streams with physical files.



Openafile

Thefirstoperationgenerallyperformedonanobjectofoneoftheseclassesistoassociate
ittoarealfile.Thisprocedureisknownastoopenafile.Anopenfileisrepresentedwithin a
program by a stream object (an instantiation of one of these classes, in the previous
example this was myfile) and any input or output operation performed on this stream
object will be applied to the physical file associated to it. In order to open a file with a
stream object we use its member function open():

open(filename,mode);

Closing afile

When we are finished with our input and output operations on a file we shall close it so
thatitsresourcesbecomeavailableagain.Inordertodothatwehavetocallthestream's
memberfunctionclose().Thismemberfunctiontakesnoparameters,andwhatitdoesis to flush
the associated buffers and close the file:

myfile.close();

Oncethismemberfunctioniscalled,thestreamobjectcanbeusedtoopenanotherfile, and the
file isavailableagainto be opened byotherprocesses.In case thatan object is destructed
while still associated with an open file, the destructor automatically calls the member
function close().

Text files
Text file streams are those where we do not include the ios::binaryflag in theiropening
mode. These files are designed to store text and thus all values that we input or output
from/to them can suffer some formatting transformations, which do not necessarily
correspond to their literal binary value.

Checkingstate flags

In addition to eof(), which checks if the end of file has been reached, other member
functionsexisttocheckthestateofastream(allofthemreturnaboolvalue):

bad()

Returnstrueifareadingorwritingoperationfails.Forexampleinthecasethatwetryto
writetoafilethatisnotopenforwritingorifthedevicewherewetrytowritehasnospace left.

fail()

Returnstrueinthesamecasesasbad(),butalsointhecasethataformaterrorhappens, like when
an alphabetical character is extracted when we are trying to read an integer number.

eof()



Returnstrueifafileopenforreadinghasreachedtheend.

good()

Itisthemostgenericstateflag:itreturnsfalseinthesamecasesinwhichcallinganyof the
previous functions would return true.

Inordertoresetthestateflagscheckedbyanyofthesememberfunctionswehavejust seen we
can use the member function clear(), which takes no parameters.

getandputstream pointers

Alli/ostreamsobjectshave,atleast,oneinternalstreampointer:

Ifstream,likeistream,hasapointerknownasthegetpointerthatpointstotheelementto
bereadinthenextinputoperation.ofstream,likeostream,hasapointerknownastheput pointer
that points to the location where the next element has to be written. Finally,
fstreaminheritsboth,thegetandtheputpointers,fromiostream(whichisitselfderived from
both istream and ostream).
Theseinternalstreampointersthatpointtothereadingorwritinglocationswithinastream can be
manipulated using the following member functions:

tellg()and tellp()

Thesetwomemberfunctionshavenoparametersandreturnavalueofthemembertype
pos_type,whichisanintegerdatatyperepresentingthecurrentpositionofthegetstream
pointer(inthecaseoftellg)ortheputstreampointer(inthecaseoftellp).

seekg()andseekp()

Thesefunctionsallowustochangethepositionofthegetandputstreampointers.Both
functionsareoverloadedwithtwodifferentprototypes.Thefirstprototypeis:

 seekg(position);
 seekp(position);

Usingthisprototypethestreampointerischangedtotheabsoluteposition(countingfrom
thebeginningofthefile).Thetypeforthisparameteristhesameastheonereturnedby functions
tellgand tellp: themember typepos_type, which is an integer value

Binaryfiles

Inbinaryfiles,toinputandoutputdatawiththeextractionandinsertionoperators(<<and
>>)andfunctionslikegetlineisnotefficient,sincewedonotneedtoformatanydata,and
datamaynotusetheseparationcodesusedbytextfilestoseparateelements(likespace,
newline,etc...).Filestreamsincludetwomemberfunctionsspecificallydesignedtoinput and
output binary data sequentially: write and read. The first one (write) is a member
functionofostreaminheritedbyofstream.Andreadisamemberfunctionofistreamthat is
inherited by ifstream. Objects of class fstream have both members.



Buffers andSynchronization



When we operate with file streams, these are associated to an internal buffer of type
streambuf.Thisbufferisamemoryblockthatactsasanintermediarybetweenthestream
andthephysicalfile.Forexample,withanofstream,eachtimethememberfunctionput (which
writes a single character) is called, the character is not written directly to the
physicalfilewithwhichthestreamisassociated.Insteadofthat,thecharacterisinserted
inthatstream'sintermediatebuffer.Whenthebufferisflushed,allthedatacontainedin
itiswrittentothephysicalmedium(ifitisanoutputstream)orsimplyfreed(ifitisaninput
stream).Thisprocessiscalledsynchronizationandtakesplaceunderanyofthefollowing
circumstances:

 When the file is closed: before closing a file all buffers that have not yet been
flushed are synchronized and all pending data is written or read to the physical
medium.

 When the buffer is full: Buffers have a certain size. When the buffer is full it is
automatically synchronized.

 Explicitly, with manipulators:When certainmanipulators areusedon streams, an
explicit synchronization takes place. These manipulators are: flush and endl.

 Explicitly, with memberfunction sync(): Callingstream'smemberfunction sync(),
which takes no parameters, causes an immediate synchronization. This function
returnsanintvalueequalto-1ifthestreamhasnoassociatedbufferorincaseof
failure.Otherwise(ifthestreambufferwassuccessfullysynchronized)itreturns0.


	COMPUTERFUNDAMENTALS
	CHARLESBABBAGE
	Definition
	Accuracy
	StorageCapability
	Diligence
	Versatility
	Automation
	ReductionInPaperWork
	Reduction In Cost
	Dependency
	Environment
	Banking
	Insurance
	Education
	Marketing
	HealthCare
	Engineering Design
	Military
	Communication
	Governmentapplications
	INPUTDEVICES
	OUTPUT DEVICES
	CPU(CENTRALPROCESSING UNIT)
	Memoryor Storage Unit:
	Control Unit:
	ALU(ArithmeticLogicUnit):
	ARITHMETICSECTION
	LOGIC SECTION
	Unitsof Computer MemoryMeasurements
	Computer Memory
	Volatile memory
	Non-volatilememory
	ObjectivesofOperating System
	CharacteristicsofOperatingSystem

	WINDOWS7
	InstallWindows7
	Pre-installation checklist
	Installation process
	ToContinuethe Installation
	To complete the installation

	MS-DOS
	DOS Commands
	OtherDOSCommand commonlyused are:
	Attrib
	Break
	Chcp
	Chkdsk
	Choice
	Cls
	Dir

	WINDOWSOPERATIONS:
	MS- PAINT
	Todrawastraightline
	Todraw a freeformline
	Todrawacurvedline
	Tosend animageusing e-mail
	Todraw arectangleorsquare
	NOTEPAD
	WORDPAD
	UsingWordPad
	TheWordPadwindow
	Selectingtext
	Copyingandmovingtext
	To copytext and paste it in anotherlocation
	Tip
	Insertinganddeletingtext
	Formattingyour document
	Tochangethefont,fontstyle,orfontsize:
	Tochange the color
	Tochange the alignment
	Savingyourdocument
	Tosavethedocument
	Printingyourdocument


	MS-WORD
	OpeningMicrosoft Word
	MicrosoftWordFeatures
	RestoreDown:
	QuickAccessToolbar
	Keyboard Review
	MICROSOFT WORDBASICS
	Deleting Text
	BACKSPACE↔ DELETE
	Undoingand Redoing
	FormattingText
	DOING MORE WITHMICROSOFT WORD
	ModifyingLine Spacing
	Tochange theline spacing:
	CreatingBulletedand Numbered Lists
	Tocreatealist:
	ChangingViewsandOverall Look
	ClickonthePageLayoutTab.
	SpellingandGrammar Check
	USINGMICROSOFTWORD
	OpeningMicrosoft Word
	MICROSOFT WORDBASICS
	Deleting Text
	MicrosoftWordFeatures The Title Bar
	The FileMenu
	TheHomeTab
	The Ruler
	Keyboard Review


	MICROSOFTEXCEL
	OpeningMicrosoftExcel
	MicrosoftExcelFeatures
	The Title Bar
	TheRibbon Menu System
	The FileMenu
	TheHomeTab
	Equation Editor
	Keyboard Review
	Pointer Shapes
	MICROSOFTEXCEL BASICS
	InsertingRowsand Columns.
	SortingData
	AutoSumandExcelEquations
	SelecttheAutoSumiconfromtheribbonmenu:
	Creating Charts andGraphs:
	Multiple Sheets
	=‘March2012’! D11

	DOINGMOREWITHMICROSOFTEXCEL
	Cutting,Copying,andPastingData
	FillingDataacrossColumnsand Rows
	CLOSINGMICROSOFTEXCEL
	SavingSpreadsheets
	Printing Spreadsheets
	Finding More Help
	Closing the Program

	MicrosoftPowerPointComponents:
	TheTitleBar
	TheMenu Bar
	Standard Toolbar
	New|Open|Save|Print |Preview| Spell-check|Copy|Pas

	SIMPLETASKSINMICROSOFTPOWERPOINT
	Text Boxes:
	Slide Design:
	Designingyour ownbackground:
	Slide Layout:
	Notethefourdifferenttypesoflayout categories.
	Inserting a Picture:
	Inserting aGraph or Table:
	Inserting a Picture.
	Insert►Chart(orTable).
	Slide Management:

	SavingSlideShows:
	Closing the Program:


	INTERNET:
	Introduction:
	What isthe Internet?

	Usesof Internet
	1)Email:
	2)Information:
	3)Business:
	4)SocialNetworking:
	5)Shopping:
	6)Entertainment:
	7)E-Commerce:
	8)Services:
	9)Job Search:
	10)Dating/Personals:

	E-mailing
	HowItIsUsed



	DESKTOP PUBLISHING
	(PAGEMAKER,CORELDRAW,PHOTOSHOP)
	Terminology
	Comparisons
	Withwordprocessing
	Withotherelectroniclayoutsoftware
	What isthe PrintMedia?
	Whyis the Print Media Important?
	ADVANTAGESANDDISADVANTAGESOFPRINTMEDIA
	Advantagesofprintmedia
	Disadvantagesofprint media


	CharacteristicsofPrintMedia
	PAGEMAKER:
	SystemRequirements

	Toolsusedinpagemaker
	TextTool
	The Pointer Tool
	RotateTool
	Torotate text,
	CroppingTool
	Tocrop agraphic,
	RectangularTools
	Elliptical Tools
	PolygonTools
	Supportedplatforms
	Characteristicfeatures
	CorelDrawGraphicsSuite
	CDRFile Format

	ADOBEPHOTOSHOP:
	FileFormat
	LanguageAvailabilities
	Plugins
	Tools
	Pen Tool
	Measuring and navigation
	Selection
	Cropping
	Slicing
	Moving
	Marquee
	Lasso
	Quick Selection
	Magic Wand
	Eraser
	Typing
	Retouching
	Content-aware
	Healingtools
	Puppetwrap
	Video Editing
	3D
	Mobile integration
	CameraRaw


	HTML/DHTML,DREAMWEAVERWeb
	IntroductiontoHTML
	WEBDESIGNING
	Forcreation ofHTML fileswerequired Two ways:
	<HRSize=5Color=”Red”Width=70%Align=”Right”>
	Basicstructure ofHTMLDocument:
	Align=Left/Center/Right<H1Align=”Left”>SoftBrain</
	<HRSize=5Color=”Red”Width=70%Align=”Right”>
	<B>SoftBrain</B>
	<I>SoftBrain</I>
	<S>
	<TT>SoftBrain</TT>
	<SUP>th</SUP>August15th August
	H<sub>2</sub>SO<sub>4</sub>H2SO4
	<Body Text=”Aqua”> UsingSpecialCharacters:
	Attributes of Unordered Listtype=”circle”type=”s
	<TableBackground=”Computer.jpg”>
	<CaptionAlign=Top/Bottom/Left/Right>CaptionText</C
	<Table Cell spacing=”Number”> CellpaddingAttribute
	<TdColspan=”Number”><ThColspan=”Number”>
	<AHREF=”filename.html”>content</A>
	<ahref=”http.//
	<Ahref=”abc.html”><img src=”image.jpg”></A>
	<ANAME=”LOCATION”>
	MARQUEE
	<Marquee></Marquee>
	For direction of scrolling
	Forbackground color/width/height
	Forspeedcontrollingin marquee
	MULTIMEDIA
	AddingVideo:<embedsrc="movies.mpg"height="200"widt
	Form Creation:
	<Fieldset>
	<inputtype=”text”name=”text-id”value=”default-text
	<inputtype=”text”name=”text-id”value=”default-text
	<inputtype=”text”name=”t1”size=25maxlength=25value
	<inputtype=”text”name=”t2”size=25maxlength=25value
	<inputtype=”checkbox”name=”boxid”value=”checkbox”c
	<inputtype="checkbox"name="c1"value="checkbox"chec
	<inputtype="checkbox" name="c2">
	<inputtype="checkbox" name="c3">
	<inputtype="checkbox" name="c4">
	<inputtype="checkbox" name="c5">
	<inputtype=”radio”name=”radioid”value=”radiobutton
	<input name="radiobutton" type="radio"value="radio
	<textareaname=”ta”rows=15cols=60></textarea><br><b
	<Inputtype=”file”name=”file-id”size=”n”accepts=”fi
	<inputtype="file"name="file"><br><hr>
	<inputtype="text"name="t1"size=25maxlength=25value
	<inputtype="password"name="pass"size=25 maxlength=
	<Inputtype=”button”name=”buttonid”value=”clickhere
	<inputtype=”image”name=”img”src=”pic.jpg”height=50
	<inputtype=”submit”name=”sub”value=”Submit”>
	<FrameName=”AA”>
	1.Thefilename.htmlfilethathastobe opened.

	WebEditorNotepad
	Using Links
	TheRightMouse Button
	Using History
	Savinga WebPage
	AccessingtheFavoritesMenu

	WebFrameworkDreamweaver
	WHAT’SAROOTFOLDER?
	Page Properties
	WebPage Preview
	AddingImages
	Delete an Image
	CreateaSecond Page
	Page Navigation
	AddanE-mailLink
	Creatinga Linkwithin aPage
	Create alinkto the anchor
	PageLayoutwith Tables
	Create a Table
	MergeCells
	Insert anImage
	Delete arow
	Experimentwith cellcolor andother options
	LANGUAGEC&C++
	PROGRAMMINGLANGUAGE C
	WhyweuseLanguage?
	WhatisC?
	CBasics
	CharacteristicsofC
	FeaturesofCProgrammingLanguage:
	1.LowLevelFeatures:
	2.Portability:
	3.Powerful
	4.Bit Manipulation
	5.HighLevel Features:
	6.ModularProgramming
	7.EfficientUseofPointers
	C Program Structure
	NOTE:
	C Keywords
	C Instructions
	Variables
	Howdoyoudeclareavariable?
	BasicDataTypes
	DataTypeDescriptionMemoryRangeFormat
	QualifiersUsedWithBasic Data Types
	Operators inC :
	Arithmeticoperators:
	OperatorsFunction Performed
	UnaryOperators:
	Theincrementoperator(denotesas‘++’)
	RelationalandLogicalOperators:
	Comparison Operators
	Pointers

	StatementsinCLanguage
	ConditionalStatement
	TypesofLoopingStatements:
	do-whileloop
	for(initialization;condition; incrementation)
	Do-While LoopStatement:
	Do
	}while(condition)
	Advantageof Arrays
	ArrayDeclaration
	TypesofArrays
	MultidimensionalArrays:
	ArrayInitialization
	EnteringData intoan Array:
	Dynamic:
	Arrayinsidethe Memory
	MultiDimensional Arrays:
	TwoDimensionalArrays:
	CharacterArrays
	Strings
	FunctionUse
	strlen ( )
	strcpy()
	strcmp ( )
	Function
	Note:
	Functions maybedivided into threecategories.
	Withoutargumentswithoutreturnvalue
	Withargumentswithoutreturnvalue
	With argumentswithreturnvalue
	Advantageof Functions:
	Thetypesofvariablesare:
	LocalVariables:
	Global Variables:
	Recursion in Functions
	Cprogramto checkoddor evenusingmodulusoperator
	Cprogramtocheckodd orevenusingbitwise operator
	Findodd oreven usingconditional operator
	Cprogramto checkodd orevenwithout usingbitwise orm
	Primenumberprogram inclanguage
	break;
	C program for primenumberor not
	break;
	C program for primenumberusing function



	PROGRAMMINGLANGUAGEC++
	Introduction
	Unstructured Programming
	Procedural Programming
	ModularProgramming
	AbstractDataTypes
	Class
	Object
	Message
	Inheritance
	Multiple Inheritance
	Inheritancebetweenclasses
	Whatisinheritedfrom the base class?
	AbstractClasses
	StaticandDynamic Binding
	Polymorphism
	Function templates
	Templatespecialization
	Exceptions
	Standard exceptions
	TypeCasting
	Implicit conversion
	Explicitconversion
	Data Types
	ExpressionsandOperators
	Statements
	Tableof Statements
	Pointersand Arrays
	Arraysas parameters
	Pointers
	Referenceoperator (&)
	Dereferenceoperator(*)
	Nullpointer
	Pointersto functions
	C++Program
	Constructor
	Destructors
	Identifiers
	Operators inC++
	Arithmeticoperators:
	OperatorsFunction Performed
	UnaryOperators:
	Theincrementoperator(denotesas‘++’)
	RelationalandLogical Operators:
	Comparison Operators
	Statements in C Language
	ConditionalStatement
	For Loop, While Loop, Breakand Continue
	TypesofLoopingStatements:
	do-whileloop
	for(initialization;condition;incrementation)
	TheWhile Loop
	Initialization; While(condition)
	Do-While LoopStatement:
	Do
	}while(condition)
	Inline functions.
	Recursively
	Classesdefinedwithstructand union
	Friendfunctions
	Preprocessor directives
	Macrodefinitions(#defines, #undef)
	Input/outputwithfiles
	Openafile
	Closing afile
	Text files
	Checkingstate flags
	bad()
	fail()
	eof()
	good()
	getandputstream pointers
	tellg()and tellp()
	seekg()andseekp()
	Binaryfiles
	Buffers andSynchronization



